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Introduction

What is Review
Review is a fully integrated client/server data review tool that makes it 
easy to access, review, report and graph clinical data residing in your 
clinical or regulatory database (management) system. This powerful, 
user-friendly Windows application supports data review with interactive 
and integrated patient listings, reports (detailed, summary and format-
ted), graphical and statistical modeling of patient subsets and patient 
populations through multi-dimensional analysis. Review was specifi-
cally designed for the pharmaceutical industry to review clinical data 
and adverse events.

Features
In addition to supporting ongoing monitoring of patient safety and data 
quality, Review provides the following features: 

• Review allows you to explore your data visually to identify trends. 

• Intuitive and easy to use; no programming knowledge required.

• Direct and immediate access to data stored in existing clinical 
database (management) systems.

• The data selection pathways mirror the organization of clinical trial 
data and data selection processes are based on a “patient” paradigm. 

• Easy assembly of Patient Selection Criteria to select Project, Protocols, 
and Data types. Focus on data values, ranges, and populations by 
point and click creation of criteria expressions.

• Multiple selections of data across different time periods may be 
viewed to identify trends and outlyers.

• Point and click utilities for creating and defining Pivot Panels, 
additional Join Logic, Clintrial 0 Type Panel Joins, New Derived Items, 
and user-defined Event Function Values such as baseline or endpoint.

• Data Browser; instant Patient Listings and Panel Views (data lists) of 
subject data of patients meeting current selection criteria. Use to view 
details of individual patient data, CRF images, Audit Trails and 
electronic Notes, accessible for all data values. View patient level 
trend graphs for multi-visit numeric data.

• Discrepancy reporting; point and click on patient data value(s) or 
data column in Data Browser Panel Views and create automatic 
discrepancy reports. Manually enter an appropriate message and 
optional priority status by clicking the Create Discrepancy button. 
Introduction 23
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Automatically your discrepancy record is documented and entered 
into the Discrepancy Report Panel. 

• Patient Profile Browser; defaults all panels/question groups of 
patient data into the generated patient profile spreadsheet. Or you can 
create a custom patient profile easily organized by panels/question 
groups or visit. Display results as single or multiple spreadsheets and 
print or export as a workbook by study site.

• Graphical Profiles; display time oriented graphical displays (days on 
drug): duration bars for AEs, Concmed, etc., trend plots with normal 
range color region, high/low normal symbols for labs, vitals, etc. 
Generate PDFs directly for all selected patients.

• Report Browser; mouse clicks on data panels and reporting functions; 
such as Means, Baseline, Endpoint, Change from Baseline, and 
Change from Previous to produce Summary and Detail Data Listing 
Reports. Report formatting may be applied. Color highlighting of out 
of range data based on ranges specified. Features for count distinct 
column, count item value, suppress duplicate rows is supported.

• Multiple Panel reports are supported by Automatic Joins (including 
outer joins) and run time (end-user) defined joins on any panel 
including type 0 panels used independently or ‘Shared with others’.

• CrossTab Browser; multi-dimensional data analysis and 
Baseline/Endpoint Shift tables for cell statistics allows you to drill 
down to the patient data behind each cell. 

• Graph Browser; choose from a variety of graphs including line charts 
displaying standard deviation with means (display selection), scatter 
plots, 2 and 3 dimensional bar charts, and frequency distributions. 
Multi page graphing capability for selected 2D graph types providing 
multiple graphs on the same page.

• Review provides powerful 3 dimensional bar chart editing, and 
complete display editing of all graphs for dynamic presentations of 
clinical data.

• Drill-down capabilities within graphs for exploring the details of 
graphical patient level data displays. Highlight data in scatter plots or 
bar chart and identify patients in the Data Browser to view patient 
level displays.

• SAS Proc (Statistical Analysis System Procedures) Browser; provides 
access to a powerful statistical engine for versatile adhoc statistical 
queries and provides the creation of SAS Data Sets and SAS Data 
Views.

• SAS Program Browser; a list of SAS (Statistical Analysis System 
Procedures) programs extending Review’s analytical depiction of 
patient populations meeting your defined and applied Patient 
Selection Criteria. Optional usage of parameterized SAS (Statistical 
Analysis System Procedures) programs. 
24 Chapter 1:  Getting Started
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Starting the application

Logging on
To log on:

1. Double-click on the Review icon: 

2. Enter your ORACLE user ID, password and server names (and 
instance ID where applicable), to connect to the appropriate ORACLE 
and SAS servers, using the tab key to move from field to field.

You can select Oracle Server and SAS Server from the drop down 
listbox for both.

3. Click OK.

Choosing an ORACLE database

By default, Review connects to a default ORACLE instance on the 
specified server. You can specify the instance ID of another ORACLE 
instance from the client application.
Starting the application 25
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If you want to access an ORACLE database other than the default 
database that you normally connect to, add the specified database 
identifier (ORACLE SID) to the end of the ORACLE Server name 
separated by a colon (:) in the text entry box within the opening Logon 
dialog box.

Using an ORACLE connect string

Alternatively you can access to an ORACLE database by the use of an 
ORACLE connect string, preceded by @.

Using Personal Oracle7

When you are using Personal Oracle7, you can access the ORACLE 
database by entering the word LOCAL.

Wrong password?
If you have entered an incorrect or invalid ORACLE user ID or ORACLE 
password, the application notifies you after you click OK. Review 
requests that you enter a valid user ID and password.

You are allotted three incorrect entries before the application denies 
access. 
26 Chapter 1:  Getting Started
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On-line Help

On-line Help
Our system of On-line Help can be accessed by clicking Help from the 
Menu Bar or the Tool Bar. Select Index to display a list of contents 
explaining how to use the functions for the various browsers. 
On-line Help 27
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In addition, your site administrator can enable a Local Help for a site 
customized help file which can be launched from within Review. If the 
Local Help file is enabled at your site, click Help from the menu bar, and 
from the display window select Local Help.
28 Chapter 1:  Getting Started
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Terminology for Oracle Clinical users

Oracle Clinical terms
• Variable names used by Oracle Clinical are an eight character name 

which is unique within a view but not unique across views within the 
same study. The dynamic views are directly related to the study data 
definition of the DCM which the user has defined.

• Text Description as a 40 character SAS label is provided as defined 
within the DCM_QUESTIONS table.

• Unique Numeric Identifier - The DCM_QUESTION_ID is study specific 
and unique across views.

• Non-Unique Numeric Identifier - The QUESTION_ID is non-study 
specific and also is not unique within a study.

What are Oracle Clinical keys?

The key is an identifier which can be used to relate one piece of data to 
another. Oracle Clinical has the following fixed hierarchy to define a 
parent key:

STUDY

INVESTIGATOR

SITE

VISIT

QUALIFYING VALUE (optional)

SAS_REPEAT_NAME (optional)

The general key names are consistent within a study. Qualifying values 
are treated as keys and are named by the qualifying question. Repeat 
Sequence Numbers are named using the eight character 
SAS_REPEAT_NAME. This attribute is added to the 
DCM_QUESTION_GROUPS table and is unique within a study. 
Constant numeric identifiers are provided for each key with the 
exception of qualifying value and repeat.

Patient                     10

Site                           20

Investigator            30

Visit                         40
Terminology for Oracle Clinical users 29
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For qualifying questions, the QUESTION_ID is used as an identifier. For 
the repeat number, a numbering seqence based upon the 
DCM_QUESTION_GROUP_ID is used to ensure the key is unique.

The Oracle Notation for DCM_QUESTIONS.DCM_QUESTION_ID refers 
to the column DCM_QUESTION_ID in the DCM_QUESTIONS.

In addition, a SAS variable is a set of data values that describes a specific 
characteristic such as weight and would be the equivalent of an Oracle 
Clinical question.

What are Oracle Clinical Data Structures?

Listed are some of the basic data structures which Oracle uses for data 
management.

• Domains are unique for the various Oracle Clinical objects such as 
Questions, Question Groups, DCMs, Data Extract Views and Queries. 
An object name is required to be unique only within a Domain. At the 
study level, the Domain is the study and within a study parent object 
names are unique. Child object names, such as DCM questions and 
DCM Question Groups have different domain uniqueness constraints 
described below.

• Questions are the building blocks of collected data and are defined at 
the library level.

• Question Groups are a collection of one or more questions and are 
defined at the library level.

• DCMs (Data Collection Modules) are defined at the study level and is 
made up of one or more question groups.

Note:The Oracle clinical data structure nomenclature for DCM, 
Question Groups and Questions will display as title headings in the 
Patient Selection Criteria window.

DCM question names are not unique within a study or a DCM under 
different conditions. For example, BLOOD_PRESSURE can appear as a 
DCM question in two different DCMs within the same study. Also, DCM 
questions can occur multiple times within the same DCM question group 
and differentiated by an Occurrence Sequence Number. The same DCM 
question can also be repeated multiple times within a DCM question 
group. The Repeat Sequence Number indicates the repeat of a Question 
Response Value. To summarize the three situations of multiple 
occurrences of a question within a study:

• A DCM question can occur two or more times within the same 
DCM Question Group.
30 Chapter 1:  Getting Started
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• A DCM question can repeat within a DCM Question Group.

• A DCM question can occur within different DCM’s of the same 
study.

At the library level, Question Names and Question SAS Names are non-
unique across Domains. For Questions with multiple Occurrences in a 
single Question Group, the Occurrence Sequence Number is part of the 
Question Name. The Repeat Sequence Number (SN) is part of the key, so 
within a given DCM, DCM Questions can be uniquely identified. 
However, this is not true with multiple DCMs as across multiple 
repeating DCM Question Groups in the same DCM which collect the 
same Questions. In the example below, the question BLOOD PRESSURE 
(BP) is collected in the DCM ADVERSE_EVENTS and the DCM VITALS, 
where it appears in both Question Groups of the DCM.

In this STUDY example, the data is collected by two DCMs: VITALS and 
ADVERSE_EVENTS. The first DCM VITALS has two Question Groups. 
The first DCM Question Group INITBP, is non-repeating and collects the 
Question BLOOD_PRESSURE twice. The second DCM Question Group 
VITALS, repeats three times. The second DCM ADVERSE_EVENTS has 
one DCM Question Group which is non-repeating. 

Table 1: Example of DCM, Question Groups and Questions

DCM, Question Group Question short 
name

Occurrence 
SN

Repeat

DCM: Vitals (short name VITAL)
Question Group: InitBp (short name IBP)
Initial Blood Pressure              __________
Date of Initial Blood Pressure __________
Blood Pressure at end of Visit __________

BP
TimeBP
BP2

1
1
2

1
1
1

DCM: Vitals (short name VITAL)
Question Group: Vitals (short name VITAL)
Blood Pressure          Time of Blood Pressure
_____________            ____________
_____________            ____________
_____________            ____________

BP
BP
BP

1
1
1

1
2
3

DCM: Adverse Events (short name ADV)
Question Group: Adverse Events (short name ADV)
AE Date            ____________
AE Time            ____________
AE Description _____________________________
Blood Pressure _____________

AEDate1
AETime1
AEDesc
BP

1
1
1
1

1
1
1
1
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What are Data Extract Views?

Oracle Clinical data extract views are of two kinds, standard and custom. 
The standard views extract data in a fixed way into the STUDY ACCESS 
ACCOUNT selected for types TEST, CURRENT, STABLE, and 
SNAPSHOT. The variables in a standard view are unique across the view 
and non-unique between views in a given study. The custom views can 
be defined by a user with the query builder or by loading view creation 
text from a SQL file.

Standard views include both static views and dynamic views. The static 
views are the same in every access account. The dynamic views are 
directly related to the study data definition. Examples of static views 
could be NORMLAB or NORMDATA.

The dynamic views also generated from a standard view are dependent 
upon the nature of the DCMs which the user defined. These dynamic 
data extract views are created in Oracle accounts in the following 
manner:

1. In a study, a view is created for each repeating DCM Question Group 
in a DCM. It’s name is the DCM short name concatenated with the 
DCM Question Group short name of the repeating Question Group.

2. All non-repeating Question Groups in the DCM are included in a 
single view with the DCM short name.

When data extract views are created for the above example, the following 
dynamic views are generated:

• VITALVITAL

• VITAL and

• ADV

These standard views are created together with any custom views 
defined where the builder can combine data from multiple DCMs. This 
data can also be aggregated. The same variable can occur multiple times 
within the same row with various aggregate functions applied.
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How does Oracle Clinical pass files to Review?

Following is a brief description of the steps of the process of passing 
Oracle Clinical project and study information to Review.

1. When Oracle Clinical first connects to Review, the list of projects 
displays from the Oracle Clinical standard table: 
RXA_DES.OCL_PROJECTS

2. When you click on a folder, review then presents a list of ‘Study 
Access Accounts’ available for that project. These are a combination of 
STUDY and the ‘type’ of access ($CURRENT, $STABLE, etc.).

3. When you click on one of the Study Access Accounts, the list of 
DCM/Question Groups displays:

All default views created for the study. These are organized by DCM, 
if there are multiple question groups per DCM (data collection 
module), otherwise, if a Question Group is the only one as a DCM, it 
will be ‘promoted’ to the top level, not listed under it’s DCM:

(+) dcmNameA

questionGroupA

questionGroupB
(-) questionGroupC (only 1 questiongroup in it’s DCM)

(+) dcmNameC

questionGroupD

questionGroupE
(+) Custom Views (list of custom views if any exist)

(+) System Tables (list of registered Foreign Panels meaning any 
other Oracle tables or view registered using ReviewAdmin utility).

By default, the PATIENT_POSITIONS table is registered which 
displays patient information into the Data Browser list of patients.
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Terminology for Clintrial users

What is metadata?

Metadata is data that define Clintrial objects and other structures. The 
tables that store metadata are called data dictionary tables. Data 
dictionary tables store reference information about the database and its 
structures.

Metadata is stored in the data dictionary tables when you ‘Create a 
protocol’.

Clintrial stores the metadata (the protocol attributes) in a data dictionary 
table that stores protocol metadata for all protocols. 

When you create or modify a panel or an item, and when you install a 
panel, Clintrial stores the metadata in tables in ORACLE accounts that 
are either system-wide data dictionary accounts, or protocol-specific 
accounts that can contain both data dictionary and clinical data 
information.

What is a project?

Typically a drug development project, is where a number of grouped 
protocols are conducted for a given project.

What is a protocol?

A protocol account (or protocol) is an ORACLE account that serves as a 
logical container to organize the objects and data for a clinical study. 
Protocols may contain clinical data for a single study or for multiple 
related studies.

When you browse clinical data with Review, you specify the protocol(s) 
that contains the data you want to review by selecting the protocol(s) 
under the selected project from the Studies folders.
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What are database tables?

Clinical data in Clintrial is stored in ORACLE database tables. These 
database tables contain clinical data in columns and rows:

A column in the table corresponds to an item, or piece of data.

A row in the table corresponds to a record, or group of related data.

What are panels?

In Clintrial, the ORACLE database tables are defined by panels. A panel 
is a collection of logically or clinically related items. 

A panel groups together a set of logically or clinically related items from 
a CRF page. Panels contain items. For example, a panel might store 
physical examination results for a subject.

After a protocol is created, panels are created within the protocol, and 
items within each panel. 

Panels define the ORACLE database tables that store the records created 
when clinical data is entered during data-entry. 

Each panel has three associated tables in the ORACLE database: an 
update table, a data table, and an audit table.

You can associate a panel with specified derivations and rules, which are 
applied to records in the panel when the records are validated in Clintrial 
Manage.

Note: In Clintrial, the data structure nomenclature for Panels and Items will 
display as title headings in the Patient Selection Criteria window.
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What are panel types?

The panel type (0 through 5) that determines which context items are 
required, and the number of records for each set of context items. 

Panel type 0: Non-patient data not related to a particular patient or 
visit. For example, laboratory normal ranges.

Panel type 1: Data collected only once for each patient in a clinical 
study. For example, demographic data or eligibility data.

Panel type 2: Data that is collected multiple times for each patient. The 
data is not related to a particular visit. For example, a panel describing 
previous medications or medical history could contain items that have 
multiple values entered on the single occasion that data is collected. 
The panel can be used for repeating items.

Panel type 3: One record is collected once for each patient visit. For 
example, vital signs or laboratory results may be collected once for the 
patient at each visit.

Panel type 4: More than one record is collected multiple times for each 
patient visit. For example, a panel describing adverse events or 
concomitant medications could contain items that would have 
multiple values entered at each patient visit.

Panel type 5: Subject enrollment ensures that each subject can be 
uniquely identified in the database. The system design automatically 
creates an empty enrollment panel when you create a protocol.

What is a context panel? 

A context panel is a special panel containing context items. Context items 
are associated with each record in a clinical data table for type 1, 2, 3, 4, or 
5 panels. 

A context panel is always named CONTEXT and there is only one 
context panel for each protocol.
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What are context items?

Special context items are used as keys (either alone, in combination with 
each other, or in combination with items in the non-context panels) to 
uniquely identify a record. There are 4 types of context items:

1. Subject-related: Items that identify the subject, such as a subject 
identifier.

2. Visit-related: Items that identify the visit, such as a visit number or a 
date.

3. Page-related: Items that identify a study page, such as a page name or 
page number.

4. Other: Items not related to the subject, the visit, or the page, such as 
the investigator name.

What are items?

An item stores the data collected by a single field in a study page or by a 
single field in a batch-loaded file. For example, the PHY_EXAM panel 
might define items for storing physical examination results.

An item stores the data collected by a single field in a study page. Items 
are defined within panels, and correspond to one column in a clinical 
data table. For example, the DEMOG panel might contain the items AGE 
and SEX or the PHY_EXAM panel might define items for storing 
physical examination results.

There are 3 types of items:

1. Context items which associate each record in the database with data 
that uniquely identifies the record, such as a particular subject or 
subject visit.

2. Data items which represent collected data, for example height or 
weight.

3. System items which Clintrial uses to identify and manage records.

Note: The data-entry area for an item on a study page is referred to as a field. 
Field names may differ from the name of the actual item.
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What are Database table types?

Each panel in a protocol defines three ORACLE database tables for the 
storage of clinical data. The items in each panel correspond to the 
columns of the database tables. The three database tables have the same 
structure, but contain data in different states:

1. The update table stores clinical data when it is first entered in Clintrial, 
and is a holding area for clinical data while it is being cleaned.

2. The data table stores clinical data that has passed validation and has 
been merged.

3. The audit table contains copies of original clinical data records as they 
existed before modification or deletion.

What are records?

A record corresponds to one row in a database table. The clinical data 
interactively entered in a study page is stored in one or more records in 
the database.

Records can also be batch-loaded into the database tables.

Depending on the panel type, the data collected in a study page is stored 
in one or more records in the database table. For example, a database 
table can contain:

• One record per subject

• Multiple records per subject

• One record per subject visit

• Multiple records per subject visit
38 Chapter 1:  Getting Started



Level 1 bleed
Quick tour

Main window

After you successfully log into the ORACLE database (on the computer 
storing your clinical data), the main window of Review opens. The left 
side contains the Object Explorer Window, under studies select a project 
folder, for example ‘Drug KA’ and protocol ‘KA201’.

Review retrieves all previously stored Patient Subsets and Output 
Specification objects organized in folders. 
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The individual browsers covered in the following chapters, are used for 
building, modifying and saving your Output Specification objects into 
folders you define. Once the objects are saved, they can be quickly 
located and launched from within the folders displayed in the Output 
Specifications window and Patient Subsets window. 
40 Chapter 1:  Getting Started



Level 1 bleed
The individual who creates and saves an object definition has sole 
security to delete or modify it. SuperUsers have extended privileges. (See 
Chapter 12: Common Topics: SuperUser Privileges).

In addition, a browser icon displays along side the object description to 
quickly identify the various output results, such as Reports, Graphs, 
CrossTabs, Registered SAS Programs, etc. A filter icon lets you know that 
a patient selection criteria was saved with the Output Specification 
object. Patient Selection Criteria may also be saved as separate objects in 
the Patient Subsets window. The output specification objects stored 
within their folders can be sorted to display by icon type or by object 
description. Simply click by Type or by Description.   

The saved objects can be stored at three levels: Private, UserGroup, or 
Public. (See Chapter 12: Common Topics: Shared Object Storage-Locations.)

Once an output specification has been saved you can use job scheduling 
to generate and save the output at a later date and time or select 
repetitive frequency to generate output results. The Review Output tab 
located at the bottom of the window allows you to view the archive of 
output results organized within folders with date and time stamps 
applied. (See Chapter 6: Report Browser: Schedule Output.)

Selecting a patient population

Once the application has started and you have selected the study or 
studies you wish to explore; you select your patient population by 
subsetting. You can double click on a saved object in the Patient Subsets 
window or build your own Patient Selection Criteria. This topic is 
covered in detail in the next chapter. If you choose not to enter a Patient 
Selection Criteria, Review will default to access the whole patient 
population. Before you select a patient population, you should be 
familiar with the important regions of the main application window.

Note: The Patient Selection Criteria window displays the section headings as 
DCM/Question Groups and Questions for Oracle Clinical, or Panels and Items 
for Clintrial. The headings display as such to be consistent with the site Clinical 
Data Management system. All other windows within Review use the terms 
panel and items and there is no functional difference. Therefore, these terms are 
interchanged throughout this text to imply similar meaning and function.
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Menu bar and windows

You can access any of the functions available in Review:

1. Click a menu from the Menu Bar, for example, File:
2. Click on one of the submenu Items of the main menu that would be 

applicable to select, for example Print.
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Note: Many of the menu commands can be run by clicking on the corresponding 
Toolbar Icon.

The Menu Bar and Toolbar can be relocated to other areas of the screen. 
Simply click and drag to the new location.

The Object Explorer Window is docked at the left side and can be re-sized 
by dragging the right side. This allows you to decrease or increase the 
window area as needed.
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 Toolbar
The most commonly used items in Review can be accessed quickly by 
clicking on one of the Toolbar buttons:

 New: Clears the current specifications in the active area.

Open: Retrieves a previously saved set of specifications into 
the active area.

Save: Saves the specifications of the currently active area.

Print: Prints the specifications, spreadsheet, report or graph, 
or whatever is active.

Print Preview: Displays a screen shot of the output result. 
Applicable to all browsers with output results. 

Selection Criteria: Makes the Selection Criteria Window 
active. Returns to Main Menu in Review.

Data Browser:  Starts the Data Browser.

Patient Profile Browser: Starts the Patient Profile Browser.
44 Chapter 1:  Getting Started



Level 1 bleed
Report Browser:  Starts the Report Browser.

Graph Browser:  Starts the Graph Browser.

CrossTabs Browser: Starts the CrossTabs Browser.

SAS Proc Browser: Starts the Statistics Browser.

SAS Program Browser: Registered SAS Programs Library for 
immediate execution against selected patient populations.

Document Browser: Starts the Document Browser.

Note Browser: Starts the Patient Level Note Browser.

Gets information about the Review client/server version, 
and licensee.
Quick tour 45



Le
ve

l 1
 b

le
ed
Review workflow

Explore and monitor your clinical data by selecting from the various 
browsers. Optionally subset the patient population with the Patient 
Selection Criteria or view all available patients by default.

Help: Displays a Help contents for Review.
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Selecting a project

Selecting a project
In the Object Explorer window under Studies, select a project from the 
list of project folders. 

As soon as you have selected one of the Projects, for example ’Drug KA’, 
Review opens that project folder to display the protocols that are stored 
in your clinical data base.

Selecting protocols

Single-protocol mode

You can click and select a protocol that you want to explore. If you click 
on one protocol, you are in single-protocol mode. The lists of panels and 
items that are displayed corresponds to all panels and items in that 
protocol. 
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Multi-protocol mode

If you select multiple protocols, you are in multi-protocol mode. The lists 
of panels and items that you see correspond to common panels and items 
between the protocols selected. In addition, Review confirms the 
common items match by data type. Unique panels or items are not 
displayed for selection.

You can select multiple protocols in one of the following ways:

For contiguous protocols (protocols listed next to each other): 

1. Click the first protocol. 

2. Hold the shift key and mouse click, and drag the cursor over the 
protocols you would like to review.

For non-contiguous protocols (protocols not listed next to each other):

1. Select the protocols you want while holding the Ctrl key.

2. Click each protocol you want to select.

Note: In Browsers, the item StudyID, is used for protocol comparison.
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Specify Patient selection criteria

Review sub-populations 

Using the patient selection criteria, you are able to filter the available 
patient population from the selected protocols into sub-populations. The 
patient selection criteria allows you to focus on these segregated sub-
populations in the production of reports, statistics, patient profiles and 
graphs. This function supports the concept of the patient paradigm in 
that all information for the selected patients is available for display 
including multiple visit data.

If you do not specify a patient selection criteria, by default you have 
access to the whole patient population.

Focused analysis

The patient selection criteria focuses Review’s analysis on the patient 
sub-population for all available data and doesn’t restrict the results to the 
individual data observations or visits of the patients to be analyzed. 
Another function, the Filter Output discussed in the next chapters is 
designed to focus on particular observations and visits. The Filter Output 
is another level of filtering used to restrict or select specific patient data 
for multiple visits, observations and Adverse Events. Access to the Filter 
Output function is located within each browser when you define your 
output specification. The patient selection criteria and filter output can be 
used in conjunction with each other or as individual functions to meet 
your needs.

The patient selection criteria you create can be saved by description and 
managed in folders for future use. The saved patient selection criteria are 
organized in your folders and displayed in the Patient Subsets Window 
for quick and easy access.  If you do not specify a patient selection 
criteria, you have access to the whole patient population.
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Steps for selection criteria

After you open a clinical project folder and select a study, you can subset 
your available patient population using the Patient Selection Criteria.
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1. Select a Panel.

2. Select a Item.

3. Select a function.

4. Select an operator.

5. Supply a value or select a value from Display Values.

– Display Values (optional).

– Display Statistics (optional).

– Compare Items (optional).

6. Add expression to criteria.

7. Add criteria description (optional).

8. Update Browsers.

Access to SAS datasets

SAS datasets are listed with the panels generated from Oracle tables. 
Items from SAS datasets can be used like other items for patient selection 
criteria.

Note: The current restriction is you cannot mix items from SAS datasets and 
Oracle table generated panels within the same patient selection criteria 
expression.
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Building and Joining Criteria Expressions

Logical expressions

Patient selection criteria are made up of logical expressions, such as ’AGE 
> 50’, connected by Boolean operators, such as AND, ANDSelect, or OR. 
You create these expressions by clicking on various listboxes.

Selecting a panel
Your clinical data has been collected and entered into meaningful groups 
of items, referred to as panels. They often correspond to Case Report 
Form (CRF) modules, such as ‘Admissions’, ‘Demography’, ‘Final 
Report’, and ‘Vital Signs’. Each panel contains a group of data items, such 
as age, sex, race, and date of birth. For the protocol of interest, a panel of 
data in the database contains all data collected for all observations and all 
patients (as appropriate for the type of panel) in the protocol. Your goal is 
to build a patient selection criteria to describe the patient population that 
you want to explore. 

The first step in defining a logical expression, such as 'AGE > 50', is to 
select the panel that contains the item to be used in your expression, such 
as Demography. Panels and items are selected individually to define the 
selection criteria expressions. 
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Selecting an item

After you have selected the Demography panel, Review retrieves and 
presents a list of all the items stored in the Demography Panel. 

Select an item. 

Select an operator.

The list of Functions and Operators displayed will vary dependent 
upon the item’s data type.

If you know the value, you can enter it in the value box or click 
Display Values. 
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Panel item profiles

Supplying a item value

You can enter a item value for an expression as follows:

1. Click on the panel that contains the data.

2. Click on an item.

3. Click on one of the default function values or user-defined functions.

4. Select a logical operator appropriate to the expression you are 
building, such as ’=’ or ’>’.

5.  If you know the value that you want to specify in the expression, 
enter the value in the Value field. 

After you are finished selecting all parts of the expression you are 
building, click ADD expression to criteria. The expression is added to 
the next row of the spreadsheet containing the active Patient Selection 
Criteria. Repeat these steps if you want to continue to add more criteria 
expressions or click Update Browsers when done.
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Displaying item values

Another way to add select criteria expressions besides directly entering a 
value is to open the Display Values window. Once you have added 
expressions by entering a value, you can capture perspectives of your 
data that are uniquely informative. Suppose you are interested in 
exploring patients who were discontinued from the protocol due to 
safety issues. For example, select the Final panel and item Reason for 
Discontinuation. This item type references a data dictionary file 
associated to the discontinuation reasons by a code.

Note: Display Values window does not automatically open for decode items, 
allowing the user to specify a code value if already known.

 To list all the values of this item in the protocol(s):

1. Select a panel, such as Final Report.

2. Select an item, such as Reason for Discontinuation.

3. Click Display Values.

Review displays the Unique Values window for the selected item. All 
the values are displayed with the internal codes if an item is coded.

4. Highlight the selected row and click ADD expression. 
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Shortcut: If you double-click on the single value of interest in the Unique Values 
spreadsheet, the expression is automatically added to the next available row in 
the Patient Selection Criteria window. 

Selecting multiple values

If you need to select multiple items of interest within the same Unique 
Values window, the selected operator must be ’=’. Then click Display 
Values to open the Unique Values window. 

To select multiple contiguous values, click on a value and drag over the 
other values. To select multiple non-contiguous values, click on a value 
and hold down the Ctrl key when clicking the other values.

When you click ADD expression, Review adds your expression, 
including the value you selected from the Unique Values spreadsheet, to 
the next available row in the Patient Selection Criteria window.

When the expression is pasted into the Patient Selection Criteria window, 
it is automatically turned into a SQL ’IN List’ expression, which means 
that patients will be selected if the value of the item specified is any of 
those in the list.
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Selecting an operator

The list of Operators changes according to the item’s data type.

1. Click on the panel that contains the data.

2. Click on the item.

3. Click on one of the default function values or user-defined functions.

4. Select a logical operator appropriate to the expression you are 
building, such as '=' or '>'.

Note:  If the item is a Text data type, you see the following text strings: 

a. contains:

b. doesn’t contain:

c. begins with:

d. ends with:

e. is missing (NULL)

f. is not missing (not NULL)

These text string operators allow you to search for partial strings 
anywhere within the field. If the item is a numeric data type (such as 
age), or a date field (such as date of birth), the string operators do not 
appear in the Operator ListBox.

Building a string expression

If you are building a string expression, (for example, patients whose 
‘Adverse Drug Event’ field contains the string 'RASH' anywhere in the 
text of the item), click the 'contains' operator and enter the string ‘RASH’ 
in the ‘Value’ field. The string search is case sensitive and you can 
determine how the data is stored by clicking the Display Values button to 
determine case status.
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Additional criteria expressions

If you to want additional criteria applied to the patient selection criteria, 
repeat the previous steps:

1. Select a panel.

2. Select an item.

3. Select an operator.

4. Either enter a value or click Display Values.

5. Click ADD expression to criteria and close the Unique Values window.

6. Click Update Browsers when you have added all criteria expressions 
to your patient selection criteria.
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Your expression has been added in two different ways. The expression 
appears in the Select Criteria (Text) field exactly as specified in the list 
boxes. Also, the expression appears in the Select Criteria (SQL) column in 
a way that is understandable to the system.

Boolean operators

When you add additional expressions, an AND operator is added 
between next row of criteria in the Select Criteria logical Operator 
column. This means that the previous expression and the current 
expression will be used with an AND between them. The patients 
selected pass the previous criteria expression AND the current criteria 
expression so both expressions must be true. In the previous example, for 
Age > 50 AND Sex = Female, only those patients who meet both criteria 
expressions as true are selected into the patient sub-population or patient 
subset for analysis. This is a simple example where the Demography data 
is a single panel type collected only once for each patient.
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AND operator
The patient selection criteria becomes more detailed when you choose a 
multiple record panel or multiple visit panel type for example, Adverse 
Events, Laboratory Chemistry or Vital Signs. In this example, both of the 
selected data items came from the same multiple visit panel Laboratory 
Chemistry.

The patients selected have a minimum of one visit where both the 
Cholesterol AND Triglycerides are >= 250 within the same visit. the 
patient selection criteria results are 20 patients in the patient subset from 
the total patient population of 196.

Hint: Viewing a detail data listing of the data items in the selection criteria is 
helpful when defining and validating patient selection criteria with multiple 
expressions and different operators.

Notice in the detail data listing contains some patient visits which do not 
meet the selection criteria as show by the arrows. Remember the patient 
selection criteria is based upon the patient paradigm and all the patient’s 
data is displayed. If you do not want the visits (rows) to display in your 
output, then you would define a Filter Output to be discussed in detail in 
the browser chapters.
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OR operator
If this is not appropriate, you can change the AND to an OR or ANDSe-
lect. Click on the AND in the Select Criteria logical Operator column to 
display the dropdown list for other operator options.

If you use the previous example and change the operator to OR, the 
patients selected must have the first or second expression as true within 
the same visit (row). For a patient to be selected they must have a 
minimum of one visit where either Cholesterol or Triglycerides or both 
data item values are >= 250 within the same visit (row). All the patient’s 
visits are displayed for the selected patient subset including the visits 
where both data items values are <= 250. The patient selection criteria 
results are 69 patients contained in the patient subset from the total 
patient population of 196.
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ANDSelect operator

When you change the boolean operator to ANDSELECT, the patient 
selection criteria is partitioned into two segments executed in succession. 
SELECT is the equivalent of adding parentheses into the Patient Selection 
Criteria and forces the execution into a multi-step process.

In this example, the data item values are no longer restricted to the same 
visit (row) for the multiple visit laboratory Chemistry panel due to the 
ANDSELECT operator. The patient selection criteria results are 21 
patients in the patient subset from the total patient population of 196.

You can apply various combinations of operators to the selection criteria 
to subset the available patient population. For example, previously we 
selected patients with elevated Cholesterol OR Triglycerides >= 250 
within the same visit. You can add selection criteria from Medical History 
data items for Cardiovascular Disease OR Hypertension as ‘yes’ to see if 
there is any relation to the laboratory results.
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The ANDSELECT operator partitions the patient selection criteria to be 
executed into two subqueries. First Review processes the multiple 
selection criteria by retrieving a list of patients who meet the first 
selection criteria subquery for elevated Cholesterol OR Triglycerides. 
Then from this first subset of patients a second subset of patients is 
generated who meet the second selection criteria subquery. The second 
selection criteria subquery results in the final patient subset. In this way 
the patients meet all the multiple selection criteria.

Build a complex patient selection criteria

Sometimes it is necessary to select patients who meet a particular criteria 
at a particular visit, (for example, at baseline), and who also meet criteria 
at another visit (for example, at endpoint). Normally, introducing Visit or 
any other item twice in the same expression with different selection 
values yields a “no patients selected” outcome, as they are mutually 
exclusive. Review introduces a concept of selection segments to access 
such patient selection criteria. Each selection segment is tested in 
succession, not all at once. This provides you with a unique versatility at 
visualizing and analyzing particular data sets. 
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To define the start of a new selection segment, click on the ANDSelect 
logical operator. 

An example Patient Selection Criteria using this technique is:

KOHEXAM = 2 (Positive)      1st Subquery 

AND VISIT NO = 1

ANDSelect {Creates nested subqueries}

KOHEXAM = 2 (Positive)     2nd Subquery 

AND VISIT NO = 6

The ANDSelect statement partitions this patient selection criteria into 
two segments. Partitioning this patient selection criterion creates 
Review’s selection segments, which are executed in succession and 
prevent each segment from excluding the other. The system processes 
such multiple selection segment criteria by retrieving a list of patients 
who meet the first selection segment criteria, then retrieving a list of 
patients who meet the second selection segment criteria, who are also in 
the first list of patients. The result would be 0 patients if the tests were 
run without Review’s selection segments or run simultaneously. You 
could not normally test for the mutually exclusive selection values 
VISITNO = 1 AND VISITNO = 6. 

Changing the selection criteria

If you want to change the patient selection criteria, click anywhere in the 
row that you want to change:

1. To modify the patient selection criteria, you can click on the row and 
edit it.

2. To remove a row, click  or from the Edit menu, select Cut. This 
will delete the highlighted row from the expression.

3. To remove all rows, click .
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Updating Browsers

If browser windows are open when you revise patient selection criteria, 
click Update Browsers to apply the updated patient selection criteria to 
the browser windows.

Criteria description

You can enter a criteria description to display in the print footers as text 
to override the default SQL.

This option is enabled in Preferences. (See Chapter 12: Common Topics: 
Reviewing Preferences)
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Item comparison selector

Compare items
An alternative mechanism to the basic patient selection criteria is the 
item comparison selector. This mechanism provides the functionality to 
base the selection criteria on the value of another item, not just a fixed 
value. Select a panel, an item, and an operator. Items can be compared 
within the same panel or between panels.

1. Click . The Item Comparison selector window opens:

2. Select the panel, item, and function value to compare to. 

3. Click ADD expression to criteria.

4. Close the Item Comparison window.

5. Click Update Browsers. See the SQL text created when for compare 
Lab Chemistry panel item SGOT > than SGPT actual values:
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Exclude patient criteria

Display excluded patients

You have the ability to view those patients who are not in your current 
selection criteria by setting . Click the button 
in the lower left corner of the Patient Selection Criteria Window to set 
this option on. For example, build a patient selection criteria for female 
patients and open the Data Browser Window to display all patients who 
meet this selection criteria. 
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To view patients excluded from your current selection criteria:

1. Click the box for .

2. Click Update Browsers.

The example shown displays all male patients or all the patients who 
were not included in the patient selection criteria. You can apply this 
patient exclude option to any patient select criteria to display all the 
patients who are not in the current selection criteria. This feature saves 
you the steps of building a separate selection criteria if you want to see 
the patients excluded.
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Functions

Types of function values

Review can refer to Item values directly and as they exist in the database, 
or allow for user-defined function values. For example, the function 
‘actual value’ presents the raw data, or ‘Baseline’ presents a User-defined 
time-related milestone value. 

The list of functions changes according to the data type (Fixed, Text, 
Date, or Time) of the item selected. 

1. Click on the panel that contains the data.

2. Click on the item of interest.

3. Click on one of the default functions or user-defined functions 
described below.

‘Actual value’ function

When you select a function other than ’actual value’, which is the actual 
raw data of the last value entered. Review automatically introduces 
additional calculation or extraction logic options for the expression you 
are building. 

Derived function values

Derived forms of the functions, such as Baseline or Endpoint, can also be 
selected. Review provides default derived values, however the _New 
Event Function_ allows you to define a variety of time-related milestone 
functions. (See Chapter 12: Common Topics: New Events Function) 

Date function

If you select ’Calendar Year’ as a function for a Date type item for a 
selected panel, Review adds programming logic to reference the year 
portion of the Date type item. For example, you can enter ’1994’ in the 
Value box to retrieve all patients whose Date type item is in the year 
’1994’.
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Default date formats are set to 4 digit year (Year 2000 compliance) 
throughout the product. Also, local country specific conventions for 
dates and numbers.

Character (Text) type data is referenced with the following list of 
functions:

• actual value 

• decoded value (if coded type)

• baseline value

• endpoint value

Numeric type data adds the following functions:

• chg. from baseline: Defined in the configuration tables and/or user-
defined using _New Event Function_.

• % chg. from baseline: Defined in the configuration tables and/or user-
defined using _New Event Function_.

•  chg. from previous: Default derived value (measure determined from 
the last two measures).

Note: Review selects an appropriate function by default with respect for the data 
type of the item selected. The default function is assigned as the most likely 
function to be used for that type of item.

_New Event Function_

Select the pseudo-function _New Event Function_ and Review allows the 
user to define run-time related milestones that work like the baseline and 
endpoint values. The user-defined new events can be applied throughout 
the application, in patient selections, as well as reporting and graphing. 
(See Chapter 12: Common Topics: New Event Function)
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Displaying item statistics

Display stats
You can display the range and other basic statistics of the item by select-
ing an item and clicking Display Stats.

Hint: This function has meaning when applied to numeric data items and may 
not be significant for other values. 

The example for patient weight shows the total count of values, 
minimum value and maximum value. If the value is numeric, then the 
mean and standard deviation are included. This display represents the 
total population of patients within the protocols selected and the selected 
function. 
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Note:  In multi-protocol mode, there is one row for each protocol. 

Displaying subsets of protocol population

You can limit the displayed statistics for the patients meeting the patient 
selection criteria by checking “Subset using Select Criteria?”. If the 
checkbox is not checked, the statistics are for the total population. If the 
statistics are displayed when you update patient selection criteria, click 
Update Browsers to apply the updated patient selection criteria to the 
displayed statistics.
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If  is checked, the statistics in the corresponding 
window reflect the sub-population of patients that falls within your 
patient selection criteria. The patient selection criteria will only be 
applied to the population when Update Browsers is clicked. Any 
changes that you make in the Patient Selection Criteria that need to be 
reflected in the subset statistics must be preceded by clicking Update 
Browsers.
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Clintrial tags

Clintrial tags as pseudo-panel

Clintrial tags are accessible as selection criteria and reportable elements. 
For the pseudo-panel Clintrial tags, the items list shows registered tags 
when the pseudo-panel Clintrial tags is selected.
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Optional user-defined panels and joins

Pivot Panels
If you select the pseudo-panel item ‘_Define Pivot Panel_’, Review pro-
vides a point and click mechanism to transpose clinical data stored in a 
normalized manner, into a more easily reportable horizontal data struc-
ture. The created pivot panel objects are accessible throughout all Review 
browsers. 

The ‘_Define Pivot Panel_’ mechanism provides a method of storing such 
definitions centrally in Review's server-based global object storage site. 
(See Chapter 12: Common Topics: Server Based Global Object Storage Site and 
Chapter 12: Common Topics: Defining Pivot Panels)

Join Logic
Review provides automatic join logic. (See Chapter 12: Common Topics: 
Automatic Join Logic) 

In addition Review provides a mechanism, through the pseudo-panel 
‘_Define Join Logic_’, to configure complex join rules and force a join 
definition.

This mechanism is required to access Clintrial Type 0 panels that can be 
related to patient data, such as laboratory normal values. This tool 
provides a lookup capability on such Type 0 panels when selecting or 
reporting patient-level data. An example is to report patient level lab 
data and lookup for reporting purposes, the corresponding lab normal 
entry (typically stored in a type 0 panel). (For more information and 
instruction, (See Chapter 12: Common Topics: _Define Logical Joins)

Note: Your site administrator can set site and user configuration to enable or 
disable ‘_Define Pivot Panel_’ and ‘_Define Join Logic_’. Therefore, your patient 
selection criteria window for the panels listbox may appear different dependent 
upon the configuration setup.
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Object storage: saving your work

Object storage location

You can store patient selection criteria at four user access levels: Private, 
WorkGroup, UserGroup, or Public.

•  Private storage is at the local PC level. The private objects are saved 
on the user’s home drive in a directory (folder) called “irpat”. 
Review handles all creation, access and deletion of the private 
objects in this folder. Therefore, the user should not be concerned 
with the contents of the irprivat folder.

•  WorkGroup storage is PC based and stored at a shared network 
drive, to which a select group of personnel would have access. 

Note: The WorkGroup storage location was supported in earlier Review 
releases. UserGroup storage location is extensively used for later releases.

• UserGroup storage is a database object storage for defined 
UserGroups in the configuration tables.

Object storage in UserGroup level allows you to specify sharing 
with multiple UserGroups. This works when you click UserGroup 
and you are a member in a UserGroup, then the UserGroup listbox 
is enabled. If you want to share the object with multiple 
UserGroups, simply use the CTRL or SHIFT mouse click for 
multiple selections.

•  Public storage is also a database object storage for all users of 
Review. There is more user access when designated as Public 
versus limited access when setup for WorkGroup or UserGroup 
storage. 

Saving on database object storage sites, requires the author to have 
“Publishing Authorization” defined in the configuration tables. 
(See Chapter 12: Common Topics: Shared Object Storage- Locations)
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When you select UserGroup object storage location, the ‘Share with 
usergroups’ listbox is made available for selection.

Object level

You can store your patient selection criteria at three levels: Study, Project, 
or Global. The Object Level box is only enabled and highlighted when 
you select an Object Storage Location designated as ‘db’ for database. 
Therefore, when you select either UserGroup or Public for database 
object storage location, you can assign an object level to restrict access to 
a specific study level or share access between multiple studies at Project 
or Global levels. 
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Saving the selection criteria

To save the patient selection criteria (the rows of Criteria Expressions) 
you have created for later use:

1. Make certain that the Patient Selection Criteria window is the active 
window by clicking on its title bar.

2. Click , or from the File menu select Save. 

3. Review displays the Save Patient Selection Criteria dialog box where 
you can specify the storage location.

4. Enter the Object Storage Location and Object Level.

5. Enter a FileName for future reference to be displayed in the list box for 
Existing Files. 

6. Enter the folder(s) information in the Category box. Each folder 
(major, minor and subfolder) is separated by a period where folder 
titles can consist of more than one word separated by a space. For 
example, the major folder for ‘Safety’ has two minor folders 
‘Safety.AEs’ and ‘Safety.Labs’. Folder names are case-sensitive and 
after the folder(s) are initially created, they are selected from the 
dropdown listbox. 

7. Next enter the description including a summary paragraph for 
additional information to be viewed by yourself or others later.

8. Click Save. Review stores the Patient Selection Criteria to the 
designated PC, UserGroup, or Public storage location. 
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Override selected Project/Global object?

The purpose of the override is to create a study specific version of the 
standard object, in the non-standard study. For example, you create a set 
of global or project level objects and assume they should be applicable to 
all subjects in the study project (for project level) or all studies in the 
database (global level) based upon your internal standards. This may be 
true the majority of the time but then you encounter a non-standard 
study.   Therefore, when you are in the non-standard study this object is 
displayed in your list box and will suppress the project or global version 
to display the local version instead.
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Note:  The Override selected Project/Global object question is only available 
when you select UserGroup or Public for Study object level. Otherwise, the 
question is disabled when you select other object locations and levels.

Object Explorer window

Once you have saved your selection criteria and assign folder 
information, your folder(s) and selection criteria will display as a stored 
object in the Object Explorer Window under Patient Subsets. Review 
displays a list of folders for previously saved output specifications at the 
selected object storage location. Simply select one of the storage locations 
as Private, UserGroup or Public to display it’s specific folders and 
contents. Select the object storage location from the drop down list.
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Retrieve a saved selection criteria

If you want to retrieve a saved patient selection criteria:

1. Double click to open a folder. The filter icon displays along side the 
description to indicate the stored object is a patient selection criteria.

2. Double click to paste the selected patient selection criteria into the 
Patient Selection Criteria Window.

Append to criteria

At this point, you can either click Update Browsers to enable your 
selection criteria, or continue to add more criteria to the end of the 
currently loaded selection criteria with the ‘Append to criteria?’ check 
box. You can modify the patient selection criteria and resave to a new 
description and folder.

Note: To save time, you can launch and paste previously saved patient selection 
criteria from the Object Explorer Window to edit and resave as new stored 
objects. However, you must load the previously stored object first into the 
Patient Selection Criteria Window then append to or modify it. 

You can append a saved patient selection criteria to the current patient 
selection criteria:

1. Select and double click to add the first patient selection criteria.

2. Click .
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3. Select and double click another selection criteria to append.
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Another way to retrieve saved patient selection criteria is to make the 
patient selection criteria window the active window:

1. Click , or from the File menu, select Open.

2.  Click on the object storage location and the available files display.

3. To retrieve the saved patient selection criteria, select a selection criteria 
and click Open; or double click on the description. 

4. You can click the  to browse various object 
storage sites.
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Display all studies

By default, the  is not checked, and the displayed list of 
objects is limited to the selection criteria objects created in the current 
Study Protocol(s).

If you want to select a saved selection criteria object created and saved 
from another protocol:

1. Click Display all studies?. 

2. You then can select from any saved selection criteria object created. 

3. Select a foreign object and click Open. 

The internal data structure between the corresponding protocols is 
checked and validated and is immediately added to the current patient 
selection criteria as a new or appended criteria expression.

Note: By default, the stored patient selection criteria is only accessible on the 
project(s) it was created on. You can click on the  to import 
foreign objects. 
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Browsing saved selection criteria

You can browse through the saved patient selection criteria at the four 
object storage locations to review the summary text. When you find the 
one you are looking for:

1. Click on the entry.

2. Then click Open. 

Review pastes the saved patient selection criteria into the Patient 
Selection Criteria spreadsheet clearing the current spreadsheet 
contents.

Another way to append previously saved patient selection criteria is:

1. Select a saved patient selection criteria and enter into the Patient 
Selection Criteria Window.

2. Click the Open icon or from the File menu, select Open. The Open 
Patient Selection Criteria window displays.

3. Select the Object Storage Location to display previously saved objects.

4. Select the specification description you want to append.

5. Click , then click Open.

6. The saved specification is added to the current Criteria Expressions.

7.  Click Update Browsers to apply the new patient selection criteria 
against the protocol patient population.
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Object properties

You can view information about an object when you select “Properties”.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Properties. A dialog window displays whether the object is 
a patient selection criteria or an output object.
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Printing the selection criteria

To print the currently active patient selection criteria:

1. Make certain that the patient selection criteria window is active by 
clicking on its title bar.

2. Click , or from the File menu, select Print.

 Review displays the standard Print dialog box. 

3. Click OK. The patient selection criteria prints on the specified printer. 
To change the printer, from the File menu, select Print Setup.
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Quick remove

You can quickly delete a saved patient selection criteria (or visual subset) 
in the Object Explorer window under Patient Subsets. 

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Remove. You are prompted “Are you sure you want to 
delete the object?”.

The Remove function is a quick way to delete stored objects provided the 
user is the creator or a SuperUser. It works for ‘Private’, ‘Workgroup’, 
‘UserGroup’ or ‘Public’ objects equally. (See Chapter 12: Common Topics: 
SuperUser Privileges) 

Another way to remove one of the saved patient selection criteria (or 
visual subset):

1. Make the Patient Selection Criteria the active window. 

2. From the File menu, click Remove.

3. Review displays the Remove Patient Selection Criteria window.

4. Click on the object storage location. The stored patient selection 
criteria specifications are listed. Click ‘Visual Subsets?’, if the object is 
a visual subset.

5. Select the stored object description you want to remove.

6. Click Remove.
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Review deletes the selection criteria from the designated local PC, 
WorkGroup, UserGroup or Public storage location if you have security 
clearance to do so. 

Exploring data

Reviewing preferences

At any time, you can modify Review’s preference by selecting the Edit 
menu from the Patient Selection Criteria window, and selecting 
Preferences from.

Outer join in Results

If enabled, a patient’s data is included in browser results even if some 
panels of data are missing for that patient. (See Chapter 12: Common 
Topics: Reviewing Preferences)
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Display panel names

If enabled, panel lists display the panel name rather than the panel 
description. (See Chapter 12: Common Topics: Reviewing Preference)

Display item names

If enabled, item lists display the panel name rather than the panel 
description. (See Chapter 12: Common Topics: Reviewing Preference)

Sort panels alphabetically

If enabled, panel lists are sorted alphabetically; otherwise, panels are 
listed in the order in which they were created. (See Chapter 12: Common 
Topics: Reviewing Preferences)

Sort items alphabetically

If enabled, item lists are sorted alphabetically; otherwise, items are listed 
in the order in which they were created. (See Chapter 12: Common Topics: 
Reviewing Preferences)

Reviewing with browsers

After you specify the patient selection criteria to be used to retrieve 
patients, you can explore the patient population you selected using the 
browsers.

Activate the  Detail Data Browser. You can display a list of patients 
who meet the patient selection criteria specified and look at their detail 
data. (For more information, see Chapter 3: Reviewing Patient Data.)

Activate the  Patient Profiles Browser. You can organize the selected 
patients into various Workbook Report types as single worksheet mode 
or multiple worksheet mode. (For more information, see Chapter 4: 
Patient Profiles.)
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Activate the  Report Browser. You can create a quick report to list 
items of interest for each of the patients and patient populations meeting 
the patient selection criteria. (For more information, see Chapter 6: Report-
ing.)

Activate the  Graph Browser. You can look at items of interest 
graphically for patient populations meeting the patient selection criteria. 
(For more information, see Chapter 7: Graphing.) 

Activate the  CrossTab Browser. You can create CrossTab and Shift 
Tables for patient populations meeting the patient selection criteria. (For 
more information, see Chapter 8: CrossTab.)

Activate the  Statistics Browser. You can look at a variety of statis-
tics and other reports for items of interest for patient populations meet-
ing the patient selection criteria. (For more information, see Chapter 9: 
Generating Statistics.)

Activate the  SAS Program Browser. You can review prepro-
grammed SAS Production Tables against original SAS datasets used in 
the analysis for patient populations meeting the patient selection criteria. 
(For more information, see Chapter 10: Production Tables.) 

Activate the  Note Browser. You can review patient-level notes 
saved by yourself and others stored in Object Storage Levels for Private, 
UserGroup and Public. (For more information, see Chapter 3: Reviewing 
Patient Data.) 

Activate the  Document Browser. You can review documents for 
the selected protocol. (For more information, see Chapter 11: Accessing 
Documents.)
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Patient selection criteria

Subset patients
After building the patient selection criteria, you can quickly view a 
detailed list of patients who meet the patient selection criteria, by using 
the Data Browser. 
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Open the Data Browser

Listing of patients

Click , or from the Browse menu, select Data.

Review opens a new window that displays a list of patients who meet the 
patient selection criteria.

Note: Review displays the number of cases selected before the list of patients. The 
key clinical information for each patient, such as treatment group, case ID, sex, 
age, and so on, are also displayed and are custom-configurable through 
ReviewAdmin.

Data Review
To see more data for each patient selected:

1. Click anywhere in the row of the patient of interest. You can use Prev 
CASE or Next CASE to view data for the next or previous patient.

2. Select a panel.
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You can select several panels from the list of available panels in the 
protocol. Each panel selected displays a new window with a spreadsheet 
containing descriptions and data for the selected patient.

If the panel displayed contains multiple observations, all observations for 
this patient are displayed in the spreadsheet, ordered by the Visit Date.
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Graph format display

You can view a graph representation of numeric data from panels 
collected as multiple visits or observations. Initially when you open a 
panel the default display is the table format. 
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If you click the graph icon, the data is converted to a graph format with 
the patient’s minimum and maximum values listed in the first column.

Browsing through patient data

To browse patient data:

1. Select a patient.

2. Select the panels that you are interested in reviewing.

3. Position and size the panel view windows. 

4. Click each patient in succession or use Prev CASE or Next CASE. 
Each time another patient is selected, each open panel view window is 
updated to reflect the data for the currently selected patient. If the 
‘Freeze Case/Case Frozen’ function is toggled to Case Frozen, the 
panel view window displayed remains displayed(frozen) with the 
patient data they were frozen with. A Case Frozen Panel View is a 
static Panel View, even as you select other patients that will update in 
only Freeze Case Panel Views. 

When tags are on, the tags column updates with the Panel Detail Data 
View, reflecting the tags for the currently selected patient. (See Chapter 12: 
Common Topics; Tags: Clintrial Tags.)
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Displaying CRF images

If your CRF imaging system is configured into Review and you want to 
review an image of the original Case Report Form (CRF) behind the data 
displayed:

1. Click on the column heading of the data observation of interest.

2. Click Display Image. 

The CRF Image Viewer and the image corresponding to this data is 
displayed (if it is available in the CRF image archive database, which 
is not part of Review).

Note: If the CRF imaging system is not configured in Review, the Display 
Image is not available.

Audit trail
To review the historical editing of the original Case Report Form items, in 
reference to any of the panels:

1. Click on the column heading of the data observation of interest, 

2.  Click Audit Trail. 

The Audit trail window displays the data chronologically; the most 
recent editing of the original data input is in the left column and 
moves chronologically to the right. The last column is the original data 
entered. The Audit Trail documents the dates on which the data was 
edited, and saves a copy of the data before it was changed.

Note: Where any editing has taken place, the new values are highlighted from 
the previous values.  This function is available for Oracle Clinical and 
Clintrial data.
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Reviewing tags (flags and notes)

You can view all Clintrial tags (that is, flags and notes) about your clinical 
data (Clintrial 3 and 4 only). All labels and monitors of data quality 
issues, and discrepancies within your clinical data (data that is, not part 
of the case report forms or matching clinical data forms) are displayed in 
columns adjacent to the data columns.

To view tags:

1. Open the panel view you are interested in reviewing.

2. Click Tags, which will toggle to Tags ON.

3. Browse through the patient listing and review the tags.
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4. Click Tags ON to return the panel view to its default display. 

Within each observation, there can be tags attached to the entire 
observation (record) or to a specified item. The observation tags are 
displayed in the upper row of the adjacent Tags column (within the 
context data items.) The specified item tags are displayed in the 
corresponding data item row of the adjacent tags column.

Discrepancy records

Discrepancy record panel view

You can review the discrepancies (Clintrial 4.x only) occurring in a 
protocol by clicking on the Discrepancy Record panel in the Data 
Browser panel listing.

Creating discrepancy records 

You can create discrepancy records (Clintrial 4.x only) for discrepancies 
observed during a review of patient data. For example, you might 
observe that the vital signs data collected for a subject over several visits 
is unusually consistent, with none of the normal, expected variations. 
Before you investigate further, you can create a new discrepancy record 
to document your research.
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Selecting data for discrepancy record

The end user (with the ‘Create Access in Resolve’) can highlight a 
patients data value or data values from a Data Browser panel view, and 
instantly create a discrepancy record, by clicking Discrepancy. 

To select data values for the discrepancy record:

1. Click on data value or values.

2. When selecting non-contiguous data values, hold the Ctrl key while 
clicking on the values of interest. 
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3. You can also select a column of data, by clicking on the header of the 
appropriate column.

4. Click Discrepancy, and the New Discrepancy dialog box opens. The 
highlighted data value or values are automatically included in the 
discrepancy record. 

5. Enter a message in the discrepancy message field.
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6. Optionally assign a priority value to the record in the “Priority” field.

7. Click Create Discrepancy, and your discrepancy record is 
automatically created and accessible in the Discrepancy Log panel.

Avoid duplicate discrepancy records

All discrepancies are contained in a Discrepancy Record panel. To avoid 
creating a duplicate discrepancy record, you can first open the panel 
view of the Discrepancy Record panel to review existing discrepancy 
records.
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Patient level notes

Store and retrieve patient notes

You can store and retrieve patient level notes observed during data 
review within the Notes Browser. For example, you might validate 
information and make a note for future reference. The notes can be stored 
at Object Storage Levels as Private, UserGroup and Public. The author of 
the note has sole security to edit or remove the note(s), unless the 
individual has SuperUser privileges. (See Chapter 12: Common Topics: 
SuperUser Privileges)

1.  Click , or from the Browse menu, select Notes.

2. Select a patient to highlight in the Data Browser, active patient-level 
reports, patient listings, or Scatter Plot graphs.
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3. Click Add Note to open a new note for the selected patient. Click the 
cursor in the Note Text box to enter up to 256 characters. The text will 
word wrap to display the note. Hit Enter to end note. 

4. Enter the Object Storage Location by selecting from the ‘Access’ drop-
down list for Private, UserGroup and Public.

You can enter multiple notes per patient which display sorted by patient 
ID and date created. The spreadsheet can be exported or copied to 
clipboard with the same features as a report.

Movement between patients within the spreadsheet can be accomplished 
with the buttons for Prev Case and Next Case.
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Find menu command

You can perform a search for a key word in the Notes Browser. 

1. Click the Edit menu, select Find.

2. Enter the search criteria and Review will locate the first occurrence.

 The find function can also be used on any report results. 

Remove note
To remove a note:

1. Click , or from the Browse menu, select Notes.

2. Highlight the note to delete, click Remove Note.
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Multiple-patient mode

Freezing a case
As you browse through patient data in the Data Browser, you notice that 
each patient selection updates the open panel views. Review has an 
optional multiple-patient mode for the Data Browser. The multiple-
patient mode allows the review of different patient’s data at the same 
time. Each panel view has a Freeze Case button in the lower right corner. 
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Click the Freeze Case button and the button text changes to Case Frozen.  
When the Case Frozen button is present, data in the panel view is frozen 
and will not update when you select another patient.

To freeze multiple panel views: 

1. Select a patient. 

2. Select a panel. 

3. Click Freeze Case. 

This freezes the panel view on the screen, dedicating it to the patient that 
was selected at the time of freezing the case. The freezing function allows 
you to display many patients with the same panel view open at the same 
time, providing you with a useful comparative clinical protocols tool.

Note: A Case Frozen will not update with the selection of a new patient. A new 
window is generated when you click on the panel to be displayed, and/or updates 
the previously selected and open panel views not frozen.
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To unfreeze a panel view, click Case Frozen. 

A panel view that is not frozen will be updated when a different patient 
is selected. If you have frozen a number of panel views, and would like to 
unfreeze it and close them, you can close each one with or without 
unfreezing them by clicking on the System menu button in the upper left 
corner of each window, or you can close the Data Browser window itself 
and all open panel views will be closed. If you want to update all the 
frozen panel views click Case Frozen and select a new patient. 

The panel view updates to the selected patient and you can proceed to 
freeze that view for a new comparative exercise. 

Note: If you have opened more than one panel view of the same panel, any left in 
the unfrozen state become active updating panel views. You may want to 
individually close all but one unfrozen panel view per panel to reduce screen 
clutter and needless repetitious presentations of the same data. 
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CrossTab Browser results 

This feature facilitates patient identification down from the CrossTab 
categorical patient counts, to the underlying patient data via the Data 
Browser.

Clicking on a patient categorical count in the results CrossTab tables 
subsets and updates the open patient listing in the Data Browser, and 
opens Detail Data Listing reports to display those patients underlying the 
selected patient count.

Note: The CrossTab Browser does not allow multiple protocol selection. (See 
Chapter 8: CrossTab Browser: Patient selection criteria)
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Patient listings and panel views

Expanding spreadsheet columns

When Review displays multiple observations in the panel view 
spreadsheet, each column is automatically sized to a fixed width size. 
You can expand or contract the columns in the spreadsheet just as you 
would in any window’s spreadsheet program. 

1. Click and drag the cursor on the line between the column heading tabs 
(between B and C if you're expanding column B in the example 
below), and drag the cursor to the width desired. 

2. If you want to size all the columns in the spreadsheet, you can 
highlight the entire spreadsheet by clicking on the upper left 
spreadsheet column tab, and then size column B and each of the 
subsequent columns will then be the same width as column B.

Print Preview
To display a print preview of patients meeting the current patient selec-
tion criteria in the Data Browser window or data from a patient’s data 
panel:

1. Click on the title bar of the Data Browser window or Panel window to 
make it the active window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen. 

3. Click either Print or Close.

The Print Preview function is applicable to all browsers with output 
results.

Printing a patient listing

To print the list of patients meeting the current patient selection criteria:

1. Click on the title bar of the Data Browser window to make it the active 
window. 

2. Click , or from the File menu, select Print.

Review displays the standard Print dialog box.

3. Click OK.
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Printing a panel view

To print the data from a patient’s data panel:

1. Click on the title bar of the panel view window to make it the active 
window.

2. Click , or from the File menu, select Print.

Review displays the standard Print dialog box. 

3. Click OK.

Exporting a patient list or panel view

To export your table in Excel 4, 5 and 7, tab delimited files , HTML format 
or PDF files:

1. From the File menu, select Export. 

Review displays the Export dialog box. 

2. Enter the storage location.

3. Enter the storage type.

4. Click OK. 

Your patient list or panel view is exported to the currently selected disk 
directory. (See Chapter 12: Common Topics: Export Browser Display 
Spreadsheets; Copy and Paste Browser Results; Copying to Clipboard)
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Custom panels

Define custom panels

You can design your own custom panels for use within the Data Browser 
with _Define_Custom_Panel_. This feature allows you to select data 
items from a variety of panels, then save your custom panel with a 
description. 

1. Click _Define_Custom_Panel_ to open the Define Custom Panel 
window.
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2. From the Panels list, select the various data items you want included 
in your custom panel. You can double-click on the individual items or 
click ADD Item or ADD All Items. 

SAS datasets are listed with the panels generated from Oracle tables. 
Items from SAS datasets can be used like other items for building 
custom panels.

Note:The current restriction is you cannot mix items from SAS datasets and 
Oracle table generated panels within the same custom panel.

3. The Sort Order can be adjusted by clicking the arrows in this edit box.

4. Before saving your custom panel, you may want to apply an output 
filter criteria.
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Custom panel output filter

The operating features of the output filter are identical to the patient 
selection criteria window. You have access to all panels and underlying 
data items when creating an output filter. The output filter is designed to 
focus in on particular observations and visits; it is not designed to be 
used for the patient selection criteria. 

5. Click Filter Data.

6. Select your output filter criteria from the panels and items lists.

7. Click Save Filter and close the Filter Data window. The Define 
Custom Panel window will reset and display Filter is ON.

8. Enter a description to reference your custom panel and click Save.

The output filter looks and operates similarly to the patient selection 
criteria window. You select the panel item and value or range value to 
create a row filtering criteria. The selection of the values or range values 
are supported by Display Stats and Display Values. 
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As in the patient selection criteria, Display Stats instantly provides the 
basic descriptive statistics for the highlighted item, function, and value, 
and Display Values provides a listing of all values possible for the 
selected item, function, and value. Both Display Stats and Display 
Values present their respective listings for the whole protocol(‘s) 
population, unless you check Subset by Patient Selection Criteria. With 
Subset by Patient Selection Criteria checked, the respective information 
in these windows is limited to the patient subset created by the current 
patient selection criteria. (See Chapter 2: Selecting Patients: Display Values 
and Display Stats)
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You can now select your custom panels in Data Browser to view individ-
ual patients.

Update or remove custom panel

If you need to update or remove any custom panel:

1. Click _Define Custom Panel_ to open the Define Custom Panel 
window. 

2. Select a panel from the Custom Panels list. 

3. You can make changes to the custom panel and click Update or click 
Remove to delete from the custom panes list.
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Modifiable items

Defining modifiable items

If your data management system supports this feature, the 
 is displayed in the Data Browser window.

Caution: Once you create a modified item, it is permanently a part of your 
database, and only one modified item can be generated per parent item. 
The modified item name can not be changed, nor can the modified 
item be deleted. However, the data can always be modified by this 
pseudo Item from the source parent item.

Your ORACLE user ID must be authorized to define parallel modifiable 
items, and your underlying clinical data management system must 
support defining parallel modifiable items. You can define modifiable 
items at run-time. In the Data Browser, click Define Modifiable Items. 
Review displays a dialog box to allow the definition of a modifiable item:
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If you can select “Link New Item to Reference Item?”, the new item is 
tied to an existing item. The new modifiable item created becomes a 
parallel field using the same decode file (if applicable) and contains the 
identical values as the existing item.

If  is left unchecked, the new item is not 
tied to an existing item and no values are duplicated into it.

1. Select the panel in which you want to define the modifiable item.

2. Select the reference item upon which to base the item. Review fills in 
the description field with the description of the reference item. You 
should change the description slightly to better distinguish your 
version of the field.

Note: If you do not alter the new item’s description, it will display the same 
description as the reference item but flagged as the “modifiable version”. 

3. Select New Modifiable Item’s Type. 

4. Select whether to “Link New Item to Reference Item?”.

5. Click Create Item. 
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Review creates the new Item in the database on the server, and 
initializes the Item with the value of its reference Item for each patient’s 
observation. The modifiable item updates can be viewed through the 
custom panels.

Modifying data

If you have defined a modifiable data item, you can change the values of 
that item for any individual patient by using the Data Browser. 

1. Select the patient of interest.

2. Select the Panel of interest. 

The modifiable data Item is displayed at the end of the list of items in 
the panel. The modifiable data items are highlighted as shown in the 
KOH Exam (Inv) row below:

3. You can make changes directly in the cell of the modifiable data item. 
Your changes are stored in the database automatically.
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If you have multiple patients or modifiable data items, you can change 
the values of the item using the Report Browser. The modifiable data 
items are listed for reporting and can be updated from report window. 
(See Chapter 6: Reporting: Defining Report Specifications)

1. Select the panel(s) of interest.

2. Select the item(s) of interest.

3. Click  to edit the items from the 
created report. If left unchecked you are unable to modify the 
modifiable item from the report.

4. Click Create Report.

5. Click on the column for the modifiable item and edit the value.
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Modifying coded data

If the reference item for the modifiable data item is a coded data item (its 
values are decoded using a code list), when you click on the item to be 
modified, it changes to a drop down list. Select one of the possible values 
from the list:
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Reset items content

If you need to reset item contents after you have changed the defaulted 
values in the modifiable item, click Reset Item Contents. All values 
changes will be reset to the values of the reference item. This button is 
only enabled when the new modifiable item is linked to a reference item.
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Saving Data Browser specifications

Object storage location

You can store patient selection criteria at four user access levels: Private, 
WorkGroup, UserGroup, or Public.

•  Private storage is at the local PC level. The private objects are saved 
on the user’s home drive in a directory (folder) called “irpat”. 
Review handles all creation, access and deletion of the private 
objects in this folder. Therefore, the user should not be concerned 
with the contents of the irprivat folder.

•  WorkGroup storage is PC based and stored at a shared network 
drive, to which a select group of personnel would have access. 

Note: The WorkGroup storage location was supported in earlier Review 
releases. UserGroup storage location is extensively used for later releases.

• UserGroup storage is a database object storage for defined 
UserGroups in the configuration tables.

Object storage in UserGroup level allows you to specify sharing 
with multiple UserGroups. This works when you click UserGroup 
and you are a member in a UserGroup, then the UserGroup listbox 
is enabled. If you want to share the object with multiple 
UserGroups, simply use the CTRL or SHIFT mouse click for 
multiple selections.

•  Public storage is also a database object storage for all users of 
Review. There is more user access when designated as Public 
versus limited access when setup for WorkGroup or UserGroup 
storage. 

Saving on database object storage sites, requires the author to have 
“Publishing Authorization” defined in the configuration tables. 
(See Chapter 12: Common Topics: Shared Object Storage- Locations)
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When you select the UserGroup object storage location, teh ‘Share with 
usergroups’ listbox is made available for selection.

Object level
You can store your Data Browser specification at three levels: Study, 
Project, or Global. The Object Level box is only enabled and highlighted 
when you select an Object Storage Location designated as ‘db’ for data-
base. Therefore, when you select either UserGroup or Public for database 
object storage location, you can assign an object level to restrict access to 
a specific study level or share access between multiple studies at Project 
or Global levels. 

Store a selection of panel views

The Data Browser's patient listing, and the subsequent panel view 
windows, are provided for instantaneous data exploration and browsing. 
Selections of multiple open panel views can be saved as Data Browser 
objects. 

1. Open the panel views and size and position them in the locations to be 
saved. Make sure the Data Browser window is active.

2. From the FILE menu, select SAVE.
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3. Review displays the Save Data Browser window where you can 
specify the storage location. Select an object storage location.

4. Select object level type. The default is Study.

5. Click ‘Store Patient Selection Criteria?’ if you choose to save the 
current patient selection criteria with the output specification. When a 
user selects the stored object specification they can modify the 
selection criteria and still run the output. If the particular patient 
selection criteria is specific and required for the output, click ‘Stored 
Patient Selection Criteria Required?’.  In this instance, the patient 
selection criteria cannot be modified when this stored object 
specification is selected.  If none are selected, then no patient selection 
criteria is saved with the output specification.

6. Enter a FileName for future reference to be displayed in the list box for 
Existing Files. The Filename is for internal use and is not displayed in 
the Object Explorer window.

7. Enter the folder(s) information in the Category box. Each folder 
(major, minor and subfolder) is separated by a period where folder 
titles can consist of more than one word separated by a space. For 
example, the major folder for ‘Safety’ has two minor folders created as 
‘Safety.AEs’ and ‘Safety.Labs’. Folder names are case-sensitive.  After 
the folder(s) are initially created, they are selected from the dropdown 
listbox. 

8. Next enter the appropriate description which is displayed in the 
Object Explorer window.

9. You can include summary information for future reference to be 
viewed by yourself or others later. 

10. Click Save. Review stores the Data Browser Specification to the 
designated PC, WorkGroup, UserGroup, or Public storage location.
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Override selected Project/Global object?

The purpose of the override is to create a study specific version of the 
standard object, in the non-standard study. For example, you create a set 
of global or project level objects and assume they should be applicable to 
all subjects in the study project (for project level) or all studies in the 
database (global level) based upon your internal standards. This may be 
true the majority of the time but then you encounter a non-standard 
study.   Therefore, when you are in the non-standard study this object is 
displayed in your list box and will suppress the project or global version 
to display the local version instead.

Object Explorer Window

Once you have saved your Data Browser specification and assign folder 
information, your folder(s) and output specification will display as a 
stored object in the Object Explorer Window under Output 
Specifications.  A Data Browser icon will display next to your output 
description. If you saved a patient selection criteria with your output 
specification, then a filter icon would display next to the browser icon.
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Retrieve a saved Data Browser object

If you want to retrieve a saved Data Browser object:

1. Double click to open a folder.

The Data Browser icon displays next to the description.  If a filter icon 
displays along side the description it indicates the object was saved 
along with a patient selection criteria.

2. Double click to open the stored Data Browser object, or high light the 
seelcted object and click Execute.

Open saved Data Browser settings

Another way to retrieve saved Data Browser specifications is:

1. Make the Data Browser the active window.

2. From the File menu, click Open. Review displays the Open Data 
Browser window.

3. Select the object storage location to list stored data browser 
specifications.

4. Select a data browser description and click the Open button or double 
click on the report description.
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5. You can select the Data Browser storage locations.

a. Click  to browse various Data Browser object 
storage locations.

By default,  is inactive and the display of saved 
objects is limited to those created while reviewing the current study 
protocol. 

b. Check Display all studies?

All saved Data Browser specifications for all study protocols are 
displayed. If you open Data Browser specifications created in a 
different study protocol(s) than the one you are currently reviewing, 
Review validates all corresponding Data Configurations. If there is 
any variance in data descriptions and/or data structure, Review 
notifies the end user of the incompatibility and flags the items that are 
variant.

Note: Saved specifications using a pivot panel will only work with the pivot 
panel it was created with. If the same pivot panel is recreated with the same 
name, the objects using the original panel will not work because the system 
naming convention iterates with each created panel. (See Chapter 12: Common 
Topics: Pivot Panels)
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Quick remove
You can quickly delete a saved Data Browser object under the Output 
Specifications window.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Remove. You are prompted “Are you sure you want to 
delete the object?”.

The Remove function is a quick way to delete stored objects provided the 
user is the creator or a SuperUser. It works for ‘Private’, ‘Workgroup’, 
‘UserGroup’ or ‘Public’ objects equally. 

Note: You cannot schedule a saved Data Browser specification.

Another way to remove a stored Data Browser specification:

1. Open the Data Browser to make it the active window. 

2. From the File menu, click Remove. Review displays the Remove Data 
Browser window.

3. Click on the object storage location. A list of the stored data browser 
specifications display.

4. Select the stored Data Browser description you want to remove. Click 
Remove.

Review deletes the Data Browser settings from the designated local PC, 
WorkGroup, UserGroup or Public storage location if you have security 
clearance to do so. (See Chapter 12: Common Topics: SuperUser Privileges)
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Object properties

You can view information about an object when you select “Properties”.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Click Properties. A dialog window displays the object properties for 
the output object. 
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It works for ‘Private’, ‘Workgroup’, ‘UserGroup’ or ‘Public’ objects 
equally. 

Updating the Data Browser

The Data Browser's patient listing and the subsequent panel view 
windows enable instantaneous data exploration and browsing. 

1. Change the patient selection criteria, refining it by adding additional 
expressions, or removing existing expressions.

2. Click Update Browsers in the Patient Selection Criteria Window to 
update all active browsers according to the new criteria.

The Data Browser, patient listing, panels, and active browser 
specifications (objects) are displayed and updated according to the 
implementations of new patient selection criteria.
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Closing panel views and the Data Browser

Closing a panel view

If you are finished reviewing data for a particular panel, double-click on 
the window’s close box, as you would with any other window.

Closing the Data Browser window

If you are finished reviewing the panel view completely, double-click on 
the close box of the Data Browser window. Review closes all panel views 
currently opened.

Exploring data

Changing the patient selection criteria

Each time you modify the patient selection criteria, the Data Browser 
instantaneously provides a listing of the patient population that meet the 
patient selection criteria. Using the Data Browser, you can rapidly review 
all selected patient data, and compare it to data for other patients or to 
CRF image sources, and note and review tagged patient data. You can 
also review all data editing with audit trail access, for any data item. 
All patient-level browser displays interact with the patient selection crite-
ria similarly, and update to display the patient inclusion defined in the 
patient selection criteria.

Patient identification

You can select and subset multiple patients from all patient level displays 
of data and CrossTab result tables, to generate corresponding patient 
listings in the Data Browser and Detail Data Listing Reports. This 
facilitates patient identification and detailed patient data review via the 
reviewing tools of the Data Browser. 
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Discrepancy reports

You can manually browse patient data, identify discrepancies and 
document your review of the study data. You can instantly create 
automatic discrepancy reports based on the data value, multiple values, 
or columnar data clusters that you highlight.

Detail Data Listing reports 

You can click and on a patient row of interest and release.   Instantly, the 
open Data Browser, Scatter Plot Graphs, update to reflect the selected 
patient. The selected patient will be highlighted in patient listings and 
highlighted in Scatter Plot Graphs.

Scatter plot graphs 

You can click and drag to outline a region on a graph. All patients within 
the outlined region comprise the new patient subset. The open Data 
Browser patient listing, open Detail Data Listing reports, and other open 
Scatter Plot graphs update to identify and characterize the new subset of 
patients. 

CrossTab table results

Clicking on the patient counts in CrossTab result tables instantly updates 
the Data Browser, the Detail Data Listing reports, and Scatter Plot graphs 
to identify and characterize all underlying patients.

Data Browser and pivot panels

Pivot panels provide a powerful display of data, and provide a data 
structure that can be uniquely utilized by the Data Browser in producing 
clinically pertinent presentations of data “on the fly.” Using the Data 
Browser Panel View, you instantly are provided views of the created 
Pivot Panel. Such views make viewing relational clinical data results easy 
and dynamic. (See Chapter 12: Common Topics: Define Pivot Panel.)
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Data Browsers and join logic

The Data Browser provides instantaneous viewing of all panels within a 
protocol or common between multiple protocols. This includes Clintrial 
Type 0 panels. The Data Browser’s panel view facilitates the viewing of 
all panel items within each panel. The panel view is a companion utility 
to the pseudo-panel ‘Defining Join Logic_’ utility.   ‘_ Define Join Logic_’ 
provides an opportunity to investigate relations within the clinical data 
defined by medical investigators. Join Logic defined for the Clintrial 
Type 0 panel is required to utilize the data items within Clintrial Type 0 
panels. However, joins can be defined using any panel available. (See 
Chapter 12: Common Topics: Define Join Logic.)
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Patient Profiles Browser

Selection set
You can quickly capture a subset of the patient population that you wish 
to view by building the patient selection criteria. 

Open Patient Profiles Browser

Click , or from the Browse menu, select Patient Profiles.
Patient Profiles Browser 145



Le
ve

l 1
 b

le
ed
Review opens the Patient Profiles Browser window which displays a list 
of patients who meet the patient selection criteria or all patients if no 
selection criteria was defined. The study and PID (patient id) are listed 
for identification. 

Define patient profile matrix

When the Patient Profiles Browser window initially opens the patient 
visit information is not yet retrieved until you define the patient profile 
matrix. The patients listed display a message stating ‘Patient visit 
information not yet retrieved’.   This allows for faster retrieval of detailed 
patient visit information and lets you select the patients and visits you 
want to view.

1. Click Define Matrix.

2. Use the Add Panels and Remove Panels buttons to select panels.

3. Click OK.

The first 10 patients display all their visit information. All visit numbers 
are listed for the active patients as a way to track individual patient study 
status by visit. The remaining patients listed display the message stating 
‘Patient visit information not yet retrieved’. 

4. To retrieve additional patients, highlight multiple patients and click 
Retrieve Visits for Selected Patients.

5. Click Retrieve All Visits for all remaining patients.    
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Note: All patient related panels and included items are listed, not foreign or 
pivot panels.

Selecting a workbook type

Initial default settings

Initially the Patient Profiles Browser opens for Workbook Report type 
and default settings for the data is organized by panel, and visit related 
data is represented by rows and single worksheet display. The autosize 
column is turned ON and the header information is left blank for you to 
define.

At this point, you can select a patient from the patient list by using the 
Prev Case or Next Case buttons to scroll. When you click Create Patient 
Profile, a single worksheet mode with the default settings will be 
created.

Once you have opened Patient Profiles Browser, you can organize the 
selected patients into various Workbook Report types as single 
worksheet mode or multiple worksheet mode. In addition, you can 
change the sort by visit or panel and the visit representation as row or 
column in the spreadsheet display.
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Single worksheet mode

The single worksheet mode can be organized by panel or visit.

• By panel lists a single worksheet for all data for all panels included 
where there is data for the active patient. It will display in the order 
that has been defined and visits are sorted numerically.

• By visit lists a single worksheet for all data for all visits for the active 
patient and the visits are sorted numerically.

Visit representation only pertains to data collected as multiple visits 
where there exists one observation per patient per visit. You select the 
display option by row where each row represents a visit or by column 
where each column represents a visit. This applies only when the 
worksheet is organized by panel. 

Note: When the worksheet mode for by visit is selected then the visit 
representation options are not available.
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The example below shows the Patient Profiles Browser in single 
worksheet mode for the options by panel and visit representation as row. 
When the single worksheet mode is generated a single tab displays at the 
bottom as ‘Patient Profile’.

The Toolbar displays the + and - signs to move between patients and to 
jump to the first or last patient.
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The next example shows the Patient Profiles Browser in single worksheet 
mode for the options by panel and visit representation as column.
150 Chapter 4:  Patient Profiles



Level 1 bleed
This example shows the Patient Profiles Browser in single worksheet 
mode by visit presented in rows.
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Multiple worksheet mode

The multiple worksheet mode can be organized by panel or visit.

• By panel creates separate worksheets for each panel that has been 
included and there is data for the active patient. It will display in 
the order that has been defined.

• By visit creates separate worksheets for each visit that has been 
included and there is data for the active patient. It will display in 
the order that has been defined.

This example shows the Patient Profiles Browser in multiple worksheet 
mode for the options by panel and visit representation as row. This 
options displays the tabs organized by panel label.
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The next example shows the Patient Profiles Browser in multiple 
worksheet mode for the options by panel and visit representation as 
column. The tabs are also organized by panel description.
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This example shows the Patient Profiles Browser in multiple worksheet 
mode for the options by visit represented as rows. The tabs are 
sequenced by visit number.
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Defining a patient profile

Modify profile content

Up to this point you have selected the single worksheet or multiple 
worksheet mode with the display settings for panel versus visit. When 
you clicked Create Patient Profile all panels and items would be 
included in the patient profile generated. The display order of the panels 
defaults from the list of panels available.

To modify the panels and items displayed in a patient profile:

1. Use the Add Panels and Remove Panels buttons to select panels 
defining the patient profile.

2. Use the Up and Down arrows located next to the Panels Included list 
box to change the sort order of the panels displayed.

3. Use the Add Items and Remove Items buttons to select specific items 
for display.

4. Use the Up and Down arrows located next to the Items Included list 
box to change the sort order of the items displayed.

5. Click Create Patient Profile. The modified panel and item contents of 
the patient profile displays.

Access to SAS datasets

SAS datasets are listed with the panels generated from Oracle tables. 
Items from SAS datasets can be used like other items for building patient 
profiles.

Note: The current restriction is you cannot mix items from SAS datasets and 
Oracle table generated panels within the same patient profile.
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Define Sub Panel

The _Define Sub Panel_ function is selected from the panels list box. 
When you define a sub panel the function is similar to cloning a panel. If 
you have a complex panel with different types of data you may wish to 
divide the panel into more meaningful categories or sub panels. For 
example, Physical Exam and Vital Signs panel can be split into sub panels 
for easier viewing. Simply select the panel and enter a sub panel 
description. The new sub panel is added to the Panels Included list for 
selection to add and remove items for display. When defining a sub panel 
you can only select a single panel. Multiple visit panels display as 
vertical or horizontal.

Define Header
The profile content and appearance can additionally be modified with 
the following functions:

Click Define Header to open the Header Definition window which lists 
all the patient related panels types (not foreign or pivot) that are one 
observation per patient. You can select up to nine items from the listed 
panels by using the add item button and multiple items can be selected.
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1. Click Define Header from the Patient Profiles Browser window. 

2. Select a panel.

3. Select the items from the various panels to add as header information. 
Use the Add Items and Remove Items buttons to include or remove 
items from the header definition. As a short cut, you can double click 
on the individual items to add them or highlight multiple items to add 
or remove.

4. Click Save Header and close window. The Patient Profiles Browser 
window will show the status of the button changed to ‘Header is 
Defined’. 
Defining a patient profile 157



Le
ve

l 1
 b

le
ed
5. Select a patient from the patient list and click Create Patient Profile.

The defined header information will appear only once at the top in the 
single worksheet mode. In the multiple worksheet mode, it will 
display at the top of each worksheet whether organized by panel or 
visit.

Once a patient profile is created and displayed, you can change the 
active patient selected and the patient profile will be updated. 
However, if you choose to modify any of the display options while the 
patient profile display window is open the profile will not be updated. 
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Customize patient profile output

Click Customize to view the default settings for all panels regarding 
display orientation, maximum number of columns and number of ID 
items. You can make changes to these options on a individual panel basis.

1. Panels shaded in gray have a locked orientation. Panels displayed in 
white are unlocked and you can on the cell to access the orientation 
drop down list to select horizontal or vertical.
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2. The maximum number of columns displayed per row can also be 
changed. The range is 8 through 13 selected from the drop down list.

3. The option to display ID items as represented by the PatientNo and 
VisitNo are also selected from a drop down list for choices are 0, 1 and 
2. If a panel row wraps beyond the maximum number of columns 
defined, you can repeat the display of ‘1’ or ‘2’ ID items onto the next 
row. If you select ‘0’ ID items then only the initial row contains ID 
items.

4. Click OK to save changes. 
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Sort Order
Click Sort Order to open the Profile Sort window. It is advised to define 
all areas of the profile prior to defining the sort. When you apply any sort 
options they are applied within the individual patient profile.

Note:  When a profile is organized by visit the user does not have the option to 
sort panels by any other items. The Sort Order button is shaded and disabled.

• Sort Order can be applied to All Included Panels or Individual 
Panels.

• The All Included Panels option allows you to define a sort order on 
those items present in all the included panels. This option will apply 
the sort order across all panels in the Patient Profile.

• The Individual Panels option allows you to define a sort order based 
on specific panels and items. This option will apply the sort order 
across to specific panels.

• For each individual panel selected and a sort option entered, an 
asterisk displays next to the panel name flagging the panel has an 
active sort option.

• When you select multiple items the sort order can be changed by 
clicking on the item and using the arrow buttons.

• Any item in the sort order can be identified as ascending or 
descending by clicking the item and the Sort Options.

• An item can be removed or added to the sort order with the Add Item 
and Remove Item buttons.
Defining a patient profile 161



Le
ve

l 1
 b

le
ed
Filter Output

Patient Profile Filter Output

After you define the specifications of your Patient Profile, you can use the 
Filter Output as a data exploration tool by filtering data inclusion, then 
comparing filtered and unfiltered results. 

Filter Output works in the Patient Profiles where only included panels 
are viewable and selectable for filtering in the Filter Output window. 

The reason behind this is that in a patient profile, each panel is displayed 
individually and is not joined with any other panel. Therefore, filtering 
criteria from any other panel would not apply to a panel used in profiles.

1. Click the Output Filter button in the Patient Profiles Browser window. 
The Patient Profile Output Filter window opens. 

2. The All Included Panels option allows you to define an output filter 
based on those items present in all the included panels. This option 
will apply the output filter across all panels in the Patient Profile. 
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3. The Individual Panels option allows you to define an output filter 
based on specific panels and items. This option will apply the output 
filter across to panels. 

4. Click Save Filter. The Filter Output button in the Patient Profile 
Output Filter window toggles to Filter is ON. The output filter is 
applied to the patient profile when you click Create Profile.

For each individual panel selected and a result filter entered, an 
asterisk displays next to the panel name flagging the panel has an 
active output filter.

Patient Profile display

Expanding spreadsheet columns

When Review displays multiple observations in the panel view 
spreadsheet, each column is automatically sized to a fixed width size. 
You can expand or contract the columns in the spreadsheet just as you 
would in any window’s spreadsheet program. 

1. Click and drag the cursor on the line between the column heading tabs 
(between B and C if you're expanding column B in the example 
below), and drag the cursor to the width desired. 

2. If you want to size all the columns in the spreadsheet, you can 
highlight the entire spreadsheet by clicking on the upper left 
spreadsheet column tab, and then size column B and each of the 
subsequent columns will then be the same width as column B.
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Print Preview
To display a print preview of a patient profile in the Patient Profile out-
put window:

1. Click on the title bar of the Patient Profile window to make it the active 
window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen.

3. Click either Print or Close.

Note: The Print Preview function is applicable to all browsers with output 
results.

Printing a patient profile

To print the patient profile of the selected patient:

1. Click on the title bar of the Patient Profile window to make it the active 
window. 

2. Click , or from the File menu, select Print.

Review displays the standard Print dialog box.

3. Click OK.

Note: When you select Print Preview or Print for the selected Patient Profile, a 
signature line with the date is printed at the bottom of the worksheet.
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Exporting a patient profile

To export your table in Excel 4, 5 and 7, tab delimited files, HTML format 
or PDF files:

1. From the File menu, select Export. 

Review displays the Export dialog box. 

2. Enter the storage location.

3. Enter the storage type.

4. Click OK. 

Your patient profile is exported to the currently selected disk directory. 
(See Chapter 12: Common Topics: Export Browser Display Spreadsheets; Copy 
and Paste Browser Results; Copying to Clipboard.)
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Formatted Patient Profile

Select formatted profile

When you select the Formatted Profile type the format options menu 
displays for you to apply setting changes. Initially if you click create 
profile the default settings are organized by panel and visit 
representation as by row. The formatted profile default is generated with 
all panels including all items for a single selected patient. 

.
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This example is a partial enlarged view of a formatted profile with 
default settings. There is a scroll bar located on the right to move between 
pages for a single patient. To move between patients use the page by 
buttons for plus and minus to go to the next or previous patient. A Zoom 
In button is available and a scale to enlarge or reduce the view.
Formatted Patient Profile 167



Le
ve

l 1
 b

le
ed
Activate Page Break

The activate page break default is set to OFF. However, you can select to 
turn ON page breaks for Organized By Panel or Visit.

Apply Page Header and Footer

To enter descriptive information to the Header and Footer area:

1. Click on the Page Header/Footer button to open Profile Page Headers 
and Footers window. 

The default settings for headers are:

a. Default title is the profile type displayed in the center cell as 
Formatted Profile with PatientID below.

b. Date and Time on the right.

c. Font is BOLD 10.
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2. Click a particular column/row cell within the template for your item 
or text entry location. Each cell can contain up to two items.

3. Use the Edit Modes to Replace or Append changes.

4. Use the various item button selections to add Header information and 
the Add Text button to enter free text descriptions. You may click on a 
cell and use the scissors icon to delete the contents.

5. Click the Font button to change font, style and size. 

6. Click Display Footers. 

7. Follow the same steps to enter and make changes to the footer. The 
default settings for footers are:

a.  Patient Selection Criteria and Output Filter on the Left.

b. Page number on the right.

c. Underline above the footer.

d. Font is BOLD 10.

8. Turn the Footer Underline ON or OFF.

9. Click OK to apply format changes.
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Format Column Headings

To open the Profile Column Headings Formatting window click on the 
Format Column Headings button. The default settings for all column 
headings are:

• Font is BOLD 8.

• Overall Alignment - Center.

• Individual Panel Alignment - Center.

• Borders set to Underline is ON.

To apply Overall Column Header Formats:

1. Click the Font button to change font, style and size.

2. Change the borders.

3. Apply a Specific Column Header Format by clicking the drop down 
list for alignment. Change from default center to auto, left, or right.

4. Change Overall Alignment or Individual Panel Alignment.

5. Click OK to apply format changes.
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Format Columns

To open the Profile Column Formatting window click on the Format 
Column button. 

• Font is Regular 8.

• Overall Alignment - Auto.

• Individual Panel Alignment - Auto.

1. Click Overall Column Formats to apply overall formats to font, style 
and size.

2. Change Overall Alignment or Individual Panel Alignment from auto 
to left, center or right.

3. Click the Alignment drop down list to align the item display for auto, 
left, center, or right.

4. Click Row Results to apply Print Change for a particular column.

5. Click OK to apply format changes.
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Preview/Page Setup

Click Preview/Page Setup to view the Preview window of the formatted 
profile. It is recommended to apply any settings in the following 
sequence since sizing of the individual columns on the grid in design 
mode will change the column widths. It is advised to set Page Setup 
before the setting of the column widths since changing the page 
orientation, left margin size or right margin size will set the column 
widths back to their default settings. 

1. Start with Page Setup.

2. Apply Number of ID Items.

3. Apply Individual Panel Orientation for horizontal versus vertical.

4. Column width can be set in one of three ways: Shrink to fit columns, 
Autosize or adjust individual columns.

5. Click Refresh to view changes. 
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Page Setup

The default display is landscape and the settings are maximum column 
width of one inch. The width is set to fit all columns on a page depending 
upon the number of columns in the profile. The default number of 
columns is ‘11’of all equal widths.

Number of ID items

The option to display Number of ID items as represented by the 
PatientID and VisitNo has selections for ‘None’, ‘First Item’ or ‘First 2 
Items’. If a panel row wraps beyond the maximum number of columns 
defined, you can repeat the display of ‘First Item’ or ‘First 2 Items’ onto 
the next row. If you select ‘None’ then only the initial row contains ID 
items. The selection can be made from All Included Panels or Individual 
Panels.

The default setting is for ‘First Item’ where the first row of all panels 
always displays the PatientID and VisitNo with any wrapped row 
displaying the PatientID.
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Panel Orientation

Changing the individual panel orientation is restricted to visit oriented 
data collection where one record is collected once for each visit. For 
example, vital signs or laboratory results may be collected once for each 
patient at a visit. Data collected only once or multiple times for each 
patient and not related to a particular visit is restricted to horizontal 
display, i.e., Concomitant Medication, Medical History, etc.

1. To change an individual panel orientation, select Individual Panels.

2. Select the panel. The default setting is horizontal.

3. Click the individual Panel Orientation drop down list to change the 
panel orientation.

4. Change the Maximum Visits Displayed in Row selecting from the 
drop down list. The choices are 5 to 9.

5. Click Refresh to view panel orientation change.

Note:  The grid in design mode only displays when you select Individual Panels. 
174 Chapter 4:  Patient Profiles



Level 1 bleed
Column width
• Click the Shrink to Fit Columns and Refresh to view all columns to fit 

on the page. All columns are of equal width with horizontal default set 
to 11 columns.

• Click the Autosize Columns and Refresh to expand each column to 
it’s maximum width. The individual data column width is adjusted 
for heading and data.

• Click Individual Panels to display the design grid. Select a panel and 
resize individual columns within the selected panel. Click and drag 
the cursor on the line between the column heading tabs to the desired 
width. Click Refresh.
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• When you select Individual Panels and select a panel you can apply a 
row break at a particular item by selecting ‘Yes’ for Last Column in 
Row. Click Refresh to view your changes. 
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Object Storage: saving your work

 Object storage location

You can store patient selection criteria at four user access levels: Private, 
WorkGroup, UserGroup, or Public.

•  Private storage is at the local PC level. The private objects are saved 
on the user’s home drive in a directory (folder) called “irpat”. 
Review handles all creation, access and deletion of the private 
objects in this folder. Therefore, the user should not be concerned 
with the contents of the irprivat folder.

•  WorkGroup storage is PC based and stored at a shared network 
drive, to which a select group of personnel would have access. 

Note: The WorkGroup storage location was supported in earlier Review 
releases. UserGroup storage location is extensively used for later releases.

• UserGroup storage is a database object storage for defined 
UserGroups in the configuration tables.

Object storage in UserGroup level allows you to specify sharing 
with multiple UserGroups. This works when you click UserGroup 
and you are a member in a UserGroup, then the UserGroup listbox 
is enabled. If you want to share the object with multiple 
UserGroups, simply use the CTRL or SHIFT mouse click for 
multiple selections.

•  Public storage is also a database object storage for all users of 
Review. There is more user access when designated as Public 
versus limited access when setup for WorkGroup or UserGroup 
storage. 

Saving on database object storage sites, requires the author to have 
“Publishing Authorization” defined in the configuration tables. 
(See Chapter 12: Common Topics: Shared Object Storage- Locations)
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When you select the UserGroup object storage location, the ‘Share 
with usergroups’ ListBox is made available for selection.

Object level

You can store your output specification at three levels: Study, Project, or 
Global. The Object Level box is only enabled and highlighted when you 
select an Object Storage Location designated as ‘db’ for database. 
Therefore, when you select either UserGroup or Public for database 
object storage location, you can assign an object level to restrict access to 
a specific study level or share access between multiple studies at Project 
or Global levels. 
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Saving Patient Profile specifications

To save the patient profile specification you have defined for later use:

1. Make certain that the Patient Profiles Browser window is the active 
window by clicking on its title bar.

2. Click , or from the File menu select Save. 

3. Review displays the Save Patient Profiles Browser dialog box where 
you can specify the storage location. 

4. Select object level type. The default is Study.

5. Click Store Patient Selection Criteria if you choose to save the current 
patient selection criteria with the output specification. When a user 
selects the stored object specification they can modify the selection 
criteria and still run the output. If the particular patient selection 
criteria is specific and required for the output, click Patient Selection 
Criteria required. In this instance, the patient selection criteria cannot 
be modified when this stored object specification is selected. If none 
selected, then no patient selection criteria is saved with the output 
specification. 

6. Enter a FileName for future reference to be displayed in the list box for 
Existing Files.   The Filename is for internal use and not displayed in 
the Object Explorer window.

7. Enter the folder(s) information in the Category box. Each folder 
(major, minor and subfolder) is separated by a period where folder 
titles can consist of more than one word separated by a space. For 
example, the major folder for ‘Safety’ has two minor folders 
‘Safety.AEs’ and ‘Safety.Labs’. Folder names are case-sensitive and 
after the folder(s) are initially created, they are selected from the drop 
down listbox.
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8. Next enter the appropriate description which is displayed in the 
Object Explorer window.

9. You can include summary information for future reference to be 
viewed by yourself or others later. 

10.Click Save.

Review stores the output specification to the designated PC, WorkGroup, 
UserGroup, or Public storage location. 

Object Explorer window

Once you have saved your patient profile specification and assign folder 
information, your stored object will display in the Object Explorer 
Window under Output Specifications.

Review displays a list of folders for previously saved output 
specifications at the selected storage location. Simply select one of the 
storage locations as Private, UserGroup or Public to display it’s specific 
folders and contents.

Note: Graphic Patient Profiles can not be scheduled or the output saved.
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Icons are displayed along with the stored object to identify the source as 
report, graph, registered SAS program, etc. When a patient selection 
criteria is saved with the stored object; the filter icon displays with the 
specific browser icon. 

Saved objects and their associated icons can be sorted to display in the 
their folders by icon type or description. Simply click sort by Type or by 
Description.

Object Explorer quick execute

The Object Explorer window aids users to quickly locate and launch 
previously saved objects stored within organized folders. This shortcut 
allows users to bypass opening the individual browsers to launch saved 
objects.

If you want to retrieve a saved output specification:

1. Double click to open a folder.

2. Click on the output specification and click Execute.

Your stored output specification will be launched.

If you want to apply a saved patient selection criteria to your output 
specification:

1. Double click to open a folder.

2. Double click to paste the selected patient selection criteria into the 
Patient Selection Criteria Window. Then follow the above steps to 
retrieve and execute a stored output specification. Or create your own 
selection criteria for a stored output specification.
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Retrieving a saved Patient Profiles specifications

Another way to retrieve a previously saved Patient Profiles specifications 
from the Patient Profiles Browser: 

1. Make the Patient Profiles Browser window as the active window.

2. Click Open, or from the File menu. The Open Patient Profiles Browser 
window displays.

3. Select the object storage location. Review displays a list of stored 
Patient Profiles Specifications.

4. Select a Patient Profiles description and click the Open button or 
double click on the description.

Note: You must use the Open Patient Profiles Browser window to access the 
object storage location for ‘WorkGroup’.   

a. If you want to browse and/or select a file from the WorkGroup, 
UserGroup or Public storage sites, click on the site and the files 
available to you are displayed in the following window. 

b. Click Change WorkGroup Location, and you are enabled to 
browse various Patient Profiles object storage sites.

5. You can browse through the Patient Profiles specification by 
reviewing the summary text. Click on the Patient Profiles 
specification, and click Open. Review pastes the Patient Profiles 
layout specifications into the layout spreadsheet, clearing the current 
spreadsheet contents.

6. By default, Review displays only saved Patient Profiles specifications 
created while reviewing the current Study Protocol(s). You may also 
import Patient Profiles specification created for other Study 
Protocol(s). Check “Display all studies?” and open any available 
Patient Profiles Browser specification. Review will validate the data 
structure to verify that the foreign Patient Profiles specification is 
compatible with the current study protocol(s).
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Object properties

You can view information about an object when you select “Properties”.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Properties. A dialog window displays the object properties 
for the output object. It works for ‘Private’, ‘Workgroup’, ‘UserGroup’ 
or ‘Public’ objects equally. 
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Quick remove

You can quickly delete a saved Patient Profiles Browser object under the 
Output Specifications window.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Remove. You are prompted “Are you sure you want to 
delete the object?”.

The Remove function is a quick way to delete stored objects provided the 
user is the creator or a SuperUser. It works for ‘Private’, ‘Workgroup’, 
‘UserGroup’ or ‘Public’ objects equally. 

Removing a saved Patient Profiles specification

Another way to remove one of the saved Patient Profiles specifications if 
you decide it should be deleted:

1. Open the Patient Profiles Browser to make it the active window. 

2. From the File menu, click Remove.

3. Review displays the Remove Patient Profiles Browser window.

4. Click on the object storage location.

5. Select the stored Patient Profiles description you want to remove.

6. Click Remove.

Review deletes it from your local PC, WorkGroup, UserGroup or Public 
storage sites as you designate and have security clearance to do so.
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Printing the Patient Profiles specifications

To print the currently active Patient Profiles specification, make certain 
that the Patient Profiles Browser window is active by clicking on.

1. Click Print, or from the File menu, select Print. Review displays the 
standard print dialog box. 

2. Click OK. Repeat column headers are printed on each page in the 
printout.

3. To change the printer, select Print Setup from the File menu.

Closing Patient Profiles Browser

Closing the Patient Profiles Browser

If you are finished with all Patient Profiles, and do not want to define any 
other Patient Profiles: double-click on the close box of the Patient Profiles 
Browser window. 

Review closes all Patient Profiles windows currently opened.
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Patient Profiles Browser

Open Patient Profiles Browser

Optionally define a patient selection criteria to quickly capture a subset 
of the patient population that you wish to view. 

Click , or from the Browse menu, select Patient Profiles. Review 
opens the Patient Profiles Browser window which displays a list of 
patients who meet the patient selection criteria or all patients if no 
selection criteria was defined. The study and PID (patient id) are listed 
for identification. The default profile opens in Workbook Profile type. 
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Graphic Patient Profile

Access Graphic Patient Profile

Users with access to the Patient Profiles have the option to access Graphic 
Patient Profiles where the data is viewed in intuitive, graphic format. You 
can create, execute and save graphic patient profile objects at the global, 
project and study levels and in either local, usergroup or public object 
locations. The user can create graphic patient profile specifications within 
the limits set by the currently defined graphic patient profile templates.

The patient data is displayed from multiple data domains and plotted 
against a common time axis. The display style for each domain depends 
upon the kind of data, for example, duration events such as Adverse 
Events are plotted as horizontal bars showing the duration of the event, 
from onset date to end date.

Define Graphic Profile Template

Graphic Profile Template

A Graphic Patient Profile template must be defined first before users can 
create graphic patient profile specifications. SuperUsers with the 
privilege to “Create Graphic Patient Profile Templates” access the 
Graphic Patient Profile template feature from the Patient Profiles 
Browser window and create a graphic patient profile template. If none 
exists, a message displays and the user is exited from the graphic patient 
profile option.

If you have privileges to define a graphic template; this message box 
displays asking if you wish to create a template now. Click Yes and the 
Graphic Patient Profiles Template window opens.
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Note: The Review Administrator application must be updated to allow the 
granting of these privileges to specific users or groups.

Super Users are able to save templates at the object storage level for 
global, project and study levels as only one per level. The templates are 
saved at the object storage location for public only.

Once a graphic patient profile is saved the template information is saved 
with the profile. Therefore, a saved profile uses the original template 
information that existed at the time it was created to avoid conflicts with 
updated or newly created templates.
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Graphic patient profiles are very complex due to the different types of 
data can best be represented by different types of graphs. The individual 
graphs are aligned along a similar time axis, however, each graph may 
consist of a different plot type based upon the type of data “event” that is 
depicted. Each graph may be based on data from multiple tables in the 
underlying database. 

Define study start date

The Study Start check box is defaulted ON for “Calculate Relative days 
based on Study Start Item (and possibly Date Criteria)?”. When checked, 
you must define an item that contains a unique single value for each 
patient’s study start date as Day 1 or Day 0. For example, a date item 
located on a single record per patient such as the Demography data 
panel. If a multiple record data panel is chosen, then the selected date 
item requires the Date Criteria applied to filter down to a unique patient 
study start date such as visit label is baseline, visit number is 1, etc.

When the Study Start box is unchecked, then all other items in the Study 
Start box are disabled and buttons previously labeled as “Date” display 
as “Day”. Enter the precalculated Day item created in your database (not 
Review). You are required to select at least one item per defined category 
that contains numeric values denoting relative days from study start (i.e., 
for a single event category such as “Laboratory Test” you would enter an 
item containing values of the relative day the lab test was performed). 
The relative day item would be another item located in the same panel. 
For duration events such as “Adverse Events” you would enter the item 
containing the values of the relative day each Adverse Event started and 
a second item containing the relative day each Adverse Event ended. 
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1. Select the Template level for global, project or study.

2. To enter the Study Start Date Item, select a panel and date item. Click 
Date Item.

3. Enter the date item as Day 0 or Day 1.

4. If you need to further specify the date, click Date Criteria. The Date 
Criteria is required if you had selected a multiple record data panel for 
your selection of date. 
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The Study Start Date Criteria window opens for you to specify details 
such as a visit label.

5. Click Save Filter and close the window.

The Date Criteria button status changes to .
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Define header items

Adding a header is optional. The PatientID defaults if left blank.

1. Click Header from the Category list.

2. Go to the Panels list and Items list to select and add header items to 
display in the graphic patient profile. 

3. Click Header Items button to add items. Highlight and click scissors 
in the tool bar to remove items.
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Category types

Different types of data can be best represented by different types of 
graphs. Data with start and stop dates (i.e., duration events) are graphed 
as horizontal bar charts over time. Data collected on a given date(s) as 
time point events (i.e., labs, vitals) are graphed as scatter plot graphs. 
Data with no date associated are displayed as text.

Different information about data panels/tables and items/fields are 
needed in order to create each type of graph (bar, line or scatter). This 
database information may come from multiple database panels/tables 
and are organized into a data category.   The data category “bucket” 
contains the type of data (or event) to be graphed; the type of graphs to 
be plotted for this type of data (or event); and additional necessary 
information on panels/tables and items/fields to get the correct data 
from the database to generate the desired graphs (i.e., lab normals). 

• A data category contains specifications about the 
data for a specific type of data “event”. 

• Allows for these specifications to be based on multiple database 
tables restricting that only one-to-one or one-to-many table 
relationships be allowed.

• Associates the type of data event to be graphed with the 
appropriate types of plots.

The following table lists the data categories.

Category Type Definition Plot Type(s)

Duration Data collection event that has a start and 
stop time point.

Horizontal Bar

Time Plot Data collection event that occurred at a 
specific point in time.

Data Value 
Line Plot 

Lab Lab test data collection event that can be 
compared to normal range values if they are 
defined in the data.

Scatter Plot 
Line Plot 
Trend Plot 
Data Value

Dosage Dosage data collection event that has a 
standardized dose value and start and stop 
time points.

Vertical Bar

Non-Time 
Aligned or 
Text

Data not associated with a specific point in 
time (i.e., gender, sex)

Free form text
196 Chapter 5:  Graphic Patient Profiles



Level 1 bleed
Define Category Information

The SuperUser specifies the category information from a pre-defined 
categories list and can further specify subcategories for laboratory tests, 
text, Vitals Signs and Physical Exam.

1. Select a category to display the corresponding template for entering 
category information.

2. If the category collects time data, click the check box to activate the 
time items to display along with the date items.

3. Select the Panel(s) and items to define the category information.

4. Repeat the steps to add another category. An asterisk displays next to 
the category in the category list noting it has been defined.
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Time Axis scale

If you include time data items in any category definition by clicking the 
‘Include time items’ checkbox, then Start and Stop Time Items will 
display for entry. In addition, the Time Axis scale in the graphic patient 
profile will include hours. The default displays the date items and 
‘Include time items’ as unchecked for displaying time items.

The following conditions are true with time items present:

• Existing templates and objects without the option for time are still 
processed from a prior release.

• Time is stored as days.hours in saved graphic patient profile objects so 
prior versions of the Review client will retrieve correctly in days.

• New templates will include the time option but you cannot go back 
and edit an existing template from a prior release.

• Time items of type character, numeric or time will process.

• Hours are included in the Time Axis scale if the time item was 
included in the opened template and graphic patient profile object.

• Hours are not included in the Time Axis scale if no time items were 
included in the opened template and graphic patient profile object.

• If a new graphic patient profile object is opened with hours as the scale 
with an older Review client, then the scale will present in days and the 
data will display accurately.

• Negative days and hours are handled.
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Duration Category Type

Duration type categories include Adverse Events, Concomitant 
Medications, Previous Medications and Treatment require the following 
item information to be entered. The Add Item is the field to be graphed. 
Ongoing Item and BY Variables are optional.
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Dosage Category Type

The dosage category is a special case of duration requiring a numeric 
field representing dosage values for the item to graph. The dosage 
category supports multiple dosing regimens when you add 
subcategories.
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Text Category Type

The text category is a text type which initially contains no subcategories. 
The SuperUser defines subcategories and assigns specific database 
items/fields from the panels/tables to either categorize itself or a 
subcategory. The items are displayed as non-time aligned data.

To add a Text Category:

1. Select Text in the Category list and click Add under Subcategory.

2. The Subcategory Name window opens for you to enter the 
subcategory.

3. Click OK.

4. Select the Panel(s) and item(s).

5. Click the Text Items button to add.
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Text subcategory is added.
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Laboratory Category Type

The laboratory category is special due to the fact that lab data can be 
structured in either a horizontal (a separate field for each lab test) or 
vertical (one field for the lab test name and a second field for the lab result 
value for all labs) format. In addition, vertical lab data has each lab test 
associated with a lab normal range which may or may not be in another 
table.

Horizontal panel structure requires:

• Date Item - the field containing the date of the event.

• Item(s) - the fields which the user may select for graphing.
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Vertical panel structure requires:

• Date Item - the field containing the date of the event.

• Lab Test Name Item - the field containing the lab test name.

• Lab Result Name Item - the field containing the lab test result or 
value.

• Lab Test(s) - the list of lab tests which the user may select for 
graphing. The overall list of lab test names is derived from the lab 
test name field.

To select multiple contiguous values, click on a value and drag over 
the other values. To select multiple non-contiguous values, click on 
a value and hold down the Ctrl key when clicking the other values.

• Unit Item - are the units associated with the lab tests.

• Normal Ranges - are the normal ranges for the lab tests. Click this 
box to enter the Normal High Item and Normal Low Item.

Note:This assumes that a join criteria has been previously defined between the 
lab and normal range panels.

• Normal High Item - the field containing the lab normal high value.

• Normal Low Item - the field containing the lab normal low value.
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Time Point Type category

Time point type categories also includes Vitals and Efficacy panels and 
may be either vertical or horizontal. Subcategories may be applied if 
needed.

Horizontal panel structure requires:

• Date Item - the field containing the date of the event.

• Item(s) - the fields which the user may select for graphing.
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Vertical panel structure requires:

• Date Item - the field containing the date of the event.

• Measurement Name Item - the field containing the measurement 
name.

• Measurement Value Item - the field containing the measurement 
value.

• Measurements - the list of measurements which the user may select 
for graphing. The overall list of measurement names is derived 
from the measurement name field.

Note:  In this example we used the Vital Signs & Physical Exam category for a 
Mycology panel because the category format best fitted our data model. Later 
when you create the graphic patient profile you can modify the category name for 
display purposes.
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Save template
When you have added all categories and subcategories to the template, 
click Save. A message window displays the template has been saved.

The template is saved at the level selected. The available template levels 
are highlighted in the Patient Profiles Browser window in the template 
level list. If no template exists for a level then the template selection is 
shaded as disabled.

Edit graphic template

The Edit Graphic Template button becomes available if you need to edit 
the existing template.
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Define Graphic Profile

Select defined template

Once a template is saved you can select from the available template 
levels to define your graphic patient profile. Shaded template levels 
haven’t been defined and saved yet.

Change Time Axis

You can define the Time Axis before or after you select your categories 
and items. When you enter the Time Axis once for any category, it will 
default across all the selected categories as the common time axis. 

1. You can change the Time Axis defaults for the graph plots by selecting 
from the dropdown Scale list and entering the Start and Stop range.

Simply enter the Start and Stop value for the selected time scale.
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If time items are included in any of the defined categories then the Time 
Axis will include hours.

Change Limit value

The Limit value denotes how much of a duration event to show before 
and after the first and last time point event. The limit feature “limits” 
how far out the time axis will go past “time point events” such as a lab 
test, or vitals or efficacy measurements. For example, if you have a long 
running Concomitant Medication with a stop date past your defined stop 
range, you can limit how much you want to see.

The default is 240 for hours, 90 for days, 12 for weeks and 1 for years. You 
may change it to any positive number to show more of the duration 
events that occurred before and after the first and last time point event. 
Choosing a limit of zero will show the shortest time axis possible (only 
from the first to last time event). Entering a negative number, (-1 for 
example) will show the entire time axis from the beginning to the end of 
the first and last duration.

Display Time items

If you had defined a template category to display time items you may set 
the scale to Hours. The Start and Stop Hours scale displays with a 
dropdown list to select within a 23 hour range before changing to the 
next day.

Note:  When selecting the Hours Scale it is best to applied to a minimal day 
range duration of not more than 4 days for meaningful results.
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Select categories for display

After you select an available template from the template levels you are 
able to select those categories to be included in the graphic patient 
profile. The header is defaulted as the first category and is required.

2. Highlight the categories to be included in the graphic profile and click 
Add Categories. Use the Remove Categories button to remove. You 
can highlight and move single or multiple categories with the SHIFT 
or CTRL key for multiple selections. 

3. Reorder the Categories Included with the up and down arrows.

Select Items for display
4. Select each included category and view the list of items and by items 

(where applicable) for the graph plots.
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You must go through the entire list of Categories Included and select 
each category and the items(s) you want included in the graphic 
profile. Otherwise, a message displays alerting you of an included 
category without items or BY items included. 

5. Highlight the item(s) and click Add Items button to select from 
available items to be included in the graphic profile.

6. Reorder the Items Included with the up and down arrows. 
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7. Enter the BY Item (if applicable) for the selected category.

8. You can change the title of any included category (except for the 
header which will always display the PatientID).
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9. You can add or change the default Plot Types. The available plot types 
are dependent on the category type defined.

Normal range multiplier

A normal range ‘multiplier’ option for labs allows you to specify if you 
only want to ‘flag’ or mark as low or high, those labs that are outside N 
times the normal range values. It is implemented as normal high times N 
versus normal low divided by N.

10. You can only select 1, 2 or 3 for the normal range multipliers with the 
default set to 1.

Note: The Multiplier feature applies to Vertical Labs only where Lab Normals 
may be entered.
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For comparison, first view out of range labs for Normal Range multiplier 
set to 1 and then change the normal range multiplier to 2. Select Plot Type 
of “Scatter” for labs and notice some points that were out of range 
previously changed to in-range from the up/down triangle to box plot 
point. If you selected Plot Type of “Line” you will notice the normal 
range “band” within the line graph has expanded for the normal range.

Normal Range set to 1. The scatter plot shows triangles indicating the 
values outside the normal range. Also, the Line Plot type for glucose and 
triglycerides shows values above the colored band for normal range.
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Normal Range set to 2. The scatter plot shows boxes indicating the values 
inside the normal range multiplier of 2. Also, the Line Plot type for 
glucose now shows values within the colored band for normal range.
216 Chapter 5:  Graphic Patient Profiles



Level 1 bleed
Create Graphic Patient Profile

After you have defined all included categories and items included: 

11.Select a patient and click Create Profile.

The Graphic Patient Profile displays all labels on the left and legends on 
the right side of the graph plots. 

Red arrows display in the right margin to identify additional graph 
display if you scroll up or down with the arrow keys. 
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12.Once you have finalized the design of your Graphic Patient Profile, 
you can save your object specifications. (See Chapter 4: Patient Profiles 
Browser: Object Storage: saving your work.)

 Missing data

Missing data is displayed for line plots and scatter plots as blank. 
Duration plots as an empty box for missing BY variable value. ‘B’ if it has 
a start date but no end date. ‘E’ if it has a stop date but no start date and 
no bar if it has no start and stop date.

Basic graphic user interface

Once the graphic patient profile displays, the following functions are 
available to assist you in further examining each graphic data display. 

• Use the keyboard up and down arrows to scroll through the multiple 
graphic plots for the patient.

• Use the keyboard left and right arrows to scroll x-axis on the graph 
across the time scale, or click-and-drag the scroll bar.

• Use the Next Case and Prev Case button on the Patient Profiles 
Browser window to move between patient profiles.
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• Select a data point on a graph display and left mouse click to select 
and invoke drill down.

• To select multiple points, click and hold the left mouse button, drag 
the mouse to create a “box” and let go of the left mouse button. This 
will invoke a drilldown for all the points in the box.

• Click the left mouse button to deselect all previously selected points.
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• Zoom in and zoom out with the ‘+’ and ‘-’ icons on the left of side of 
the scroll bar. 

• On the Control bar (left side of categories); use the left mouse to 
minimize and maximize the category.

• When you create a workbook for multiple case, in the Toolbar use the 
icons with the appearance of little pages with + and - signs to move 
between patients. The first button always takes you to the first patient. 
The second button moves you one patient back. The third button 
moves you one patient forward. The last button always takes you to 
the last patient.

• You can save the graph image to JPG or PDF from the Toolbar. Simply 
click the file icon to open the save window. 

• The last buttons decrease or increase row size by compressing or 
expanding the rows.
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Filter Output

Patient Profile Filter Output

After you define the specifications of your Graphic Patient Profile, you 
can use the Filter Output as a data exploration tool by filtering data 
inclusion, then comparing filtered and unfiltered results. 

Filter Output works in the Patient Profiles (both workbook and graphic) 
where only included panels (or panels behind included graphic 
categories) are viewable and selectable for filtering in the Filter Output 
window. So if you did not include any panels/categories in your graphic 
profile, even if they are defined in your template, you would see nothing 
in the Filter Output window.

The reason behind this is that in a patient profile, each panel is displayed 
individually and is not joined with any other panel. Therefore, filtering 
criteria from any other panel would not apply to a panel used in profiles.

The only exception to this is in Graphic profiles when a category is 
defined by more than one panel (i.e. dosage and treatment). In this case, 
both these panels will appear in the Filter Output window and filtering 
criteria from one panel would affect the other panel.

1. Click the Output Filter button in the Patient Profiles Browser window. 
The Patient Profile Output Filter window opens. 

2. The All Included Panels option allows you to define an output filter 
based on those items present in all the included panels. This option 
will apply the output filter across all panels in the Graphic Profile and 
filter all graphic displays. 
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3. The Individual Panels option allows you to define an output filter 
based on specific panels and items. This option will apply the output 
filter across to specific graph displays. 

4. Click Save Filter. The Filter Output button in the Patient Profile 
Output Filter window toggles to Filter is ON. The output filter is 
applied to the graphic profile when you click Create Profile.

For each individual panel selected and a result filter entered, an 
asterisk displays next to the panel name flagging the panel has an 
active output filter.
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Graph settings

Select settings

On the Toolbar, click the first button to bring up the settings options.
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Appearance options

Each of the sliders, when moved with the mouse, will change the 
contents of the white box to help the you visualize the setting. For 
example, when you click and move the ’External’ slider under ’Fonts’.

The size of the text “abc” will be the actual size of the text on the graph.   
The same occurs for the 'Misc.' size settings, except the white box will 
contain a line of the appropriate width.

The 'Display Crosshairs' checkbox toggles a crosshair following the 
mouse. This is good for visualizing alignments. 'Use gradients', when 
checked, will display gradient backgrounds to almost all rectangles 
drawn on the display. 'Draw labels on normal region' toggles the little 
markers that display the value of the normal range border. 'Draw 
numeric labels on y axis' label each row.
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Printing and PDF output settings

There are many options that allow you to customize how the Graphical 
Patient Profile prints. The printing options are found on the ’Print/PDFs’ 
tab in the settings window.

The most important of these options is the first, ’Fit to page when 
printing’. This option has precedence over all other printing options. If it 
is selected, then a page will be printed on one page regardless of the view 
range or the height per row. The default for “fitting” is true. Ideally, it is 
easiest to visualize the data when it is contained on one page. When this 
is not possible, the other paging options come in to play. The paging 
options are used to change the order in which the pages print. Basically it 
allows you to choose between moving horizontal or vertical first. The 
picture on the dialog is pretty self explanatory, across many patients. 

You can chose to print the current patient only, or all pages. A print job of 
multiple patients, each of which is multiple pages, can get extremely 
large very quickly. These options like this have been added to help the 
you have control.

Finally, if color printers are unavailable, there is the print hash marks 
option. This makes it easy for the user to distinguish between the 
different by-variables and categories without the use of color.
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Color settings

There are 15 icons on top, each of which controls a certain aspect of the 
screen. Each button contains a little image, which highlights the part it 
refers to. So for example, the background button (top left) has a 
highlighted blue background, while the rest of the graph remains 
unchanged. 

The color of the background is not blue however. The actual color of the 
background is white, which is shown by the little circle in the bottom 
right corner. This method of conveying the color clearly distinguishes 
each part of the graph while at the same time gives you a sense of color. 
So to change a color, simply click on the button.

The Category Colors at the bottom of the tab is used to modify the order 
of the category colors. These colors work from left to right (so light blue 
is the color of the first category). To change the color, simply use the left 
mouse button over the appropriate button.
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Headers and footers

You can control the information that is printed on the top and bottom of 
the graphic display. There are seven entries which allow you to insert 
'special strings'. For example, if you type “p$P” into one of the edit boxes, 
it will appear as p1 on a printout (where 1 is the number of the page. This 
allows you to control both static and dynamic strings.

Category settings

Each category has its own category settings dialog box. In the Graphic 
Patient Profile window use the right mouse button on the control bar 
next to the category title.
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 Each graph’s dialog has unique characteristics. Every category contains a 
category color box, on the bottom left of the dialog box. 

 Line, trend, and block graphs also contain the ’lines per row option’ 
which is used to modify how many graph lines each display will use.   
The list box under ’Step One’ contains a list of the BY variables for the 
current panel. When the user clicks on one, the variables on the right side 
will be populated.

You can change the color of the particular BY variable by clicking on the 
color with the left mouse button. You also have the ability to modify the 
maximum and minimum. There are no limits on the minimum and 
maximum except that the min must be less than the max. The range on 
’lines per row’ is 1 to 10.
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Graphic Patient Profile display

Print Preview
To display a print preview of a patient profile in the Patient Profile out-
put window:

1. Click on the title bar of the Patient Profile window to make it the active 
window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen. Print 
Preview for a graphic patient profile displays a detailed cover page 
before the graphic profile pages. The following information displays 
along with the Filter Output definition if applicable. 

3. Click either Print or Close.

The Print Preview function is applicable to all browsers with output 
results.

Printing a patient profile

To print the patient profile of the selected patient:

1. Click on the title bar of the Patient Profile window to make it the active 
window. 

2. Click , or from the File menu, select Print.

Review displays the standard Print dialog box.

3. Click OK.

Note: When you select Print Preview or Print for the selected Patient Profile, a 
signature line with the date is printed at the bottom of the worksheet.
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Exporting a patient profile

To export your table in Excel 4, 5 and 7, tab delimited files, HTML format 
or PDF files:

1. From the File menu, select Export. 

Review displays the Export dialog box. 

2. Enter the storage location.

3. Enter the storage type.

4. Click OK. 

Your patient profile is exported to the currently selected disk directory. 
(See Chapter 12: Common Topics: Export Browser Display Spreadsheets; Copy 
and Paste Browser Results; Copying to Clipboard.)
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Object Storage: saving your work

 Object storage location

You can store patient selection criteria at four user access levels: Private, 
WorkGroup, UserGroup, or Public.

•  Private storage is at the local PC level. The private objects are saved 
on the user’s home drive in a directory (folder) called “irpat”. 
Review handles all creation, access and deletion of the private 
objects in this folder. Therefore, the user should not be concerned 
with the contents of the irprivat folder.

•  WorkGroup storage is PC based and stored at a shared network 
drive, to which a select group of personnel would have access. 

Note: The WorkGroup storage location was supported in earlier Review 
releases. UserGroup storage location is extensively used for later releases.

• UserGroup storage is a database object storage for defined 
UserGroups in the configuration tables.

Object storage in UserGroup level allows you to specify sharing 
with multiple UserGroups. This works when you click UserGroup 
and you are a member in a UserGroup, then the UserGroup listbox 
is enabled. If you want to share the object with multiple 
UserGroups, simply use the CTRL or SHIFT mouse click for 
multiple selections.

•  Public storage is also a database object storage for all users of 
Review. There is more user access when designated as Public 
versus limited access when setup for WorkGroup or UserGroup 
storage. 

Saving on database object storage sites, requires the author to have 
“Publishing Authorization” defined in the configuration tables. 
(See Chapter 12: Common Topics: Shared Object Storage- Locations)
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When you select the UserGroup object storage location, the ‘Share 
with usergroups’ ListBox is made available for selection.

Object level

You can store your output specification at three levels: Study, Project, or 
Global. The Object Level box is only enabled and highlighted when you 
select an Object Storage Location designated as ‘db’ for database. 
Therefore, when you select either UserGroup or Public for database 
object storage location, you can assign an object level to restrict access to 
a specific study level or share access between multiple studies at Project 
or Global levels. 
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Saving Patient Profile specifications

To save the patient profile specification you have defined for later use:

1. Make certain that the Patient Profiles Browser window is the active 
window by clicking on its title bar.

2. Click , or from the File menu select Save. 

3. Review displays the Save Patient Profiles Browser dialog box where 
you can specify the storage location. 

4. Select object level type. The default is Study.

5. Click Store Patient Selection Criteria if you choose to save the current 
patient selection criteria with the output specification. When a user 
selects the stored object specification they can modify the selection 
criteria and still run the output. If the particular patient selection 
criteria is specific and required for the output, click Patient Selection 
Criteria required. In this instance, the patient selection criteria cannot 
be modified when this stored object specification is selected. If none 
selected, then no patient selection criteria is saved with the output 
specification. 

6. Enter a FileName for future reference to be displayed in the list box for 
Existing Files.   The Filename is for internal use and not displayed in 
the Object Explorer window.

7. Enter the folder(s) information in the Category box. Each folder 
(major, minor and subfolder) is separated by a period where folder 
titles can consist of more than one word separated by a space. For 
example, the major folder for ‘Safety’ has two minor folders 
‘Safety.AEs’ and ‘Safety.Labs’. Folder names are case-sensitive and 
after the folder(s) are initially created, they are selected from the drop 
down listbox.
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8. Next enter the appropriate description which is displayed in the 
Object Explorer window.

9. You can include summary information for future reference to be 
viewed by yourself or others later. 

10.Click Save.

Review stores the output specification to the designated PC, WorkGroup, 
UserGroup, or Public storage location. 

Object Explorer window

Once you have saved your patient profile specification and assign folder 
information, your stored object will display in the Object Explorer 
Window under Output Specifications.

Review displays a list of folders for previously saved output 
specifications at the selected storage location. Simply select one of the 
storage locations as Private, UserGroup or Public to display it’s specific 
folders and contents.

Note: Graphic Patient Profiles can not be scheduled or the output saved.
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Icons are displayed along with the stored object to identify the source as 
report, graph, registered SAS program, etc. When a patient selection 
criteria is saved with the stored object; the filter icon displays with the 
specific browser icon. 

Saved objects and their associated icons can be sorted to display in the 
their folders by icon type or description. Simply click sort by Type or by 
Description.

Object Explorer quick execute

The Object Explorer window aids users to quickly locate and launch 
previously saved objects stored within organized folders. This shortcut 
allows users to bypass opening the individual browsers to launch saved 
objects.

If you want to retrieve a saved output specification:

1. Double click to open a folder.

2. Click on the output specification and click Execute.

Your stored output specification will be launched.

If you want to apply a saved patient selection criteria to your output 
specification:

1. Double click to open a folder.

2. Double click to paste the selected patient selection criteria into the 
Patient Selection Criteria Window. Then follow the above steps to 
retrieve and execute a stored output specification. Or create your own 
selection criteria for a stored output specification.
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Retrieving a saved Patient Profiles specifications

Another way to retrieve a previously saved Patient Profiles specifications 
from the Patient Profiles Browser: 

1. Make the Patient Profiles Browser window as the active window.

2. Click Open, or from the File menu. The Open Patient Profiles Browser 
window displays.

3. Select the object storage location. Review displays a list of stored 
Patient Profiles Specifications.

4. Select a Patient Profiles description and click the Open button or 
double click on the description.

Note: You must use the Open Patient Profiles Browser window to access the 
object storage location for ‘WorkGroup’.   

a. If you want to browse and/or select a file from the WorkGroup, 
UserGroup or Public storage sites, click on the site and the files 
available to you are displayed in the following window. 

b. Click Change WorkGroup Location, and you are enabled to 
browse various Patient Profiles object storage sites.

5. You can browse through the Patient Profiles specification by 
reviewing the summary text. Click on the Patient Profiles 
specification, and click Open. Review pastes the Patient Profiles 
layout specifications into the layout spreadsheet, clearing the current 
spreadsheet contents.

6. By default, Review displays only saved Patient Profiles specifications 
created while reviewing the current Study Protocol(s). You may also 
import Patient Profiles specification created for other Study 
Protocol(s). Check “Display all studies?” and open any available 
Patient Profiles Browser specification. Review will validate the data 
structure to verify that the foreign Patient Profiles specification is 
compatible with the current study protocol(s).
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Object properties

You can view information about an object when you select “Properties”.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Properties. A dialog window displays the object properties 
for the output object. It works for ‘Private’, ‘Workgroup’, ‘UserGroup’ 
or ‘Public’ objects equally. 
Object Storage: saving your work 237



Le
ve

l 1
 b

le
ed
Quick remove

You can quickly delete a saved Patient Profiles Browser object under the 
Output Specifications window.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Remove. You are prompted “Are you sure you want to 
delete the object?”.

The Remove function is a quick way to delete stored objects provided the 
user is the creator or a SuperUser. It works for ‘Private’, ‘Workgroup’, 
‘UserGroup’ or ‘Public’ objects equally. 

Removing a saved Patient Profiles specification

Another way to remove one of the saved Patient Profiles specifications if 
you decide it should be deleted:

1. Open the Patient Profiles Browser to make it the active window. 

2. From the File menu, click Remove.

3. Review displays the Remove Patient Profiles Browser window.

4. Click on the object storage location.

5. Select the stored Patient Profiles description you want to remove.

6. Click Remove.

Review deletes it from your local PC, WorkGroup, UserGroup or Public 
storage sites as you designate and have security clearance to do so.
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Printing the Patient Profiles specifications

To print the currently active Patient Profiles specification, make certain 
that the Patient Profiles Browser window is active by clicking on.

1. Click Print, or from the File menu, select Print. Review displays the 
standard print dialog box. 

2. Click OK. Repeat column headers are printed on each page in the 
printout.

3. To change the printer, select Print Setup from the File menu.

Closing Patient Profiles Browser

Closing the Patient Profiles Browser

If you are finished with all Patient Profiles, and do not want to define any 
other Patient Profiles: double-click on the close box of the Patient Profiles 
Browser window. 

Review closes all Patient Profiles windows currently opened.
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Patient Selection Criteria

Selection set
After building the patient selection criteria, you can explore customized 
groupings of items for each of the patients who meet the criteria by using 

the Report Browser. To open the Report Browser, click , or from the 
Browse menu, select Reports. Opening the Report Browser

Review displays a new window where you can specify the type, 
contents, and presentation of your report(s):
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Selecting a report type

The Report Browser facilitates customized groupings of item values for 
patients currently included in the patient selection criteria. Review 
provides point and click report creation, without panel join limitations. 
Multiple study reporting is supported in each of the report types.

You select a Type of report from the Report Type ListBox by choosing one 
of the following: 

• Detail Data Listing generate one report line for each patient 
observation. 

• Summary Listing generate one report line containing summary 
information such as summary category, counts, mean, and so on.

• Formatted Detail Data Listing and Formatted Summary Listing 
provide the same basic functions as Detail Data Listing and Summary 
Listing. In addition, extensive formatting features are available for you 
to make changes over default settings which are initialized when you 
select a formatted listing. Refer to the section in this chapter on 
Formatting Reports when you select Formatted Detail Data Listing or 
Formatted Summary Listing.

• Patient Visit Report contains patient results organized by patientid 
and visit where multiple visit panels are easily joined and displayed 
per row.
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The setting changes can be applied to:
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Steps for report building

1. Select a Report type.

2. Select a Panel.

3. Select an Item(s).

4. Select a Function.

5. Click ADD Item or double-click on the item to add. (Repeat steps 1-4 
as needed to add items.)

6. Optionally, create an Output Filter.

7. For unformatted reports - Edit the column order, column headings, 
report heading, sort order, row results or range checks.

8. For formatted reports - Edit the column order, column headings and 
row results or range checks. Apply detailed formats with menu.

9. Click Create Report.
248 Chapter 6:  Reporting



Level 1 bleed
Defining Report Specifications

Selecting a panel, item, and function

You define the contents of a report using the same method that you used 
to build the patient selection criteria: 

1. Select a panel.

2. Select each item of interest. 

3. For each item, select an appropriate function or use the default 
function type for the type of item selected.
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Adding items
Select individual items and click ADD Item to add the selected item to 
the report content spreadsheet. Or double click on the individual items to 
add each item to the report content spreadsheet.

A short cut for adding non-contiguous items within the same panel:

1. Select the items you want while holding the Ctrl key.

2. Click ADD Item and Review adds the items to the report content 
spreadsheet in the order they appear in the panel.

OR

3. Click Add All Items to add all items in the selected panel to the 
current report. You can select and combine items from all panels.

Default and new events

Review provides predefined functions, and you can select from any 
function value listed. You can utilize the ‘_New Event_’ function that 
facilitates the creation of new user-defined functions. (See Chapter 12: 
Common Topics: _New Events) 

The predefined function ‘Chg from previous’, calculates the change from 
the last measure. All other default functions are pre-configured in the 
Review Administrative Configuration Tables. (See Review Configuration 
Guide)

New item, new ranges, and new events are fully supported in the Report 
Browser. (See Chapter 12: Common Topics: Derived Items and New Range 
Variables)

Access to SAS datasets

SAS datasets are listed with the panels generated from Oracle tables. 
Items from SAS datasets can be used like other items for building reports.

Note: The current restriction is you cannot mix items from SAS datasets and 
Oracle table generated panels within the same report.
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Column autosizing

Optional column autosizing is available, click ‘AutoSize Columns?’. 
When the report is created the columns will default to the width of the 
column heading. The default is AutoSize Columns on.

Edit report sort order

To make changes to the sort order:

1. Click on the default sort order values.

2. Delete, replace, edit or add sort order values.
The sort order 1 will be the item in which the primary sort will take   
place, sub-sorted by sort order 2, and so on. 

3. Optional descending sort is specified by a trailing ‘D’ after the sort 
order number.

Note: Formatted reports use a different definition for how items are sorted. See 
sort order for Formatted Reports.

Edit report column order

To move a column:

1. Click on the column you want to move, or click and drag to highlight 
over the columns you want to move.

2. Use the directional arrow buttons to place the highlighted column in 
the columnar position(s) you would like. 
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Changing the report specifications

To change the report specification that you have defined:

1. Click anywhere in the report layout (heading, sort order, column 
headings, row results, delete or add panel item function values, or 
define (or re-define) join logic. 

For example, in a column that you want to delete (and perhaps replace 
later).

a. Click  or from the Edit menu, select Cut. This deletes the 
column from the report specification. 

b. To place the column in a new order location, click on a column and 
from the Edit menu, select Insert. The cut column is inserted to the 
left of the highlighted column. Or, highlight the column(‘s), and 
use the directional arrows to reposition the columns highlighted. 

2.  To clear the entire report specification, click .

Edit column heading

You can edit the column headings for Col. Head 1 and Col. Head 2. To 
edit a column heading:

1. Click on the text. 

2. Edit the text.

3. Press Enter.

Defining a report title

Edit the report heading to easily identify the report window and 
printouts. You can enter a title for your report that will be displayed as 
the caption in the report window, as well as, in any printouts. By default, 
the Report Browser assigns the report type as the heading of the report. 
Enter the title text in the ‘Heading’ field.
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Create report

When all report specifications have been entered click Create Report. The 
report is displayed in a Report Browser window containing a 
spreadsheet of your report. 

Find menu command
You can perform a search for a key word in the Report Browser. Non-for-
matted reports use the dialog box below.

1. Click the Edit menu, select Find.

2. Enter the search criteria and Review will locate the first occurrence. If 
you select search by column, highlight the column in the spreadsheet.

Formatted Reports do not require the column to be highlighted. Simply 
enter the search criteria in the dialog box.
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Detail Data Listing features

Defining row results

By default, the first sorted item’s ‘Row results’ is set to the ‘Print change’, 
which means that the row will only print on a change in that item value. 
The row results options vary with each item type. ‘Row results’ for a non-
numeric item type is limited to 'Print change'.

A numeric type provides clinically pertinent options, such as mean or 
sum. Numeric row results generate report summations (for example, 
Selecting Sum or Mean), or break point summations that the report will 
generate in summation or at break points for example, change in PID, 
Sum at Change and Mean at Change. The Row Results drop downlist 
below is for non-formatted report types.

Note: Mathematical row results options are different between non-formatted 
and formatted report types.
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Formatted reports have more mathematical options. In addition, 
formatted reports support Sum at Change, Mean at Change, Mean at 
Change and Mean, and Sum at Change and Sum. 

Using mathematical row results

You must select the item to ‘break on' when utilizing the mathematical 
row results. This required selection is enforced when you have selected a 
mathematical row result ‘Sum at change’ or ‘Mean at change’ or ‘Mean at 
Change and Mean’. The possible break items are listed in the ‘Reset 
Subtotal with Change’ drop-down list.

The mathematical row results options are available in the Detail Data 
Listing and Summary Listing.
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The mathematical break point is applied to the Pat No. with ’Sum at 
change’ row result selected for Efficacy Evaluation items.
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Highlighting data check ranges

When you define a report, for example, which includes numeric 
parameters such as laboratory data, vital signs or scores, you can enter 
warning and panic ranges that will be used to color highlight the data in 
the report display. Variable values outside the ranges you define will 
show up in yellow and red. If the report specifications are saved, these 
data check ranges are also stored within the report. 

Simply enter your data check ranges within the spreadsheet cells labeled 
“Warn-Low”, “Warn-High”, “Panic-Low” and “Panic-High”.
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Suppress duplicate rows

If you want to display only unique rows (unique based on all items being 
displayed), click on the checkbox for ‘Suppress duplicate rows?’. When 
you turn this feature on, it includes “DISTINCT” in the select statement 
generated which has the effect of only displaying unique rows.
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The examples show the difference between this report when the suppress 
duplicate rows is turned off versus turned on. 
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Include? prompt

The ’Include? Prompt’ allows you to facilitate a ’generalized’ version of a 
report where the data items are collected in English or Metric units, and 
recorded in the database in separate fields corresponding to the 
collection unit. For example, create a demographic listing with height 
and weight fields included for height-metric, height-english, etc. If this is 
the case, you can create a ’general’ report, using the include prompt as 
follows: 

When the report is created you will see a spreadsheet with the following:

Include? Yes/No 

Metric Yes/No

English Yes/No

If you toggle ‘YES’ for Metric and ‘NO’ for English and click Create 
report, you will see a 'Metric' version of the report which includes only 
the set columns for Metric as the 'Include Prompt'. 
262 Chapter 6:  Reporting



Level 1 bleed
Summary Listing features

The Summary Listing have different Group functions available 
dependent upon the item selected:
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When building a Summary Listing it is typical to first select an item with 
a group function of ‘none’ and then follow it by the item with a group 
function applied. This method displays the item first as a row label 
followed by the items with group functions applied. 

The item ‘AE Coded’ is entered first with a group function of ‘none’ 
followed by the group functions ‘count’ and ‘count subjects’.
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Count distinct

The group function for ‘count distinct’ is the same as the count subjects, 
except the value being counted are the unique values of the item 
specified. For example, if you selected Adverse Event text and specified 
‘count distinct’, you would only display the number of unique adverse 
event text values. The select item phrase generated: count (distinct 
<item).
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Count item value

The group function for ‘count item value’ counts the number of entries of 
a particular item, which has a particular value. This feature is especially 
useful for reports counting patients having different categories. It enables 
you to select items from ‘Unique Values’ as a column to count the item.

1. Select a panel.

2. Select each item with group function for ‘count item value’. Click 
ADD Item and the ‘Unique Values’ window opens.

3. Select the individual value for a column where you want to count item 
value and click Select value.

4. Repeat the same steps to continue to add columns to your report with 
ADD Item and the Display Values window. These values will be 
counted as different categories.
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The results are the patient counts for the various Reasons for 
Discontinuation from the decode file.
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5. To change an existing value, double click on the column in the Report 
Browser window and the unique values window display for that 
column. Then change your value selected.
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Snapshot output

Multiple population mode

Review has an optional multiple-population mode available in 
throughout all the output browsers. The Snapshot output function allows 
you to lock the results window and make changes to the patient selection 
criteria, output filter and/or report definition contents. Then create and 
view the different output within the report browser at the same time. The 
Snapshot function allows you to view multiple open results within the 
same output browser. (See Chapter 12: Common Topics: Snapshot output)

When the results are executed and displayed from the browser output 
window, two icons are displayed in the toolbar at the top for “Snapshot 
Output” and “Who?”.   Simply click the Snapshot button to lock the 
current results output window. The report heading changes to display 
Snapshot for the current window status. 

Click the Who button to display a message box showing the current 
patient selection executed if any.

To reverse the results window snapshot status simply click on the 
Snapshot button to display the message box.
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Join Order

Join order in multi-panel reports

By default, the Join Order of a multi-panel report is ordered by the 
sequence in which you selected panels and items. The patient records 
displayed in the report are determined by the first panel selected. 

Instead of creating multiple reports to obtain different patients in the 
output, simply change the Join Order of the report and save for your 
different output requirements. 

For example, if you create a multi-panel report with panels selected in the 
order first Demography and second Adverse Events then Final, the join 
order will default in the same sequence. When the report is created, all 
patients with demography panels will display in the report even if they 
do not have Adverse Events records. Had you selected the Adverse 
Events panel first, then only patients with Adverse Events would display. 
This report would show fewer patients than when the Demography 
panel was ordered first. This example assumes all patients have a 
Demography panel, but not all patients had Adverse Events.
272 Chapter 6:  Reporting



Level 1 bleed
 

Notice the last column for ‘FINAL Completed?’ displays as a blank row 
when the Adverse Event record doesn’t exist. The Final panel data is not 
truly missing but unable to link in the report due to the previous non-
existent record. The patients who show Adverse Events records are able 
to link and display their Final data.
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You can change the Join Order by selecting Edit menu and click Join 
Order. 
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The Join Order Definition window displays. Click on the panel you want 
to reorder and use the arrows to the left.   Click Save to apply the new 
Join Order to the report. The revised Join Order is saved along with your 
report specifications. 

This report shows the revised join order where Adverse Events is 
assigned the first order position. Any blank records for Adverse Events 
are dropped from the listing.

The last example revises the Join Order as the Final panel in the first 
order, Demography in second and Adverse Events as last. Notice how 
the previously blank data for Final panel and completed study contain 
data. In the first example, the Final panel was unable to link to the non-
existent Adverse Event panels and displayed as blank data.
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Output filter

Subset on observation and/or visit

The reviewing strategy of an Output Filter is to provide a tool that 
instantly highlights and subsets a group of patients with a particular 
observation (such as Adverse Event: Gastrointestinal) and/or visit 
measures (such as Visit Label with a particular data Item value.) The 
output filter is designed to focus in on particular observations and visits; 
it is not designed to be used for the patient selection criteria.

For example, if you want to see all the patients who had Adverse Events 
with an intensity of ‘Serious’, you need to decide whether to define the 
data subset at the patient level or observation/visit level. If you define 
the data selection with a patient selection criteria and apply it to a detail 
data listing, all the patients who have a serious adverse event in addition 
to their other adverse events are displayed. This subsetting option 
provides for a complete clinical profile of the patient when you apply a 
patient selection criteria to the patient population. However, to view only 
‘Serious’ adverse events and not display other adverse events you would 
define an Output Filter. So when selecting from multiple 
observation/visit data you need to determine which subset function to 
apply for viewing at patient level or visit level. 

The examples show a glucose data listing with a patient selection criteria 
applied for values “>= 300” on the left. The same glucose selection was 
defined instead as an output filter on the right.
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The exact same patients are selected. The difference is the patient 
selection criteria displays all the visits for selected patients, while the 
output filter selected only the visits with the elevated values as defined.

You may apply patient selection criteria and output filters to a report 
specification and both would be saved in the object specification.

Creating report output filter

Click Filter Output before you click Create Report. The Report Output 
Filter window opens.

The output filter looks and operates similar to the patient selection 
criteria window. You select the panel item and value or range value to 
create a row filtering criteria. The selection of the values or range values 
are supported by Display Stats and Display Values. 

As in the patient selection criteria, Display Stats instantly provides the 
basic descriptive statistics for the highlighted item, function, and value, 
and Display Values provides a listing of all values possible for the 
selected item, function, and value. Both Display Stats and Display 
Values present their respective listings for the whole protocol(‘s) 
population, unless you check Subset by Patient Selection Criteria. With 
Subset by Patient Selection Criteria checked, the respective information 
in these windows is limited to the patient subset created by the current 
patient selection criteria. (See Chapter 2: Selecting Patients: Display Values 
and Display Stats)
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Comparing items
Click Item Compare if you want to create a criteria expression that is 
based on the relationship of two item values. (See Chapter 2: Selecting 
Patients: Compare Items)

Adding expressions

Click ADD Expression once a row filtering criteria has been created. The 
expression is immediately entered in the Result Filter (Text) and Result 
Filter (SQL) columns.

Add as many row filter criteria as needed to limit the rows of 
observations and visits included in the report analysis. Each result filter 
expression is automatically joined by the AND operator. However, just as 
in the patient selection criteria, the operator OR is also available for non-
dependent filter expressions. ANDSelect is not available in the output 
filter. 
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When the output filter is complete, apply it to the next report creation by 
clicking Save Filter. 
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Apply report output filter

The report window’s Filter Output toggles to Filter is ON. The resulting 
report is for patients meeting the patient selection criteria and the output 
filter criteria(s).

Save the report specification for later use and results validation. All 
saved reports with an output filter ON are saved with the filter 
specification, and the filter will be active when relaunched.

To turn the Filter Output off:

1. Click Filter is ON and the CrossTab Output Filter window opens. 

2. Click New. 

 or

1. Click all of the Result Filter Rows.

2. From the Edit menu, select Cut. This deletes the rows from the output 
filter specification. Clearing the output filter turns it off.

3. Click Save Filter to save the cleared filter status before closing the 
Output Filter window.
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Define Parameter

Runtime parameter

Defining runtime parameters is another way to select Output Filters to 
subset your patients and data observations. The object specification 
(reports, graphs, crosstabs) are first saved with the defined parameters. 
When the object specifications is executed the Output Filter View Choices 
window with the defined parameters displays for selection to the user.

The same basic steps used to define an output filter are used to select the 
panel, item and operator before you click Define Parameter. Initially 
when you define the parameters you can specify the parameter type as 
free text, between two values, choose from a specified list, or choose from 
all possible values (Display Values). The defaulted parameter text can be 
edited to an end-user prompt or question. Also, you can specify with a 
checkbox if filtering is required for the parameter. Otherwise, when the 
object is executed the user can click the ‘Disable Filtering’ checkbox prior 
to creating the output to not include filtering on a particular parameter. 
This feature provides flexibility for the user to select various 
combinations of parameters to generate output containing different 
patients or data values.

Create parameter

The Define Parameter function is accessed within the Filter Output 
window in the various browsers (reports, graphs, crosstabs). You may 
combine standard output filter definitions along with defining 
parameters when you click Save Filter. The operating features of the 
Define Parameter are similar to selecting a panel and item for an output 
filter. You have access to all panels and underlying data items when 
creating a parameter.

1. Click Filter Output from the browser window.

2. Select a panel.

3. Select an item.

4. Select the operator.
282 Chapter 6:  Reporting



Level 1 bleed
5. Click Define Parameter.

The ‘Runtime Filter Definition’ window opens. You may replace the 
default text in the End User Prompt for field value(s) by typing over 
the description.

6. Select one of the Parameter Value Choices.
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When selecting which parameter value choice to apply to your data you 
must consider the data type. For example, whether the data is date, 
numeric, free text ore references a data dictionary file. The option to 
select a value between two value entries can be applied for date ranges or 
numeric laboratory and vital signs data. Coded data referencing a data 
dictionary file is best defined by allowing the user to select from any 
values (Display Values) as the entry required is the coded value. The free 
value entry can be used for free text data such as Adverse Event Text or 
Concomitant Medication Text.

7. Check if filtering is required for item? (optional)

8. Click ADD expression and close the window.

9. Repeat the steps to add another parameter.

10.Change the Boolean Operators in the Output Filter window if needed. 
Click Save Filter.

Note: You MUST save the Output Specification first in order to enter parameter 
selections and create output.
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Enter runtime parameter

When the user executes a report, graph or crosstab object with runtime 
parameter prompts define, first they see the Output Filter Value Choices 
window prompting for all parameters. The user may select multiple 
parameters with the CTRL or SHIFT key in the Display Values option. 
The ‘Disable Filter’ checkbox allows the user the flexibility to ‘turn off’ 
filtering for a particular item.

After making parameter selections, click Create to generate the output.
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Patient Visit Report

Select panel visit report

The patient visit report supports joining multiple visit data into a single 
report without the usual problems encountered with multiple joins. You 
can select data from different panels containing multiple visit data and 
the records are linked by the Visit Date. If a record contains several date 
fields you have the option to select which date for reference in your 
report specification. Initially when you select this report type the 
PatientID and Visit Date are hard coded into the report and are required.
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Define patient visit report

You define the contents of a patient visit report using the same method 
that you used to build the detail data listing: 

1. Select a panel.

2. Select each item of interest. 

3. For each item, select an appropriate function or use the default 
function type for the type of item selected.

Report options

After adding all your items to the report template you can apply 
additional report options, patient information, formats and date merge 
settings. 

4. Click Options and Patient Info. The Report Options and Patient 
Information window opens.

(The image has been split for display purposes.)

5. Report Options supports multiple observations with the default set to 
ON for ‘Display All Data Observations for each day?’. For example, 
if there are multiple Adverse Events with the same Onset Date, they’ll 
be listed on separate report rows as floating for that patient. The first 
Adverse Event row listed displays the Onset Date details, the next 
Adverse Event displays on the next row with the date field blank 
implying that it’s from the same Onset Date.

If you uncheck ‘Display All Data Observations for each day?’ it only 
displays one value on the specified date, typically the last one for that 
date based upon the time/observation item setting.
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6. Column Head Font and Data Font are available to control fonts for 
Column Headers and Report Data.
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Add Patient Info Items

You can add patient information items to display as a column under the 
PatientID. For example, demographic or medical history information.

7. Select the panel and item. 
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8. Click Add Item and Remove Item to add or remove items from the 
Patient Info Items list. Use the arrows to change the sort display.

9. Click PatID Font and Info Item Font to apply fonts for PatID and Info 
Items.

10. Click OK.

Define Date Merge Settings

When you add items to your report specification the Visit Date is 
defaulted for all selected panels. If a panel contains multiple date fields 
you have the option to specify a more appropriate date. For example, if 
Onset Date is preferred in the Adverse Events panel instead of the 
default Visit Date. A message displays requiring you to select a specific 
date item if you included panels containing multiple dates.

11.Click Date Merge Settings.

 (This image has been split for display purposes.)
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12. Click on the DateItem cell. If the panel contains multiple date items 
the Items list displays. 

13.Select the preferred date item and click Date Item to replace the 
default Visit Date. 

14.If you need to report by an observation or time item, click on the 
Obs/Time Item cell. 

15.Select the preferred item. Click Time/Observation Item to replace. 

16.Click OK.

17.Enter a report Heading.
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Create Patient Visit Report
18. Click Create Report. (The image has been split for display purposes.)

Observe the Adverse Events where the Onset Date is different from the 
Visit Date and displays on a new row. This distinguishes the Adverse 
Event data from the scheduled visit data.    
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Add vertical lab

If you have a vertical lab panel and need to access a ‘Lab Value’ item the 
‘Add Vertical’ button functions to pivot the item. You are able to display 
a list of all the lab variable names and select the item of interest. The lab 
item will display a column for the selected lab test to the report while the 
data is being pulled dynamically from the vertical lab table. Simply 
repeat the steps to add more lab parameters to the report display.

1. Select a vertical lab panel.

2. Select the ‘Lab Value’ and click ADD Vertical.

(The image has been split for display purposes.)

3. Select the Pivot Item Value,i.e., the item which contains the test name 
or description. Click Retrieve Values.
Patient Visit Report 293



Le
ve

l 1
 b

le
ed
4. Select the Pivot Item Value and click ADD Item. 

5. Repeat steps to add more lab parameters to the report.

6. After adding all your items to the report template, apply additional 
report options for patient information, formats and date merge 
settings. 

7. Enter a report Heading.

8. Click Create Report.
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Formatted reports

Select formatted listing type

When you select the report type for Formatted Detail Data Listing or 
Formatted Summary Listing the associated function buttons are 
displayed. Overall report default settings are:

• Font is Arial.

• Page Setup for landscape with one inch margins. 
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Apply Page Header and Footer

To enter descriptive information to the Header and Footer area:

1. Click on the Page Header/Footer button to open Report Page Headers 
and Footers window. The default settings for headers are:

a. Default title is the report type displayed in the center cell as 
Formatted Detail Data Listing or Formatted Summary Listing.

b. Date and Time on the right.

c. Font is BOLD 10.

d. Page Report By Item.

2. Click a particular column/row cell within the template for your item 
or text entry location. Each cell can contain up to two items.

3. Use the Edit Modes to Replace or Append changes.

4. Use the various item button selections to add Header information and 
the Add Text button to enter free text descriptions. You may click on a 
cell and use the scissors icon to delete the contents.

5. Select an item to generate a page break in your report for a specified 
item with Page Report By Item.
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Note:It is not required to have an item be defined as a page by item, and more 
than one item can be defined.

6. Click the Font button to change font, style and size. 

7. Click Display Footers. Follow the same steps to enter and make 
changes to the footer. The default settings for footers are:

a.  Patient Selection Criteria and Output Filter on the Left.

b. Page number on the right.

c. Underline above the footer.

d. Font is BOLD 10.

8. Turn the Footer Underline ON or OFF. 
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Enter a Group Header

The default setting for this function is font BOLD 10. There is a maximum 
of 4 group headers consisting of 3 rows each.

1. Click on the Group Header button to open the Report Group Header 
window.

2. Click the Font button to change font, style and size. 

3. Use the Add Item and Text button to enter items. If you do not enter a 
free text description, the item will be added alone without text or 
description. Text cannot be added alone without an item. You may 
click on a row and use the scissors icon to delete the contents.

4. Enter panel and item selection to the Group Header with the Edit 
Mode buttons to Replace or Append changes.

Note:One item must defined as the Group Break item.
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Format Column Headings

To open the Report Column Headings Formatting window click on the 
Format Column Headings button. The default settings for all column 
headings are:

• Font is BOLD 8.

• Alignment - Center.

• Borders set to Underline and Underline Group Heading is ON.

To apply Overall Column Header Formats:

1. Click the Font button to change font, style and size.

2. Change the borders.

3. Or apply a Specific Column Header Format by clicking the drop down 
list for alignment. Change from default center to auto, left, or right.

Note: Edit the column headings for Col. Head 1 and Col. Head 2 from the Report 
Browser window. See edit column heading.
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To apply Column Group Headings:

1. Highlight the items you want included in the group.

2. Click Add Group Heading.

3. Use Remove Group Heading to make changes. If a Column Group 
Heading is removed the items are added back to the list columns in 
the original order.

4. Enter a Column Group Heading.

5. Click box to Underline the Group Heading.
300 Chapter 6:  Reporting



Level 1 bleed
Format Columns

To open the Report Column Formatting window click on the Format 
Column button. The default setting alignment is automatic based on the 
data type. Break definition is set to none and font is regular 8.

• Click Overall Column Formats to apply overall formats to font, style 
and size. The overall Alignment is Auto.

Or you can apply individual Specific Column Formats.

• Click the Alignment drop down list to align the item display for auto, 
left, center, or right.

• Click the Break Definition drop down list for None, Skip line, 
Underline, Page.
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• Click the Numeric Format drop down list for any numeric item 
included as a column in the report.

The best way to use the Percent Numeric format option is to apply 
it to a calculated field that is a percentage which has not been 
multiplied by 100. For example, if the calculated field is 0.67 
percent and you apply the% format to display as 67%.

The Boolean numeric format would be used on a calculated field 
where ‘0=False’ and all other numeric values will display as ‘True’.

The numeric formatting is also available for Change from Baseline 
and %Change from Baseline items.
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• Click the Mean Numeric Format drop down list for any row result 
defined as Mean, Mean at Change or Mean at Change and Mean.
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Sort Order
The default order of data items:

1. Headers

2. Footers

3. Group Headers 

4. First 4 columns added to the report.

5. Items are defaulted in ascending order.

Note: It is advised to define all areas of the report prior to defining the sort.

• All items added to the report in the header, footer, group header or as 
columns will display as Available Defined Items.

• The sort order can be changed by clicking on the item and using the 
arrow buttons.

• Any item in the sort order can be identified as ascending or 
descending by clicking the item and the Sort Options.

• An item can be removed or added to the sort order with the Add Item 
and Remove Item buttons. 

• An Item not displayed in the report can be added for sorting purposes 
only by selecting the item from the Panels column.
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Preview/Page Setup

Click Preview/Page Setup to view the Design window or to Preview the 
report. Both the Design and Preview functions allow you to view the first 
200 records only from the database to determine column widths and 
page setup for orientation and margins. This function is specific to 
formatted reports only.

Note:  See Print Preview function from the File menu for non-formatted reports. 

The default display is landscape and the settings are maximum column 
width of one inch. The width is set to fit all columns on a page depending 
upon the number of columns in the report.

• Click the Reset Columns Widths to view all columns to fit on the page. 

• Click the Autosize Columns to expand each column to it’s maximum 
width. 

• Click Page Setup window to enter paper size, changing the page 
orientation for portrait versus landscape and setting the margins in 
inches for top, bottom, right and left.

Note: Sizing of the individual columns on the grid in design mode will change 
the column widths. It is advised to set page setup before the setting of the column 
widths since changing the page orientation, left margin size or right margin size 
will set the column widths back to their default settings. Use Preview for sizing 
the columns as well.
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The page you are currently viewing and the total number of pages for the 
first 200 records in the report are displayed with arrows to move through 
the listing. Use the magnify button to enlarge the report preview display. 
You may use the Printer icon to print a sample of the first 200 records of 
the report from the Preview window.

Note: You must use the Create Report to print the entire records contained in 
your report. The Preview function is used to determine report layout dimensions 
and specifications only.
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Create formatted report

You must Create Report to view and print the entire records contained in 
you report. Click OK in the Preview window and return to the Report 
Browser window. Click Create Report. Use the tool bar buttons to scroll 
through the pages or change the image scale.
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Exporting and printing report results

Exporting the report

Export your report in Excel 4, 5 and 7, tab delimited files, HTML format 
and PDF files.

1. The created report window must be the active window. From the File 
menu, select Export. 

Review displays the Export Save As window.

Note: Only Formatted Report types can be exported to PDF files. Non-
formatted reports can only be exported to Excel and HTML.

2. Enter the storage location.

3. Enter the File name.

4. Enter the format type.

5. Click Save.

The report is exported to the currently selected disk directory. (See 
Chapter 12: Common Topics: Export Browser Display Spreadsheets; Copy 
and Paste Browser Results; Copying to Clipboard)
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Print Preview

You can use the Print Preview for the Detail Data Listing and Summary 
Listing only.

Note: Formatted Reports must use the Preview/Page Setup button under the 
formatting functions. 

To display a print preview of your non-formatted output:

1. Click on the generated output window to make it the active window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen. 

3. Click either Print or Close.

The Print Preview function is applicable to all browsers with output 
results.

Printing the report

To print your report:

1. Click , or from the File menu, select Print. 

     Review displays the standard print dialog box. 

2. Click OK. The report prints on the currently selected printer.

Page Setup

The default printed report contains the report heading as you entered it, 
the current Filter Condition, the current patient selection criteria, and a 
page number as the footer.
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Page setup can be accessed by going to the File menu, and selecting Page 
Setup. Review displays a standard page setup dialog box option for you 
to make changes.
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Highlighting patients

Single patient mode

If you have created multiple patient-level displays of your data from all 
of the applicable browsers, you can click on any row in one of the report 
windows to highlight a patient of interest in a Detail Data Listing Report.

Note: Formatted reports are not interactive with the Data Browser and do not 
highlight and support drilldown links with other browsers.
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Click on one patient row instantly highlights the corresponding patient 
and data in any other active patient-level reports, patient listings, and 
Scatter Plot graphs:

In an active scatter graph the selected patient’s data point is highlighted.

In an active Multi-Line Chart Item Value vs. Category by Case graph, a 
highlighted line within the graph will update all patient-level displays of 
data to highlight the patient underlying the case data.
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Multiple-patient mode

When multiple patients are highlighted and selected from any patient-
level display of data, the Detail Data Listing Reports are updated to 
display only the patients that are highlighted and selected. (See Chapter 6 
Graph: Multiple Patient Mode.)

The CrossTab Browser results are categorical patient counts.   A selected 
and highlighted count within a CrossTab or Shift Results Table activates 
all patient level displays to be in the multiple patient mode. 

When a patient count is highlighted in the CrossTab results window, all 
Detail Data Listing Reports are instantly updated to display only the 
patients underlying the patient count highlighted from the CrossTab 
Browser results table.
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Object Storage: saving your work

Finalize output specification

When the report layout contains the necessary information and all 
editing is complete, you can save the report specification for future use. 

Note:  The data in your report contains only data from those patients who meet 
your current patient selection criteria and/or report output filter criteria.

All saved reports with output filters on are saved with the filter 
specifications respectively. If you have an active filter on when the report 
specifications are saved, you will have that same active filter on when the 
saved specifications are relaunched. 

Object storage location

The output specification can be stored at four user access levels: Private, 
WorkGroup, UserGroup, or Public.

•  Private storage is at the local PC level. 

•  WorkGroup storage is PC based and stored at a shared network 
drive, to which a select group of personnel would have access. 

Note:  The WorkGroup storage location was supported in earlier Review 
releases. UserGroup storage location is used extensively for later releases.

• UserGroup storage is a database object storage for defined 
UserGroups in the configuration tables.

Object storage in UserGroup level allows you to specify sharing 
with multiple UserGroups. This works when you click UserGroup 
and you are a member in a UserGroup, then the UserGroup listbox 
is enabled. If you want to share the object with multiple 
UserGroups, simply use the CTRL or SHIFT mouse click for 
multiple selections.

•  Public storage is also a database object storage for all users of 
Review. There is more user access when designated as Public 
versus limited access when setup for WorkGroup or UserGroup 
storage. 

Saving on database object storage sites, requires the author to have 
“Publishing Authorization” defined in the configuration tables. (See 
Chapter 12: Common Topics: Shared Object Storage- Locations)
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Object level
You can store your output specification at three levels: Study, Project, or 
Global. The Object Level box is only enabled and highlighted when you 
select an Object Storage Location designated as ‘db’ for database. There-
fore, when you select either UserGroup or Public for database object stor-
age location, you can assign an object level to restrict access to a specific 
study level or share access between multiple studies at Project or Global 
levels.

When you select the UserGroup object storage location, the ‘Share with 
usergroups’ listbox is made available for selection.
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Save the object specification

To save the report specification you have created for later use:

1. You can save your report specification with either the Report Browser 
window or the Report Output window as the active window.

If the Report Output window is the active window, then the font, 
color, alignment, borders and shading will be stored with the report 
specification.

2. Click , or from the File menu select Save. 

3. Review displays the Save Report Browser window where you can 
specify the storage location. Select an object storage location.

Note: In the example, when UserGroup is selected the ‘Share with usergroups:’ 
box is enabled allowing you to select other usergroups to share access with the 
object specification. Use the CTRL or SHIFT key to make multiple selections.

4. Select object level type. The default is Study.

5. Click Store Patient Selection Criteria if you choose to save the current 
patient selection criteria with the output specification. When a user 
selects the stored object specification they can modify the selection 
criteria and still run the output. If the particular patient selection 
criteria is specific and required for the output, click Patient Selection 
Criteria required. In this instance, the patient selection criteria cannot 
be modified when this stored object specification is selected. If none 
selected, then no patient selection criteria is saved with the output 
specification. 

6. Enter a FileName for future reference to be displayed in the list box for 
Existing Files.   The Filename is for internal use and not displayed in 
the Object Explorer window.
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7. Enter the folder(s) information in the Category box. Each folder 
(major, minor and subfolder) is separated by a period where folder 
titles can consist of more than one word separated by a space. For 
example, the major folder for ‘Safety’ has two minor folders 
‘Safety.AEs’ and ‘Safety.Labs’. Folder names are case-sensitive and 
after the folder(s) are initially created, they are selected from the 
dropdown listbox. 

8. Next enter the appropriate description which is displayed in the 
Object Explorer window.

9. You can include summary information for future reference to be 
viewed by yourself or others later. 

10.Click Save.   

Review stores the output specification to the designated PC, WorkGroup, 
UserGroup, or Public storage location. 

Note: Any place where the output filter is turned on, the output filter criteria is 
saved with the browser specifications and will be active when the saved output 
specification is opened at a later date.
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Object Explorer window

Once you have saved your output specification and assigned folder 
information, your stored object will display in the Object Explorer 
window under Output Specifications.

Review displays a list of folders for previously saved output 
specifications at the selected storage location. Simply select one of the 
storage locations as Private, UserGroup or Public to display it’s specific 
folders and contents.

Icons are displayed along with the stored object to identify the source as 
report, graph, registered SAS program, etc. When a patient selection 
criteria is saved with the stored object; the filter icon displays with the 
specific browser icon. 

Saved objects and their associated icons can be sorted to display in their 
folders by icon type or description. Simply click sort by Type or by 
Description.
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Object properties

You can view information about an object when you select “Properties”.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Then click Properties. The Object Properties window displays the 
object properties for the output object. 

It works for ‘Private’, ‘Workgroup’, ‘UserGroup’ or ‘Public’ objects 
equally.
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Print stored object specification

To print the currently active report specification, make certain that the 
Report Browser window is active by clicking on.

1. Click Print, or from the File menu, select Print. Review displays the 
standard print dialog box. 

2. Click OK.

3. To change the printer, select Print Setup from the File menu.

Repeat column headers are printed on each page in printout.
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Object Explorer quick execute

The Object Explorer window aids users to quickly locate and 
immediately launch previously saved objects stored within organized 
folders. This shortcut allows users to bypass opening the individual 
browsers to launch saved objects.

If you want to retrieve a saved output specification:

1. Double click to open a folder.

2. Click on the output specification and click Execute. Your stored output 
specification is launched.

If you want to apply a saved patient selection criteria to your output 
specification:

1. Double click to open a folder.

2. Double click to paste the selected patient selection criteria into the 
Patient Selection Criteria Window. Then follow the above steps to 
retrieve and execute a stored output specification. Or create your own 
selection criteria for a stored output specification.
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Retrieve stored specification from file menu

Another way to retrieve previously saved object specification from the 
Report Browser: 

1. Make the Report Browser the active window.

2. Select the File menu, click Open. Review displays the Open Report 
Browser window.

3. Select the object storage location to list stored report specifications.

4. Select a report description and click the Open button or double click 
on the report description.

Note: You must use the Open Report Browser window to access the object 
storage location for ‘WorkGroup’.   

a. If you want to browse and/or select a file from the WorkGroup, 
UserGroup or Public storage sites, click on the site and the files 
available to you are displayed in the following window. 

b. Click Change WorkGroup Location, and you are enabled to 
browse various report object storage sites.

5. You can browse through the report specification by reviewing the 
summary text. Click on the report specification, and click Open. 
Review pastes the report layout specifications into the layout 
spreadsheet, clearing the current spreadsheet contents.
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6. By default, Review displays only saved report specifications created 
while reviewing the current Study Protocol(s). You may also import 
report specifications created for other Study Protocol(s). Check 
“Display all studies?” and open any available Report Browser 
specification. Review will validate the data structure to verify that the 
foreign report specification is compatible with the current study 
protocol(s).

7. If a filter criteria was on when the report specification was saved, the 
filter has been saved with the report and will be active upon 
reopening. 

Schedule output

Object Explorer scheduled output

The Object Explorer window aids users to quickly locate and schedule 
previously saved objects stored within organized folders. The output 
scheduler allows users to schedule a job throughout all output browsers 
in Review. This includes reports, graphs, crosstabs and SAS jobs.

1. Select the stored object with a single click. 

2. Right-mouse click to display a floating menu.

3. Click Schedule. A dialog window displays for Job Scheduling.
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4. If you select Later at (Date Time), click on the arrow to display a drop 
down calendar to select a future date and time.

OR

Schedule a repetitive frequency using selected days of the week by 
selecting Later every (day). This feature allows you to automatically 
delete previous generations of the output or enter a number of 
generations to keep.

5. Select who can access the stored output results for Private, UserGroup 
or Public.

6.  Click Submit Job.

The output results are archived in the object folder with a date time 
stamp and identify the user who submitted the job run. Only the person 
who scheduled the job output can delete the stored results. 
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View Scheduled Jobs

Click the Scheduled tab at the bottom of the Object Explorer window to 
view jobs currently scheduled. The scheduled jobs are organized and 
listed in the same folder category as the object specification storage 
folder. 

Remove Scheduled Jobs

If you need to remove a scheduled job, highlight the job description and 
right-mouse click to display a floating menu, click Remove. 
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Change Schedule

If you need to change a scheduled job:

1. Click the Scheduled tab at the bottom of the Object Explorer window 
to view jobs currently scheduled.

2. Select the job description and right-mouse click to display a floating 
menu.

3. Click Change Schedule.

4. The Job Scheduling window opens for you to enter your changes.

5. Click Update.
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Review output

Locate stored output results

The Review Output folders are from the category folder definition for 
each of the objects that were run. You only see folders in the Review 
Output if an object has output saved. 

Note:The exception is previously run and saved SAS Proc output results from 
an earlier Review release. The SAS Proc browser scheduled a job to be run and 
the output saved. The output would be listed under the specific SAS Proc that 
was run. Therefore, old SAS Proc jobs are placed in a SAS Proc folder. 

You can quickly locate stored output results run from the different 
Review output browsers for reports, graphs, crosstabs and SAS jobs.

1.Click the Review Output tab at the bottom of the Object Explorer 
window to view saved output. The stored output results are saved 
with the date/time stamp and author who submitted the job. 

2.Single click on the folder category to open. 

3.Either highlight the output description and click the Review button or 
double click on the description to view output.
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Quick remove saved output results

1.Locate and open the output folder.

2.Select the stored object with a single click. 

3.Right-mouse click to display a floating menu, click Remove. 

Delete multiple output

You can delete multiple output results in one of the following ways:

For contiguous output listed next to each other:

1.Click the first output.

2.Hold the shift key and mouse click and drag the cursor over the 
output tables you would like to delete.

3.Click Delete output.

For non-contiguous output tables not listed next to each other:

1.Select the output tables you want while holding the Ctrl key.

2.Click each output table you would like to delete.

3.Click Delete output.
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Quick remove a stored object specification

You can quickly delete any saved Output Specification in the Output 
Specifications window located on the Execute Objects tab.

1.Select the stored object with a single click. 

2.Right-mouse click to display a floating menu.

3.Then click Remove. You are prompted “Are you sure you want to 
delete the object?”.

The Remove function is a quick way to delete stored objects provided the 
user is the creator or a SuperUser. It works for ‘Private’, ‘Workgroup’, 
‘UserGroup’ or ‘Public’ objects equally. 

Note:If output has been saved for the object specification, then a message displays 
stating saved output exists for this object. Therefore, the object specification 
cannot be deleted at this time.

Remove a stored object specification

Another way to remove a saved object specification:

1. Open the browser to make it the active window. 

2. From the File menu, click Remove.

3. Review displays the Remove Report Browser window.

4. Click on the object storage location.

5. Select the stored report specification you want to remove.

6. Click Remove.
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Review deletes it from your local PC, WorkGroup, UserGroup or Public 
storage sites as you designate and have security clearance to do so.

Closing report browser and reports

Closing a report window

If you are finished reviewing the data in a report, double-click the 
window’s close box, as you would with any other window.

Closing the Report Browser

If you are finished with all reports, and do not want to define any other 
reports: double-click on the close box of the Report Browser window. 

Review also closes all report windows currently opened.
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Exploring data

Changing the patient selection criteria

After you have defined the specifications of your report, and have 
created it by clicking Create Report, you can use the report(s) that are 
currently displayed as data exploration views by doing the following: 

1. Change the patient selection criteria, redefining it by adding 
additional expressions, or removing existing expressions.

2. Click Update Browsers in the Patient Selection Criteria window to 
update all active browsers according to the new criteria.

Reports or other browser objects that are displayed will be updated 
according to your new criteria. Each report generated with a filter on will 
update with the same filter criteria with which it was created. 

Pivot panel presentations

You can create a pivot panel from any of the Review browsers. All pivot 
panels can be shared, if they are created and registered with the ‘Shared 
with Others’ option.

Pivot Panels offer a powerful opportunity to transpose the data structure 
at the database into a clinically pertinent structured views of the actual 
data in the data management system. 

Note: Saved specifications using a pivot panel will only work with the pivot 
panel it was created with. If the same pivot panel is recreated with the same 
name, the objects using the original panel will not work because the system 
naming convention iterates with each created panel. (See Chapter 12: Common 
Topics: Pivot Panels)
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Report output filter

After you have defined the specifications of your report, you can extend 
your data exploration by row filter data inclusion.   Row filtering is 
carried out by the output filter criteria window. The output filter function 
specifies observations and visits, presumably from multi-visit items, to 
focus reporting presentations on clinically specified item values. Filtered 
and non-filtered Scatter Plot graphs can be very informative when 
Review’s patient-level interactive browsers are utilized interactively in 
the multiple-patient mode to identify and characterize a subset of 
patients:

1. Create an output filter or edit by adding, editing, or removing existing 
expressions.

2. Click Save Filter in the Report Output Filter window to apply it 
against the next created Report.

Patient identification

Multiple patients can be selected from all patient-level displays of data 
results. Selecting more than one patient activates Review’s multiple-
patient mode, which updates patient-level displays of data to highlight 
only the selected patient data. This facilitates patient identification and 
subsetting, for exploration of the selected patient data with the reviewing 
facilities of the Data Browser and all of Review’s browser tools. (See 
Chapter 12: Common Topics: Multi-Patient Mode) 

_Define Join Logic_

The pseudo-panel ‘_Define Join Logic_’ provides an opportunity to 
investigate relations within the clinical data defined by medical 
investigators “on the fly”. Join logic defined for the Clintrial type 0 panel 
is required to utilize the items within Clintrial Type 0 panels. Custom join 
logic for Clintrial type 0 panel can be used anywhere in a report. (See 
Chapter 12: Common Topics: Define Join Logic)

Clintrial tags
Clintrial tags are accessible to be used in Report Browser constructs. Clin-
trial tags are listed as a pseudo-panel, and definition and categorizations 
of tags are listed as items. (See Chapter 12: Common Topics: Clintrial TAGS)
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Protocol comparison

Utilizing the pseudo-item <Study ID> in CrossTab constructs facilitates 
comparisons between protocols. (See Chapter 12: Common Topics: <Study 
ID> pseudo Item)

_New Event Function_

Utilizing the pseudo-function ‘_New Event_’ allows you to create and 
define new landmark events to be evaluated and applied to your selected 
patient populations as function values. (See Chapter 12: Common Topics: 
_New Event Function_)

Outer Joins
If enabled, a patient's data is included in a browser’s results even if some 
panels of data are missing for that patient. (See Chapter 12: Common Top-
ics: Reviewing Preferences)

FULL JOIN
By default, full joins is enabled, which sets selection criteria against each 
row per patient. By default the FULL Automatic JOINS, tests by row 
restricting criteria application to Visit and/or Observation, depending on 
the type of Panel.

An optional join preference is to disable the full joins, this facilitates the 
selection criteria to be applied throughout all patient data rows. The 
criteria applied would test by Patient ID and not consider Visit and/or 
Observation, thus broadening the scope of the patients meeting set 
criteria. (See Chapter 12: Common Topics: Reviewing Preferences)
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Patient selection criteria

Selection set
You can explore data items of selected patients graphically after defining 
the patient selection criteria and by using the Graph Browser. 

Opening the Graph Browser

Click , or from the Browse menu, select Graphs. Review displays the 
Graph Browser window where you specify the type and contents of your 
graph. The Graph Type listbox offers two options for displaying data 
graphs at detail patient level or summary data. The Graph Style listbox 
displays selections dependent upon the graph type you selected.
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Access to SAS datasets
SAS datasets are listed with the panels generated from Oracle tables. 
Items from SAS datasets can be used like other items for graphs.

Note: The current restriction is you cannot mix items from SAS datasets and 
Oracle table generated panels within the same graph.

Selecting a graph type

Detail Data Graph

Click Detail Data Graph option in the Graph Type listbox. Click the 
Graph Style button to display a drop-down listbox of graph types for 
Detail Data Graph:

• Scatter (item X vs. item Y) Plot with dual Y axis mode option

• Scatter with Regression Line with dual Y axis mode option

• 3D Scatter (item X vs. item Y vs. item Z) Plot

• Baseline vs. Endpoint Scatter Plot

• Baseline vs. Min value Scatter Plot

• Baseline vs. Max Value Scatter Plot

• MultiLine Chart Item Value vs. Category by Case

• MultiLine Chart Item Value vs. Category by ByVar

Summary Data Graph

Click Summary Data Graph option in the Graph Type listbox. Click the 
Graph Style button to display a drop-down listbox of graph types for 
Summary Data Graph:

• 2D BarChart Frequency Distribution

• 3D BarChart Frequency Distribution

• 2D BarChart Item Summary vs. Category

• 3D BarChart Item Summary vs. Category

• Pareto Chart Frequency Distribution

• Pie Chart Item Summary vs. Category

• Line Chart Item Summary vs. Category with dual Y axis mode option
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• Multiple Variable MultiLine chart

• Polar Chart Item Summary vs. Category

• Radar Chart Item Summary vs. Category

• Filled Radar Chart Item Summary vs. Category

• Multiple Variable Radar

• Mean + Standard Deviation vs. Category

Note: Multiple studies are supported with Summary Data Graphs.

Bar Styles
The Bar Style listbox displays when the Summary Data Graph type is 
selected. The following Bar Styles are available for 2D BarCharts only:

• Clustered bar (Vertical and Horizontal)

• Stacked bar (Vertical and Horizontal)
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Group Functions
All general purpose graph types (2D Scatter, Line Chart, and BarChart) 
allow all normal data function selections displayed in the Functions list-
box. In addition, the following summary graphs support Group Func-
tions dependent upon the item selected:

• 2D BarChart Item Summary vs. Category

• 3D BarChart Item Summary vs. Category

• Pie Chart Item Summary vs. Category

• Line Chart Item Summary vs. Category

• Multiple Variable MultiLine chart

• Polar Chart Item Summary vs. Category

• Radar Chart Item Summary vs. Category

• Filled Radar Chart Item Summary vs. Category

• Multiple Variable Radar
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Defining a graph specification

Creating a graph specification

Specify the contents of a graph by applying the same method that you 
used to build the patient selection criteria. 

1.  Select a panel. 

2. Select each item of interest and the appropriate function for the item.

3. Depending on the graph type and style selected, click the appropriate 
graph axis button to add the item to the graph specification.

For example, click to add the selected item to the Y axis on the right 
side of the Graph Browser window.

4. Enter a Group BY variable (optional).

5. Enter a Page BY variable (optional).

6. Enter a Graph Heading.

7. Click Create Graph.

Note: Selected 2D graphs in Detail Data Graphs for Scatter Plots and Summary 
Graphs for 2D Barcharts support the Add Page variable.
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When you apply a Page variable item such as investigator which may be 
common to most to your panels, select the investigator data item from 
the same panel as your Axis items. In this example, the lab items and 
investigator were selected from the Lab Hematology panel. This will 
avoid creating complex outer joins or possible discrepancies where the 
Page variable item may be missing in a particular panel.
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Note: The Page By item variable selected in this example for Investigator is 
displayed in the lower right corner along side the page number.

Change graph specifications

1. To change the graph specifications you defined:

a. Click on the Y axis or X axis to be deleted.

b. Click  or from the Edit menu select Cut. 

c. If you want to clear the graph specifications entirely, click .

Note: You may use the pseudo-function ‘_New Event Function_’ to define your 
own function as well as new items and new ranges are supported throughout the 
Graph Browser. (See Chapter 12 Common Topics: Derived items and New 
Range Variables and New Event Function.)
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Graph Browser output filter
2. Optionally, create an output filter: 

a. Click Filter Output, to row filter the observations and/or date 
values of choice. 

b. After you build the output filter criteria and save it, the Filter 
Output button toggles to . 

3. When you are satisfied with the contents of the graph specification, 
click Create Graph. The filter criteria is applied during the next graph 
creation. (See Chapter 6: Report Browser: Output Filter.)

Graph display results

2D Graph Toolbar

The toolbar displayed in your graph results window is dependent upon 
the graph you specified. Select 2D graphs have additional features 
available from the toolbar and the buttons activated are dependent upon 
the graph style selected for the graph specification. Some 2D graphs have 
optional multi-page graph display buttons enabled when the Page By 
item variable is defined in the graph specification. In addition, the 2D 
Summary Data Graphs have graph style buttons so you can change the 
current graph style without replacing the graph specification.

When you click Create Graph the graph toolbar is displayed at the top of 
the results output window. The first and second buttons are the 
‘Snapshot’ and ‘Who?’ buttons and are available for all output browsers. 
(See Chapter 6: Report Browser: Snapshot Output)
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Display multiple pages

The next four buttons apply to the multi-page graphing capability for 
select 2D graphs where multiple graphs can display on the same 
window. The Page By item variable is optional when you define the 
graph specification. Simply click a multi-page graph button to view 
several graphs displayed on the same window.

Initially the graph opens and displays in single mode. If a Page By item 
variable was defined, you can move within single mode between the 
individual pages with the up/down arrow keys.

The Page By item variable for Investigator in this example is displayed in 
the lower right corner of each graph display along side the actual page 
number.
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Change graph style

Select 2D Summary Data Graphs have the ability to change the graph 
type after the graph has been generated. Create your 2D Summary Graph 
to view the results, then click the graph style buttons to change the graph 
style view.

Note: The same graph header is displayed between all selected graph styles.
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Highlight the graph

The 2D and 3D graphs display a different graph toolbar. Therefore, 
slightly different steps are used to highlight data points or bars between 
the graph styles.

• Initially when you create and view a select 2D graph type the arrow 
icon is active for highlighting and defaulted ON. 

• To highlight data points in any 2D Scatter Plot Graph, click and drag 
the mouse over the selected area in the graph. Start the mouse drag 
from the upper left corner down and across to the lower right corner.

• The 3D Scatter Plot displays a minimal toolbar without the arrow icon. 
Simply click and drag the mouse over the selected area in the graph.

• A 2D or 3D Summary Data Graph only requires a click on the selected 
bar to highlight.
Graph display results 351



Le
ve

l 1
 b

le
ed
Note: Scatter Plot graphs allow you to save a visual subset of selected data 
points. (See Graph Browser: Patient subset by graph) 
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Zoom the graph

To use the graph zoom feature on 2D Scatter Plot graphs: 

1. Create your 2D Scatter Plot.

2. Click the left magnify button to turn ON the zoom. Click and drag the 
mouse over the selected area in the graph. A new view of the select 
zoom area of your graph is displayed.

3. If you choose to highlight any data points while in zoom mode, click 
the arrow icon to highlight those data points.

4. To exit out of zoom mode and reset to the original display, click the 
right magnify button.
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Resize graph image

The last two buttons increase or decrease the size of the graph image.

Multiple graphs

You can have multiple graphs active at the same time. After you have 
defined and created one graph:

1. Define and create the first graph and leave the results window open.

2. Go back to the Report Browser window. Click ,or from the File 
menu, select New to refresh your screen. 

3. Define and create the new graph. Review displays a new window and 
displays your graph within it. 

Note: If you make changes to the patient selection criteria it will refresh the open 
graph results window.

Snapshot output

Multiple population mode

Review has an optional multiple-population mode available in the Graph 
Browser. The Snapshot output allows you to change the patient selection 
criteria and view the different output within the graph browser at the 
same time. When the results are executed and displayed from the graph 
browser output window, two icons are displayed for “Snapshot Output” 
and “Who?”. (See Chapter 6: Report Browser: Snapshot Output and Chapter 
12 Common Topics: Snapshot output)
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Patient subset by graph

Subset by graphic regional selection

The click and drag windows region selection convention used for 
highlighting or outlining a region of data, is used in the Graph Browser 
for Scatter Plots to create a instantaneous subset of patients within the 
boundary created. (See Graph Browser: Highlight the graph)
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When you open the Data Browser and then select a region from any 
scatter plot in the multiple-patient mode, the Data Browser instantly 
updates the current patient listing and all data browsing features for the 
selected patients within the region selected in the scatter plot graph. (See 
Graph Browser: Multiple-Patient Mode)

Save Visual Subset

You can save patient subsets from patient-level graphs when you 
highlight data points. The Save Subset icon is activated and located as the 
last button in the toolbar. When you click Save Subset Review displays 
the Save Visual Subset window where you specify the storage location 
and details for later use.
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1. Enter the Object Storage Location and Object Level.

2. Enter a FileName.

3. Enter the folder(s) information in the Category box. Each folder 
(major, minor and subfolder) is separated by a period where folder 
titles can consist of more than one word separated by a space. Folder 
names are case-sensitive and after the folder(s) are initially created, 
they are selected from the dropdown listbox.

4. Enter a description and summary information for display and future 
reference.

5. Click Save. 

The stored patients represented in a visual subset from the Graph 
Browser can be used in regenerating reports and other analyses.
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The saved Visual Subset object stores the highlighted patients in the 
designated folder of the Object Explorer window under Patient Subsets. 
The visual subset description is listed with a double icon as a filter with a 
scatter plot graph on top. The double icon distinguishes the stored visual 
subset object from the stored patient selection criteria objects which 
display a single filter icon.

Note: The saved patient subset is NOT A DYNAMIC SAVE. If the data points 
change in the future, selecting the saved object will display the original subset of 
data points.

Remove Visual Subset

You can do a quick remove of the stored visual subset.

1. Click on the stored object under the Patient Subsets window. 

2. From the File menu, click Remove. You will see a message display 
asking you to confirm the deletion.

Review deletes the visual subset from the designated local PC, 
WorkGroup, UserGroup or Public storage location if you have security 
clearance to do so. (See Chapter 12: Common Topics: SuperUser Privileges)
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Types of Detail Data Graphs

Scatter (Item X vs. Item Y) Plot

 In a Scatter (Item X vs. Item Y) Plot graph, each data point corresponds 
to each patient’s observation for item X and item Y and BY variable to 
subset graphic displays. 
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There is no restriction on the data type and character data is also 
supported. This example demonstrates the Page variable where the data 
item Investigator was taken from the Concomitant Medication panel 
along with the X and Y Axis data items.
362 Chapter 7:  Graphing



Level 1 bleed
Use the Page Up and Page Down buttons on your keyboard to move 
between Investigator pages. 

Note: You may need to limit the number of patients displayed.
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The Scatter (Item X vs. Item Y) Plot can also be plotted as two variables 
on the Y axis (dual Y axis mode).
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Scatter Plot with Regression Line

In a Scatter (Item X vs. Item Y) Plot with Regression Line (least mean 
square algorithm), each data point corresponds to each patient’s 
observation for item X and item Y. There is no restriction on the data type 
used. 

Testing of Regression formula of Y on X: (y = a + b * x)

The Scatter Plot with Regression Line can also be plotted as two variables 
on the Y axis (dual Y axis mode).
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3D Scatter Plot

The 3D Scatter (Item X vs. Item Y vs. Item Z) Plot displays three-
dimensional data. Each patient’s data points for X and Y coordinates are 
plotted against the Z elevation value. Use the BY variable to subset 
graphic displays.
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You can rotate a 3D graph image. Click on the left mouse key and then 
the right mouse key while holding down both keys at the same time, 
rotate the graph image. 
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Baseline vs. Endpoint Scatter Plot

In a Baseline vs. Endpoint scatter plot each data point represents a 
patient’s baseline (X axis) and endpoint (Y axis) for the item. The Baseline 
vs. Endpoint Scatter Plot have only “Y axis” button enabled. When you 
add the item to the Y axis, it is automatically added to the X axis, and 
both axis titles are modified with 'Baseline' or 'Endpoint' after the 
description. Use the BY variable to subset graphic displays. Review also 
provides graphing formats for Baseline vs. Min Value Scatter Plot, as well 
as Baseline vs. Max Value Scatter Plot of selected items.
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MultiLine Chart Item Value vs. Category by Case

In a MultiLine Chart Item Value vs. Category by Case graph, each patient 
is represented by a line. PID is defaulted for the patient identification. 
The Page variable is not allowed. Click on a line and the underlying 
patient will be highlighted in all patient-level displays of data.

Note: You may need to limit the number of patients displayed.
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In this example, a patient selection criteria was applied to the graph 
output for Medical History if Diabetes was ‘Yes’ and displays in the 
graph heading.
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MultiLine Chart Item Value vs. Category by ByVar

The MultiLine Chart Item Value vs. Category by ByVar graph, provides 
the same functionality as the MultiLine Chart item Value vs. Category by 
Case graph. However, you select the patient identification item. Each 
patient is represented by a line. Click on a line and the underlying patient 
will be highlighted in all patient-level displays of data.

Note: You may need to limit the number of patients displayed.
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Types of Summary Data Graphs

2D Bar Chart Frequency Distribution

In a 2D BarChart Frequency Distribution graph, each bar represents the 
category value of the item with the Y axis representing the frequency. Bar 
style options are clustered bar versus stacked bar in vertical or horizontal 
orientation. Use the BY variable to subset graphic displays.
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This example shows the same graph type and style, but with a different 
Bar style option for clustered horizontal.
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This example of a 2D Barchart Frequency Distribution plots Adverse 
Event data. The counts represent patient counts and the individual 
adverse events. Compare to the Summary Listing.
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(partial screen display)
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X and Y scaling

The X and Y axis scaling on the graph browser screen only appears when 
line charts or 2D bars are the selected graph styles. They are inactive and 
initially set to Auto until a page variable is selected. Then you may pick 
either Auto (0), Fixed (1), or Variable (2). When you save any graph, an X 
and Y scaling value will be saved. These values will be 0 unless you 
changed them on the screen. For old saved graphs, if no X and Y values 
exist, it will read as 0.
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3D BarChart Frequency Distribution

In a 3D BarChart Frequency Distribution graph, each bar represents the 
category value of the item with the Y axis representing the frequency.
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Use the BY variable to subset graphic displays.
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2D Bar Chart Item Summary vs. Category

In a 2D BarChart Item Summary vs. Category, each bar represents a 
category value X axis versus a summary statistic (mean, count, sum) Y 
axis. The Graph Browser window provides a list of group functions for 
the Y axis. Use the BY variable to subset graphic displays.
386 Chapter 7:  Graphing



Level 1 bleed
Types of Summary Data Graphs 387



Le
ve

l 1
 b

le
ed
3D BarChart Item Summary vs.Category

In a 3D BarChart Item Summary vs. Category, each bar represents a 
category value X axis versus a summary statistic (mean, count, sum) Y 
axis. The Graph Browser window provides a separate list of group 
functions for the Y axis. Use the BY variable to subset graphic displays.
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Pareto Chart Frequency Distribution

In a Pareto chart frequency Distribution, each bar represents a category 
value that corresponds to the plotted Y axis. The line above the bars 
shows the cumulative percentage. Pareto charts display the Y axis bars in 
descending order of frequency.
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Pie Chart Item Summary vs. Category

The Pie Chart Item Summary vs. Category, draws each slice to represent 
a category value X axis versus a Y axis summary statistic (mean, count, 
sum). The Graph Browser window provides a separate list of group 
functions for the Y axis. Use the BY variable to display multiple pie 
charts of grouped data.
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Polar Chart Item Summary vs. Category

In a Polar Chart Item Summary vs. Category, each data set is draw as 
connected points on a polar coordinate system (theta, r). The X axis 
values (theta) are drawn as a circle to represent the amount of rotation 
and Y axis values (r) are the distance from the origin.

The Graph Browser window provides a separate list of group functions 
for the Y axis. Use the BY variable to display multiple sets.
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Radar Chart Item Summary vs. Category

The Radar Chart Item Summary vs. Category, draws the Y axis value in 
each data set along a radar line (where the X value is ignored). The chart 
plane is equally divided into angle segments (each point represented at 
n/360 degree increments) with the X axis showing Point-labels. The 
radial gridlines are spaced equally apart. By default, the radar line 
representing the first point is drawn vertically at 90 degrees. Each data 
set is drawn as connected points along the radar lines.

The Graph Browser window provides a separate list of group functions 
for the Y axis. Use the BY variable to subset graphic displays.
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For polar and radar charts, circular gridlines are a property of the Y axis 
and radial gridlines are a property of the X axis.
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Filled Radar Chart Item Summary vs. Category

The Filled Radar Chart Item Summary vs. Category, shares the same 
chart definition as the Radar Chart Item Summary vs. Category. The 
difference is each data set is drawn as connected points along the radar 
lines with the area filled inside the points.

The Graph Browser window provides a separate list of group functions 
for the Y axis. Use the BY variable to subset graphic displays. Multiple 
sets are drawn “on top” of the preceding set.
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Line Chart Item vs. Category

In a Line Chart Item vs. Category, trends over time or other categorical 
items can be presented. With the use of a categorical BY variable, two or 
more populations can be represented, and comparatively viewed. The 
Graph Browser window provides a separate list of group functions for 
the Y axis. Line Chart Item vs. Category allows you to plot up to 2 
variables on the Y axis (dual Y axis mode). 
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Item Mean and Standard Deviation vs. Category

In a Item Mean and Standard Deviation vs. Category graph, the standard 
deviation is represented by range bars at each categorical data point. 
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Highlighting patients

Single patient mode

Scatter Plot graphs are patient-level graphs, and each data point 
represents an individual patient’s data value for the respective variables. 
A click on any data point facilitates identification of the underlying 
patient and access to all respective patient data in the single patient 
mode.

1.  Activate the Data Browser to display a list of patients in the current 
patient selection, or activate the Report Browser to create and display 
any Detail Data Report (a list of patient data with customized data 
item groupings).

Note:The highlighting feature does not apply to formatted reports. (See 
Chapter 6: Report Browser: Formatted Reports)

2. Click on any data point in the Scatter Plot graph. Review highlights 
the clinical data point clicked on within the graph. The selected patient 
is highlighted throughout any open Detail Data Listing Reports, open 
Scatter Plot graphs, and/or the Data Browser patient list and open 
data Panels.

3. If you click on a patient’s row in a Detail Data Listing Report or Data 
Browser patient list, the selected patient’s data point is highlighted in 
any scatter plot.
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4.  If there are multiple scatter plots or Baseline vs. Endpoint plots active, 
each plot highlights the selected patient’s data point. You can click on 
a patient’s data point in one graph to see where that patient’s data 
point is displayed in other graphs.
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Multiple patient mode

Scatter plot graph

The Graph Browser Scatter Plot graphs provide a click and drag function 
to outline a region of a graph, thus selecting the patients within that 
region. Graphic regional patient selection sets Review in the multiple 
patient mode. 

Detail Data Listing Reports, the Data Browser patient listing, and other 
Scatter Plot graphs are updated to display only the patients that are 
highlighted in an active Scatter Plot graph in multiple-patient mode. 

The CrossTab Browser results tables are categorical patient counts; a 
highlighted count within a CrossTab or Shift Table activates all patient 
level displays to be in the multiple patient mode. When a patient count is 
highlighted in the CrossTab results window, instantly all Detail Data 
Listings, Reports, Scatter Plot graphs, and the Data Browsers patient 
listing are updated with only the patients underlying the patient count 
highlighted from the CrossTab Browser results table.

Multi-Line graph
All lines within a multi-line graph, will immediately highlight the under-
lying patient throughout all open patient-level displays of data. 

BarChart graph
All bars depict a subset patient populations in the BarChart graphs. Click 
on a bar within a BarChart graph and all underlying patients will be sub-
set in all open patient-level displays of data.

Pie Chart
All slices depict a subset patient populations in the Pie Chart. Click on a 
slice within a Pie Chart and all underlying patients will be subset in all 
open patient-level displays of data.
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Graph editing

Graph settings

Once you create your graph, you can right-mouse click anywhere on the 
graph to open the graph settings window.   All 3D graph styles display a 
specific 3D Chart Control Properties window to select the tab and edit 
graph properties.

All other graph styles utilize the graph settings window. You can apply a 
variety of graph format changes with the setting options available.

Each graph setup has it’s own selection window with default settings 
and setting options for you to select. When you select a variable setting in 
the Variable listbox, the description of the setting function is displayed. 
The available choices are listed in the Option listbox. A Default button 
allows you to return to the default setting. 
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General Setup

Display Setup
410 Chapter 7:  Graphing
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Axis Setup

Title Setup
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Legend Setup

Printing Graphs

Print Preview

The default setting for all graphs is portrait and full screen display. Use 
the Page Setup to select landscape and to adjust height and width. All 
graph displays are for a single plot.

To display a print preview of your graph:

1. Click on the generated output window to make it the active window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen. 

3. Click Print or Close from the Print Preview window.

The Print Preview function is applicable to all browsers with output 
results.
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Printing the graph

Another way to print with the graph output window open:

1.  Click , or from the File menu, select Print. 

 Review displays the standard print dialog box. 

2. Click OK. The graph prints on the selected printer. 

Object storage: saving your work

(See Chapter 6: Report Browser: Object storage: saving your work)

Schedule output

(See Chapter 6: Report Browser: Schedule output)

Closing graphs and the Graph Browser

Closing a graph window

If you are finished reviewing a graph, and do not need to use the Graph 
to review any other patient populations: double-click the window’s close 
box.

Closing the Graph Browser

If you are finished with all graphs, and do not need to define any other 
graphs, double-click the close box of the Graph Browser window. 
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Exploring Data

Changing the patient selection criteria

After you define the specifications of your graph, and create it by clicking 
Create Graph, you can use the graph currently displayed as a data 
exploration view by doing the following: 

1.  Change the patient selection criteria, adding additional expressions or 
removing existing expressions.

2. Click Update Browsers in the patient selection criteria window to 
update all active browsers according to the new criteria.

Graphs or other browser objects that are displayed will be updated 
according to your new criteria. Each graph generated with a filter on will 
update with the same filter criteria with which it was created.

Multiple protocols

Utilizing the pseudo-item <Study ID> in Graph Browser constructs, 
within summary graphs and as a BY variable, facilitates comparisons 
between studies. (See Chapter 12: Common Topics: <Study ID> pseudo item.)

Graph output filter

After you define the specifications of your graph, and create it, you can 
use the output filter facility as a data exploration tool by row filtering 
data inclusion, then comparing filtered and unfiltered results. Row 
filtering is carried out by the Output Filter Criteria window. The output 
filter function allows specified observations and visits, from multi-visit 
data items, to focus graphical presentations on clinically specific item 
values (numeric and/or categorical) and ranges. 
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Open filtered Scatter Plot graphs can be very informative when Review’s 
patient-level browsers interact in the multi-patient mode. In this mode 
Review facilitates the ability to identify and characterize a subset of 
patients:

1.  Create the output filter criteria or edit it by adding additional 
expressions, or removing existing ones. 

2. Click Save Filter in the Graph Output Filter window to apply it 
against the next created graph.   The Output Filter button in the Graph 
Browser window toggles to .

Note: If you save the graph with an output filter ON, the same filter will be 
used when the graph is recreated.
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Patient selection criteria

Selection set
You can explore clinical groupings of patients within a single protocol 
who meet the current patient selection criteria by using the CrossTab 
Browser. 

Note: The CrossTab Browser allows Multistudy mode in CrossTabs. However, 
Shift Tables does not allow multiple protocol selection.

Open the CrossTab Browser

Click , or from the Browse menu, select CrossTabs. Review displays 
a new window where you can specify the type and contents of your 
multi-dimensional analysis:
Patient selection criteria 419



Le
ve

l 1
 b

le
ed
CrossTab Browser types of analysis

Selecting a CrossTab Browser type of analysis

Select a Type of CrossTab/Shift Table from the Type List by clicking on 
one of the following: 

CrossTab: Clinical patient categorization and counts.

Shift Table: Clinical patient categorization by defined threshold values 
segmented over time.

Either CrossTab type facilitates browsing patient listings underlying any 
of the patient counts within the table results. When you click on any of 
the categorized patient counts, the results table updates the Data Browser 
and Detail Data Listing Reports to display a listing of patients underlying 
the table count. Scatter plot graphs highlight the patients underlying the 
CrossTab Browser table patient count clicked on. This function facilitates 
patient identification to all underlying patient data from categorical 
patient counts, regional graphic selection, and row selections in patient 
and detail data listings.
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Defining a CrossTab table

Selecting a panel, item, and function

You can define the contents of a CrossTab table by applying the method 
that you used to build all other browser specifications. 

1. Select a panel.

2. Select each item of interest. 

3. For each item, select the appropriate functions or use the default 
functions. 

4. Click  or  to add the selected Items to 
the CrossTab content spreadsheet at the bottom of the CrossTab 
window.

5. You can edit the default Cross Tab Heading by clicking in the heading 
box. 

6. Click Create.
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The CrossTab construct is created and instantly displays results in the 
CrossTab output window containing a spreadsheet of the multi-
dimensional analysis you designed.

Note: The data in teh CrossTab contains only the data from those patients who 
meet your current patient selection criteria and output filter criteria.

In the exampe, the CrossTab data represents patient counts and not 
individual Adverse Events. 
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Access to SAS datasets

SAS datasets are listed with the panels generated from Oracle tables. 
Items from SAS datasets can be used like other items for CrossTab.

Note: The current restriction is you cannot mix items from SAS datasets and 
Oracle table generated panels within the same CrossTab.

Optional Include Row% Col%

You can optionally create a CrossTab or Shift Table with row and column 
percentages displayed.

7. Click . Each row and column is summarized by the 
following descriptive statistics:

Sort by Code Value

If you want to sort the CrossTab table by the order of the code values, as 
opposed to the default alphabetic sort of the descriptive text.

Click “Sort by Code Values”.
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Output Filter

Row filtering is carried out by the Output Filter which facilitates the 
specification of observations and visits from multi-visit data items to 
include in your CrossTab results.

After you define your CrossTab specifications you can use the output 
filter as a data exploration tool by row filtering data inclusion, then 
comparing filtered and unfiltered results. (See Chapter 6 Report Browser: 
Output Filter)

8. Click Filter Output.

9. Add the filter expressions and click SAVE.

10.The Filter Output button status toggles to Filter is ON when a row 
filter criteria is active to be applied during the next graph creation.  
Click Create Graph. 

Note:  If you save a CrossTab specification with an output filter ON, the same 
filter will be applied when teh CrossTab is recreated.

Edit column width

 To edit the column width of the CrossTab results:

a. Click the column heading tabs (labeled A, B, etc.) as you would 
with any windows spreadsheet package.

b. Move the column boundaries to the position you want.

Add cell variable

You can optionally generate statistics for a specified cell variable when 
you create a CrossTab. 

a. Select a panel.

b. Select a numeric item. Click Add Cell Variable.

c. Select one or more Cell Statistics. You must select at least one.

Note: The Cell Statistics default for Count Subjects must be on. If you choose to 
use the Add cell variable to optionally generate statistics for a specified cell 
variable, it cannot be used in conjunction with Optional Include Row%, Col%.
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The individual cells display the statistics you selected with the cell 
variable item.

Editing a CrossTab specification

Changing the CrossTab specification

If you want to change the CrossTab specification that you have defined:

1. Click any element in the CrossTab layout to edit. For example, click on 
any column heading that you want to delete.

2. Click , or from the Edit menu, select Cut.   This deletes the 
column heading from the CrossTab specification.

3. To modify the corresponding Filter Output, simply change the criteria 
expressions appropriately

4. Click Save Filter. 

5. Click Create CrossTab to create a new results window. 

6. If you want to clear the entire CrossTab construct, click .
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Defining a Shift Table

Item analyzed

The Shift Table is a patient count of any numeric multi-visit patient data, 
providing patient categorization by defined threshold values segmented 
over time. The panels and items available are limited to data that is 
multi-visit or multi-measure. You must use numeric data.  When the Shift 
Table is selected, not all panels listed contain data suitable for Shift Table 
calculation. For example, Dose and Concomitant Medication is not as 
meaningful as data values with normal ranges to reference.
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Create Shift Table

Define the contents of a Shift Table by applying the same method that 
you used to build all other browser constructs: 

1. Select a panel.

2. Select the item to be analyzed. 

3. Click ADD Item to the Item Analyzed box. Basic descriptive statistics 
are displayed and default cutoff values are assigned.

4. By default, the CrossTab Browser assigns the table type as the heading. 
Edit the default Shift Table heading to easily identify the Shift Table 
results window. The heading displays as the caption of the Shift Table 
output, as well as on any printouts.

5. Click Create.  Review opens the Shift Table results.
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Read Baseline values as rows versus Endpoint values as columns. For 
example, the lab Glucose had 1 patient normal at baseline and high at 
endpoint of the study.

Range values

Use the default Low/High range values. The Shift Table type presents 
basic statistics and default boundary values of normal range for the 
selected item. The normal range by default is +/- two times the standard 
deviation.

Or, you can edit the default Low/High range values by typing in the 
values you want to apply.
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Use the Companion Low/High variable names to select the laboratory 
normal ranges for the item analyzed.
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Include Row% and Col% 

You can optionally create a Shift Table with row and column percentages 
displayed.

Check . Each row and column will be summarized 
by the following data:

Note: When you include the calculations for row and column percent, you may 
see text ‘#DIV/0!’ for values where zero cannot be divided by zero. 

If you save a CrossTab construct with a patient selection criteria and/or 
the output filter on, they are saved with the CrossTab or Shift Table 
output specification. (See Chapter 6: Report Browser: Object Storage: saving 
your work)
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Multiple CrossTab/Shift Tables 

Multiple CrossTabs

You can have multiple CrossTabs active at the same time. After you 
define and create one CrossTab:

1. Click , or from the File menu, select New to refresh your screen. 
While creating a new CrossTab you can add to the specifications of the 
existing CrossTab. 

2.Click Create to execute the new CrossTab. There will be a CrossTab 
Browser output window for each CrossTab created. There is no 
limitation within Review as to how many CrossTabs you create and 
leave open. Each open CrossTab output window is fully interactive 
with all patient level browser displays, to identify and characterize the 
underlying patient data.You can optionally create a CrossTab or Shift 
Table with row and column percentages displayed.

Note:If you enter a patient selection criteria, all currently open crosstab 
output windows will refresh to display the new results with the patient 
selection criteria applied.

Snapshot output

Multiple population mode

Review has an optional multiple-population mode available in the 
CrossTab Browser. The Snapshot output allows you to change the patient 
selection criteria and view the different output within the CrossTab 
browser at the same time. When the results are executed and displayed 
from the CrossTab browser output window, two icons are displayed for 
“Snapshot Output” and “Who?”. (See Chapter 6 Report Browser: Snapshot 
Output and Chapter 12: Common Topics: Snapshot output)
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Printing and exporting CrossTab/Shift Tables

Print Preview
To display a print preview of your output:

1. Click on the generated output window to make it the active window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen. 

3. Click either Print or Close.

The Print Preview function is applicable to all browsers with output 
results.

Print the CrossTab/Shift Tables

To print the CrossTab/Shift Table:

1. Click , or from the File menu, select Print. Review displays the 
standard print dialog box. 

2. Click OK on the printer. The CrossTab/Shift Table prints on the 
specified printer. 

The default printed CrossTab/Shift Table contains the CrossTab/Shift 
Table heading as you entered it as a header, the current patient selection 
criteria, and a page number as the footer. 

Page Setup
Page setup can be accessed by selecting page setup from the File menu. 
Review displays a standard spreadsheet page setup dialog box, allowing 
you to make changes.
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Exporting the CrossTab/Shift Tables

Export of CrossTab spreadsheet includes Excel 4, 5 and 7, tab delimited 
files, HTML format and PDF files. 

 To export your tables:

1. From the File menu, select Export. 

Review displays the Export Save As window. 

2. Enter the storage location, and Click OK. 

Your tables are exported to the currently selected disk directory. (See 
Chapter 12: Common Topics: Shared Object Storage- Location.)
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Interactive patient-level displays

Detail data patient listings and graphs

If you have created a Detail Patient Listing report, Scatter Plot graph, or 
have the Data Browser open, you can click on any table values in one of 
the CrossTab/Shift Table windows to view a patient listing of the 
selected table value in all open patient-level displays of data. You 
automatically highlight and subset the patients underlying 
CrossTab/Shift Table values in any other active patient-level Scatter Plot 
graph, Detail Data Listing report, and Data Browser patient listing, when 
you click on a table value.
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The patient counts are fully interactive with all patient-level displays of 
data. Data Browser and Detail Data Listing reports update to identify 
and describe only the patients underlying the patient counts clicked on.

Note: Use patient categorical counts for low, normal and high to highlight the 
same patients in graphs. Do not use total counts.

Scatter plot graphs update to highlight only the patients underlying the 
patient count selected in the Shift Table, against the patient population 
subset by the current patient selection criteria.
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Object storage: saving your work

(See Chapter 6: Report Browser: Object storage: saving your work)

Schedule output

Note: You cannot schedule a saved Shift Table specification, however, you can 
schedule a saved CrossTab specification.  (See Chapter 6: Report Browser: 
Schedule output)

Closing CrossTab tables and the CrossTab Browser

Closing a CrossTab Window

If you are finished reviewing the data in a CrossTab or Shift Table, 
double-click the window’s close box.

Closing the CrossTab Browser

If you are finished with the CrossTab Browser and do not want to define 
any other constructs, double-click the close box of the CrossTab Browser 
window. Review closes all CrossTab Browser windows currently opened.
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Exploring data

Changing the patient selection criteria

After you define the specifications of your CrossTab\Shift Table, and 
create it by clicking Create CrossTab, you can use the CrossTab\Shift 
Table(s) that are currently displayed as data exploration views: 

1. Change the patient selection criteria, redefining it by adding 
additional criteria expressions, or removing existing criteria 
expressions.

2. Clicking Update Browsers in the Patient Selection Criteria window to 
update all active browsers according to the new Criteria.

CrossTabs or other browser objects that are opened will be updated 
according to your new patient selection criteria.

CrossTab output filter

Row filtering is carried out by the Output Filter Criteria window. The 
output filter facilitates specification of observations and visits, from 
multi-visit data items, to include in your focused presentations. 

After you define the specifications of your CrossTab, you can use the 
output filter as a data exploration tool by row filtering data inclusion, 
then comparing filtered and unfiltered results. Open filtered and non-
filtered Scatter Plot graphs can be very informative when Review’s 
complementary browsers, such as the CrossTab browser, are utilized in 
the multiple patient-mode to identify and characterize subsets of 
patients:

1. Click Filter Output, and create a new filter by adding or removing 
filter criteria expressions. 

2. Click Save Filter in the CrossTab output filter window to apply it 
against the next created CrossTab. The Filter Output button in the 
CrossTab Browser window toggles to Filter is ON.

Note: If you save the CrossTab specification with an output filter on, the same 
filter will be applied when the CrossTab is recreated.
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Pivot panels
Pivot panels provide a powerful display of data, and provides a data 
structure that can be uniquely utilized by the CrossTab Browser in pro-
ducing clinically pertinent presentations of data “on the fly”. 

Note: Saved specifications using a pivot panel will only work with the pivot 
panel it was created with. If the same pivot panel is recreated with the same 
name, the objects using the original panel will not work because the system 
naming convention iterates with each created panel. (See Chapter 12: Common 
Topics: Define Pivot Panel.)

Join logic
The pseudo-panel ‘_Define Join Logic_’ provides an opportunity to 
investigate relations within the clinical data defined by medical investi-
gators “on the fly.” Join logic defined for the Clintrial type 0 panel is 
required to utilize the items within Clintrial type 0 panels. (See Chapter 
12: Common Topics: Define Join Logic.)

Clintrial tags
Clintrial tags are accessible format in CrossTab specifications. Clintrial 
tags are listed as a pseudo-panel, and definitions and categorizations of 
tags in the item list. (See Chapter 12: Common Topics: Clintrial tags.)

 _New Event Function_

Utilizing the pseudo-function ‘_New Event Function_’ allows you to 
create and define new landmark events to be evaluated and applied to 
your selected patient populations. (See Chapter 2 Selecting Patients: _New 
Event Function and Chapter 12: Common Topics: Derived Function Values 
_New Event Function.)
440 Chapter 8:  CrossTab Browser



Level 1
9 Generating Statistics9

 bleed

Level 3 bleed
Patient selection criteria     443

Selection set     443

Opening the SAS Proc Browser     443

Selecting a SAS Proc type     444

Selecting a SAS Proc     444

Defining a SAS View and Dataset     445

Create SAS View and Dataset     445

Select format library options     448

SAS Transport Files     449

V5 (FDA Guidelines) option     449

Edit panels     451

Defining a SAS Proc Specification     452

Define SAS Proc specification     452

Adding items to be analyzed     452

Adding BY variables     454

Statistics options     454

Defining a SAS Proc title     455

Creating the SAS Proc output     456

Change a SAS Proc specification     456

Output filter     457

SAS Proc results display     457

Toolbar     457

Find menu command     458

Displaying the SAS output, source, or log     458

Exporting and printing results     459

Print Preview     459

Printing the SAS Proc results     459

Exporting the result     460
 441



Le
ve

l 1
 b

le
ed
Other SAS Proc displays     461

Multiple SAS Proc outputs     470

Opening multiple SAS Proc results     470

Snapshot output     470

Multiple population mode     470

Saving a SAS Proc specification     471

Review output     471

Schedule SAS Proc jobs     471

Close SAS Proc Browser and results     472

Closing a SAS Proc output window     472

Closing the SAS Proc Browser     472

Exploring data     472

Changing the patient selection criteria     472

SAS Proc output filter     472

Pivot panels     473

Join logic     473

Clintrial tags     473

Protocol comparison     474

_New Event Function_     474
442 Chapter 9:  Generating Statistics



Level 1 bleed
Patient selection criteria

Selection set
You can explore statistical reports of selected items for the patients who 
meet the current patient selection criteria by using the Statistics Browser 
(SAS Proc Browser). 

Note: Full or restricted access to the SAS Proc Browser is enabled/disabled based 
on the SAS user-level setting made by the administrator. By default, access to all 
SAS Procs is enabled.

Opening the SAS Proc Browser

Click , or from the Browse menu, select SAS Procs. Review dis-

plays a new window where you can specify the panels and items to be 
included for the execution of SAS procedures.
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Selecting a SAS Proc type

Selecting a SAS Proc

Select one of the following types of SAS Proc:

– Create SAS View - generates a SAS View of the items selected.

– Create SAS DataSet - generates a SAS Dataset of the items selected 
for the patient population currently selected.

– FREQ - generates a frequency distribution matrix of the items 
specified.

– FREQ with Statistics - generates a frequency distribution matrix 
with additional statistics ‘Options’.

– GLM - supports many different analyses including regression, 
ANOVA, covariance, multivariate and partial correlation are 
available in ‘Options’.

– LOGISTIC - supports linear logistic regression analyses for subsets.

– NPAR1WAY - performs analysis of variance on ranks.

– REG - supports general-purpose linear regression models by least-
squares. The various model-selection methods are available in 
‘Options’.

– TTEST - performs a two sample t-test for testing the hypothesis.

– LIFEREG - The LIFEREG procedure estimates the parameters by 
maximum likelihood using a Newton-Raphson algorithm. 

– LIFETEST - lifetime or survival data is the presence of right-
censored observations due either to withdrawal of experimental 
units or to termination of the experiment.

– MEANS - generates a report of basic statistics for each of the items 
for the population currently selected.

– TABULATE - generates a cross-tabulation of the items for the 
population currently selected.
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Defining a SAS View and Dataset

Create SAS View and Dataset

Define the specifications of the SAS View or Dataset by applying the 
same method that you used to build the patient selection criteria: 

1. Select Create SAS View or Create SAS Dataset.

2. Select a panel.

3. Select each item of interest. 

4. When using the Create SAS View and Create SAS Dataset you may 
use the Add Item to add single items or Add ALL Items to default all 
items for the selected panel. This method of selecting individual items 
or all items from multiple panels will create a single SAS View or 
Dataset.
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5. You can create multiple SAS Views or Datasets by selecting multiple 
panels in the following ways:

 For contiguous panels (panels listed next to each other):

a. Click the first panel.

b. Hold the shift key and mouse click and drag the cursor over the 
next panel(s).
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For non-contiguous panels (panels not listed next to each other):

a. Select the panels you want while holding down the CTRL key.

b. Click each panel you want to select.

Each panel that was selected is assigned an individual SAS View or 
Dataset name with all items included.

Note: If multiple panels are selected, and item names are repeated, Review 
automatically forces unique names to be used in the creation of the SAS View 
or the SAS Dataset.
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Select format library options

The SAS Dataset/View Create Options window allows you to specify 
format library options such as generate formats, use FULL codelist, 
attach formats to dataset items and include formats as dataset columns.   
In addition, you can define dataset sorting, index items and enter  
%include files to be added before and after the dataset or view is created. 
When you create a SAS Dataset all the settings are enabled including 
Index Items and the option to create SAS Transport files and PDF files.

You must select ‘Generate Formats?’ in order to ‘Use FULL codelist’ or to 
‘Attach Formats’. Likewise, in order to ‘Include formats as dataset 
columns’, you must first select the ‘Attach Formats’ in order to create 
those columns.

6. Click Options. The SAS Dataset/View Create window opens.

7. Enter your options.

8. Create SAS Transport Files? 
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SAS Transport Files

You must click Create SAS Transport Files in order to select the type of 
transport file. 

The SAS Views you create are dynamic, i.e., whenever accessed by SAS 
return the current Oracle data. The SAS Dataset created contains the 
selected items of the current patient population. This feature allows you 
to take snapshots of the data while the study is ongoing. Simply select 
panels and items to add to the dataset, and export if desired. (See Chapter 
12 for information about the pseudo-items ‘_Define New Item_’ and ‘_Define 
New Range_’ on the pseudo-function, ‘_New Event Function_’.)

9.  Click OK.

10.Click Create to generate SAS Output.

V5 (FDA Guidelines) option

When you create SAS Transport Files as V5 (FDA Guidelines) this option 
is the only one which requires format settings. You must generate format 
catalogs and attach the formats to the variables in the datasets. It is not 
mandatory to ‘Include formats as dataset columns’. 

Note: When you click the V5 option the two required options are selected for you 
and you cannot change it.
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Edit panels

When you select the V5 (FDA Guidelines) option and create the SAS 
Dataset/View, you can edit the panels by clicking the eSub PDF button. 
The Electronic Submission PDF window displays as a panels 
spreadsheet. The primary function of the panels spreadsheet is to display 
format details.

1. Click Edit Panel(s) to convert the panels spreadsheet into edit mode. 
The button status changes to save Panel(s).

2. Select a row variable to edit specific fields in the items spreadsheet.

3. Click Save Panels.

4. Click Save PDF. Print Preview and Print buttons can be selected.
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Defining a SAS Proc Specification

Define SAS Proc specification

Define the specifications of the SAS Proc run by applying the same 
method that you used to build the patient selection criteria: 

1. Select a SAS Proc.

2. Select a panel.

3. Select each item of interest and an appropriate function or use the 
default function.

4. Select a BY Variable(s) to categorize the data if applicable.

5. Click Create.

Adding items to be analyzed

The following SAS Procs share the same display window for the 
selections ADD By Var and ADD Item.

• FREQ

• MEANS

• TABULATE

• FREQ with Statistics
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Select the individual item(s) to be analyzed and click ADD Item to add 
the item to the SAS Proc specification. 
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Adding BY variables

You can further process the data with the use of BY categorical variables. 
Click ADD By Var to add the selected Item to the list of By Variables for 
the SAS Proc run.

A BY variable is a variable by which the data sets are ordered according 
to the BY statement variable. Statistical observations on BY variables are 
carried out on ordered, grouped, or indexed values of one or more 
variables. 

Statistics options

Some of the more complex SAS Procs have additional options available 
to further analyze the data. The statistic options are specific to the SAS 
Proc selected. You will see the OPTIONS button enabled for those 
specific SAS Procs; otherwise, the OPTIONS button is not highlighted.    
Click Options if available.

The Frequency tables with Stats has an Options button to further analyze 
the data with additional statistical testing as follows: 

1. Click Frequency tables with Stats as the SAS Proc type. The Options 
button is enabled when this SAS Proc type is selected.

2. Select a panel.

3. Select each item of interest.   

4. Click Options to display the SAS Proc Freq Options window.

5. Select the statistical test(s) for analysis and click OK.
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Defining a SAS Proc title

Enter a title for the SAS Proc that will be displayed as the caption of the 
resulting SAS Proc output window, as well as on any printouts. Enter the 
title text in the “Heading” field.
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Creating the SAS Proc output

When your SAS Proc specification contains the information you want, 
click Create. Review sends your request to be processed by SAS on your 
server computer, and displays the results in View Output window. The 
data in your report contains only data from those patients who meet your 
current patient selection criteria and/or SAS Proc output filter:

Change a SAS Proc specification

To change the SAS Proc Run specification that you define:

1. Click anywhere in either the By Variables or the Item(s) analyzed list.

2. Click on the item that you want to delete. 

3. Click  or from the Edit menu, select Cut. This deletes the 
highlighted row from the SAS Proc specification. 

4. To clear the entire SAS specification, click .
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Output filter
(See Chapter 6 Report Browser: Output Filter.)

SAS Proc results display

Toolbar

The toolbar at the top of the output display window allows you to page 
through the output. The paging feature is necessary to view listings 
where ADD BY Var is applied to create the output. For example, if 
investigator is the BY Var then a page break by investigator is applied to 
the output display.

In addition, the magnify button drop down list has percent scale sizing 
and multiple page display options for you to select.
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Find menu command

You can perform a text search which supports case sensitive or not 
searches and find next. Select the Edit menu and click Find.

Displaying the SAS output, source, or log

Notice the three buttons at the bottom of the output display window. By 
default, the SAS output has been displayed; however, if you want to 
review the SAS log click . If you want to review the 
SAS source used to create the SAS output click . To 
review the SAS output again, after reviewing the SAS log or SAS source 
click . 

If multiple SAS Proc results are active at the same time, each functions 
independently. That is, you can review the source, log or output of each 
independently by clicking the appropriate results button in the 
respective windows.
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Exporting and printing results

Print Preview
To display a print preview of your output:

1. Click on the generated output window to make it the active window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen. 

3. Click either Print or Close.

The Print Preview function is applicable to all browsers with output 
results.

Printing the SAS Proc results

To get a printed copy of your output:

1. From the Toolbar in the output display window, click the Printer 
button. Review displays the Print window dialog.

2. Enter printing selections and click Print. 

OR

1. Click , or from File menu, select Print. Review displays the Print 
window dialog. 

2. Enter printing selections and click Print. 

The SAS results (output, source, or log) prints on the currently selected 
printer.
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Exporting the result

Export your result to PDF files.

1. From the File menu, select Export. The created output window must 
be the active window. 

 Review displays the Export dialog box. 

2. Enter the storage location.

3. Enter the storage type.

4. Click OK. 

The result is exported to the currently selected disk directory. 
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Other SAS Proc displays

The following SAS Procs: NPAR1WAY and TTEST share the same display 
window for selections ADD Var and ADD Class. Select panel and item, 
then click ADD Var and ADD Class buttons for data items to be 
analyzed.
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The following SAS Procs LOGISTIC and REG share the same display 
window for selections ADD Dependent and ADD Independent. Select 
panel and item, click ADD Dependent and ADD Independent buttons 
for data items to be analyzed.
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When you select SAS Proc REG, the ‘Options’ button is automatically 
enabled for selection of REG Model Options. Click selection boxes 
desired and click OK. The click Create to generate SAS output.
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When you select the SAS Proc GLM, the browser window only displays 
the ‘Options’ button. Click Options to display the GLM Options and 
define your analysis definitions. 
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Click Item Selector to display and select panels and items. You can 
double-click on the desired item or click Insert Item to add items to the 
various edit areas.
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Note: Do not type text items into the edit areas. You must select items by 
clicking Item Selector and make selections from the panels and items displayed 
in the Item Selector window. Insert a space between each item selected if you add 
multiple items within the same edit area.

You can enter additional valid statements in the GLM procedure by 
typing in the edit area called ‘Other statements’.

Click OK to submit the GLM Options. Click Create.
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When you select the SAS Proc for LIFEREG: Parametric, click Options to 
display the LIFEREG Options and define your analysis definitions for 
Model and Class. You must follow the same instructions for the Item 
Selector and Insert Item as described above.

Click OK to submit the LIFEREG Options. Click Create.
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Select the SAS Proc for LIFETEST: Survival distribution, and click 
Options to display the LIFETEST Options and define your analysis 
definitions for TIME, STRATA and TEST. Again, use the same steps for 
Item Selector and Insert Item.

Click OK to submit the LIFETEST Options. Click Create.
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Multiple SAS Proc outputs

Opening multiple SAS Proc results

You can have multiple SAS Proc result windows active at the same time. 
After you define and create one SAS Proc output, you can minimize the 
results and/or activate the SAS Proc Browser. Once the SAS Proc 
Browser is the active window:

1. Click  or from the File menu, select New to refresh the screen. 
(You can open saved SAS Proc specification.)

2.  You add variables to an active or saved SAS Proc specification, and 
click Create SAS Output to run the SAS Proc request. 

Review displays a new window for each new SAS statistical analysis. 
You can have several output windows active at the same time. (The 
suggested procedure is to minimize the output windows, and open them 
as needed to help manage window space. The only limitation that an 
end-user may experience in the number of SAS Proc result windows 
opened at once is window space). 

Snapshot output

Multiple population mode

Review has an optional multiple-population mode available in the SAS 
Proc Browser. The Snapshot output allows you to change the patient 
selection criteria and view the different output within the SAS Proc 
browser at the same time. When the results are executed and displayed 
from the SAS Proc browser output window, two icons are displayed for 
“Snapshot Output” and “Who?”. 

(See Chapter 6: Report Browser: Snapshot Output and Chapter 12: Common 
Topics: Snapshot output)
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Saving a SAS Proc specification

Save the SAS Proc specification for later use or for validation of results. 
All saved SAS Procs with output filters on are saved with the filters. (See 
Chapter 6: Reporting: Object Storage: saving your work.)

All output specification functions for saving, retrieving, exporting, 
scheduling and removing are covered in the Report Browser. These 
functions are the same and apply for all Review output browsers.

Note: An object specification must be saved before it can be scheduled. The 
output is saved automatically when a job is scheduled. The Review Output 
option only displays lists of outputs previously stored. Otherwise, a message will 
state no output is stored. 

Schedule SAS Proc jobs

(See Chapter 6: Reporting - Scheduling Output.)

Review output

The Review Output folders are from the category folder definition for 
each of the objects that were run. You only see folders in the Review 
Output if an object has output saved. 

Note:The exception is previously run and saved SAS Proc output results from 
an earlier Review release. The SAS Proc Browser scheduled a job to be run and 
the output saved. The output would be listed under the specific SAS Proc that 
was run. Therefore, old SAS Proc jobs are placed in a SAS Proc folder. 
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Close SAS Proc Browser and results

Closing a SAS Proc output window

If you are finished reviewing the output of a SAS Proc, and do not need 
to use the output to review any other patient populations: Double-click 
the window’s close box.

Closing the SAS Proc Browser

If you are finished with all SAS Proc outputs, and do not need to define 
any other reports: Double-click the close box of the SAS Proc Browser 
window. Review also closes all SAS Proc results windows currently 
opened.

Exploring data

Changing the patient selection criteria

After you define the specifications of your report, and create it by 
clicking Create, you can use the output(s) that are currently displayed as 
data exploration views:

1. Change the patient selection criteria, redefining it by adding 
additional expressions, or removing existing expressions.

2. Click Update Browsers in the patient selection criteria window to 
update all active browsers according to the new criteria.

Any SAS Procs, or other browser objects that are open update 
according to your new criteria. Each report generated with a filter on 
will update with the same filter criteria with which it was created.

SAS Proc output filter

After you define the specifications of your graph, you can use the output 
filter as a data exploration tool by row filtering data inclusion and 
comparing filtered and unfiltered results. Row filtering is carried out by 
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the Output Filter Criteria window. The output filter functionality allows 
specified observations and visits, from multi-visit items, to focus 
reporting presentations on clinically specific requisites.

Open filtered scatter plot graphs can be very informative when Review’s 
patient-level interactive browsers are utilized in the multiple-patient 
mode to identify and characterize a subset of patients.

1. Change the output filter criteria by adding additional expressions, or 
removing existing expressions.

2. Click Save Filter in the SAS Proc Output Filter window to apply it 
against the next created SAS Proc. 

Pivot panels
Pivot Panels provide a powerful display of data, and provides a data 
structure that can be uniquely utilized by the SAS Proc Browser in pro-
ducing clinically pertinent presentations of data “on the fly”.

Note: Saved specifications using a pivot panel will only work with the pivot 
panel it was created with. If the same pivot panel is recreated with the same 
name, the objects using the original panel will not work because the system 
naming convention iterates with each created panel. (See Chapter 12: Common 
Topics: Define Pivot Panel.)

Join logic
The pseudo-panel ‘_Define Join Logic_’ provides an opportunity to 
investigate relations within the clinical data defined by medical investi-
gators “on the fly”. Join logic defined for the Clintrial type 0 panel is 
required to utilize the items within Clintrial type 0 panels. (See Chapter 
12: Common Topics: Define Join Logic.)

Clintrial tags
Clintrial tags are accessible to be used in SAS Proc specifications. When 
the pseudo-panel Clintrial tags is clicked on: 

• Clintrial tags are listed as a pseudo-panel.

• Definitions, and Categorizations of tags are listed in the items list. (See 
Chapter 12: Common Topics: Clintrial tags.)
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Protocol comparison

Use of the pseudo-item <Study ID> in SAS Proc specifications, facilitates 
comparisons between protocols. (See Chapter 12: Common Topics: <Study 
ID> pseudo Item.)

_New Event Function_

Utilizing the pseudo-function “_New Event Function_” allows you to 
create and define new landmark events to be evaluated and applied to 
your selected patient populations. (See Chapter 2: Selecting Patients: _New 
Event Function.)
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Selection criteria

Selection set
You can use the SAS Program Browser to regenerate previously pro-
grammed SAS Production Tables, with the original complete patient pop-
ulation, or to regenerate the tables with only those patients who meet the 
current patient selection criteria.

In addition, you can schedule a SAS program to run now or at a later 
scheduled date/time as a batch job. The actual output can be saved in the 
designated folder with the creation date/time stamp for future reference. 
A brief description of the patient subset criteria used to generate the 
output will display along side the creation date/time stamp. (See Chapter 
6: Report Browser: Schedule Output)

SAS program browser

Registered SAS programs

Your System Administrator can register SAS programs and SAS Data 
Sets used in the formal analysis of the protocol(s) of interest. They can be 
current Global and Study Specific SAS programs or Project global SAS 
programs. These programs and datasets can be made available and 
registered to Review, typically after the completion of the protocol and 
cleaning of the database. Thereafter, you can access these programs and 
datasets by using the SAS Program Browser.

Opening the SAS Program Browser 

The SAS Program Browser is useful in exploring patient sub-population 
statistical responses to the clinical trials. After defining your patient 
selection criteria, click or from the Browse menu, select SAS 
Programs. Review opens the SAS Program Browser window to display 
the categorical folders containing additional subfolders and all SAS 
Production Tables registered by your System Administrator for the 
current protocol. Groups of SAS programs can also be defined and 
executed.
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Selecting a table

Select an entry from the list of available SAS programs to be executed.

A SAS Program that requires parameterization opens a SAS Table 
Parameters Window, which facilitates the selection of variable parameter 
values. 

1. Each row value is a drop list box when clicked on. Select the 
parameter value you want to apply to the analysis.

2. Click on the value, and the drop list box with all possible values will 
be listed and made available for you use in the execution of the SAS 
program.

3. Once you have selected the applicable values, you are ready to create 
the SAS program output.

4. Click Create.
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5. You can choose to change the file type for exporting.

Schedule SAS Program jobs

(See Chapter 6: Report Browser: Schedule Output)

SAS program results and log files

For information to View SAS Source, View SAS Log, View SAS Output 
and Toolbar. (See Chapter 9: SAS Proc Browser: SAS Proc results display)
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Multiple table outputs

There can be multiple table outputs active at the same time. After you 
have generated one SAS Production table, you can select another by 
clicking Create. 

Each output is displayed in its own window. Each table output remains 
active and updates to reflect the current patient selection criteria when 
Update Browser is used.   

If there are multiple SAS Proc outputs active at the same time, each 
functions independently, that is, you can review the source, log, or 
output of each independently by clicking the appropriate buttons in the 
respective windows.

Snapshot output

Multiple population mode

Review has an optional multiple-population mode available in the SAS 
Program Browser. The Snapshot output allows you to change the patient 
selection criteria and view the different output within the SAS Program 
browser at the same time. When the results are executed and displayed 
from the SAS Program browser output window, two icons are displayed 
for “Snapshot Output” and “Who?”. (See Chapter 6: Report Browser: 
Snapshot output and Chapter 12: Common Topics: Snapshot output)
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Exporting and printing SAS program results

Print Preview
To display a print preview of your output:

1. Click on the generated output window to make it the active window. 

2. Click , or from the File menu, select Print Preview. 

Review displays a screen shot of the selected active screen. 

The Print Preview function is applicable to all browsers with output 
results.

3. Click either Print or Close.

Printing the table output

To get a printed copy of your SAS Proc output:

1. Click , or from the File menu, select Print. 

2. Click OK.  The SAS Proc output prints on the selected printer. 
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Exporting the result

Export your result to PDF files.

1. From the File menu, select Export. The created output window must 
be the active window. 

 Review displays the Export dialog box. 

2. Enter the storage location.

3. Enter the storage type.

4. Click OK. 

The result is exported to the currently selected disk directory. 
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Close SAS Program results window and SAS Program Browser

Closing the table output window

If you are finished reviewing the output of a table, and do not want to 
use the output to review any other patient populations; double-click on 
the window’s close box.

Closing the SAS Program Browser

If you are finished with all SAS Program Browser outputs, and do not 
want to define any other reports; double-click on the close box of the SAS 
Program Browser window. 

Exploring data

Opened SAS production table results

After you have selected a SAS Production table to be executed, click 
Create Output, and repeat as desired. 

Each output remains active in its own window. You can use the output(s) 
that are displayed as data exploration views. 

Update patient selection criteria 

Change the selection criteria by adding additional expressions or 
removing existing expressions.

Click Update Browsers on the selection criteria window to update all 
active browsers according to the new criteria.
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Data source (protocol)

Selecting a data source

After you select a data source (protocol) to review, you can access any 
documents that have been made accessible to Review.

Open the Document Browser

Click , or from the Browse menu, select Documents.  Review 
displays a list of folders of the saved documents.
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Displaying a document

To select one of the available documents: 

1. Single click to to open a folder.

2. Click on the document and then click Display Document, or double 
click on the document. 

Review invokes the appropriate Windows program to display the 
document you have selected.

Closing the Document Browser

To close the Document Browser; double-click on the close box of the 
Document Browser window.

Note: Review does not automatically close the Windows program previously 
opened. When you are finished reviewing the document in the program, you 
must exit the program manually. 
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Shared object storage

Exploring interpretative consensus

Exploring clinical data interpretative consensus by using selection 
criteria and result specifications defined by co-workers.

Consensus of data interpretation 

The shared object storage feature facilitates quick communication of 
review specifications that may serve as powerful tools for fellow 
reviewers. The four-level Object storage also functions to allow for 
consensus of interpretation on the data derived from a shared reviewing 
tool and an assortment of shared review criteria and views of patient 
data.

PC Based Object Storage

You have four levels of object (browser specifications) storage using 
Review. The four levels, Private, WorkGroup, UserGroup and Public, 
offer varying degrees of sharing these objects with peers. 

Private object storage

The Private object storage site is only available to you on your PC.   The 
Private object storage site is defined in the Review.ini file. (See the Review 
Configuration Guide.)
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WorkGroup object storage

Note:  The WorkGroup object storage is no longer used as it has been replaced by 
the preferred UserGroup method to achieve the same function of sharing between 
users and based on a database saved object. The WorkGroup function is still 
available for backward compatibility.

The WorkGroup object storage site is network designated PC based to be 
accessed by all within the WorkGroup. The WorkGroup object storage 
site is defined in the Review32.ini file. However, Change WorkGroup 
Location button in the Open save object window, facilitates the browsing 
of other defined workgroup object storage sites. (See the Review 
Configuration Guide.)

UserGroup object storage

The UserGroup object storage site is database object storage for defined 
UserGroups in the configuration tables. Object storage in UserGroup 
level allows you to specify sharing with multiple usergroups. This works 
when you click UserGroup and you are a member in a UserGroup, then 
the usergroup listbox is enabled. If you want to share the object with 
multiple usergroups, simply use the CTRL or SHIFT mouse click for 
multiple selections. Saving on database object storage sites, requires the 
author to have “Publishing Authorization” defined in the configuration 
tables. (See the Review Configuration Guide.)

Public object storage sites

The Public object storage site is database object storage for all users of 
Review who have shared drive access beyond the local WorkGroup. The 
Public object storage site is a database storage defined in the 
Review.inifile. Saving on database object storage sites, requires the 
author to have “Publishing Authorization” defined in the configuration 
tables. (See the Review Configuration Guide.)
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SuperUser
Individual users can be granted special privileges as ‘SuperUsers’ to 
update and delete stored objects created and saved by other users. Typi-
cally only the author of a stored object can modify or delete it. However, 
the SuperUser has access to those stored objects when modification or 
deletion are needed for maintenance and cleanup.

Server-based global object storage 

Global object storage

User-created objects such as, pivot panels, logical joins, and '_New Event 
Functions_' are saved in tables owned by the Review Admin ORACLE 
user. The site or user configuration can be enabled or disabled for user-
created objects for pivot panels, logical joins, and user preferences 
selections. The panel listbox in the patient selection criteria window will 
look different if these functions are disabled by the site administrator. 

The site default, usergroup or user level privileges can be set to control 
access to SAS to save objects at each level (Private, WorkGroup, 
UserGroup and Public). This also includes the ability to save patient 
notes. 

Sharing objects
When the 'Share with other?' checkbox is checked as WorkGroup, User-
Group or Public; the stored object is accessible to those shared sites if the 
user has publishing privileges. If the checkbox is not checked, then the 
created object is only accessible by the author.

Object level
You can save output specifications (reports, graphs, SAS Proc, etc.) at 
Project or Global level when you select an Object Storage Location desig-
nated as ‘db’ for database. Therefore, when you select either UserGroup 
or Public for database object storage location, you can assign an object 
level to restrict access to a specific study level or share access between 
multiple studies at Project or Global levels. 
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Change User Password

Change password
You can change your own password if you have the privilege set in 
ReviewAdmin. From the File menu, select ‘Change Password’.

Snapshot output

Multiple population mode

Review has an optional multiple population mode available for the 
following browsers: Report Browser, Graph Browser, SAS Proc Browser, 
SAS Program and CrossTab Browser. The Snapshot Output allows you to 
change the patient selection criteria and view the different output within 
a particular browser at the same time. When the results are displayed 
from an executed browser to the browser output window, two icons are 
displayed for “Snapshot Output” and “Who?”.
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Snapshot output

The first icon is “Snapshot Output” which allows you to keep a particular 
output as is for comparison purposes. Before you change the patient 
population, click the ‘Snapshot Output’ icon. The output window’s 
caption bar changes to include ‘[Snapshot]’ at the beginning - to let you 
know the output is a snapshot and will not be updated when you change 
the patient selection criteria and create output.

Click on the Snapshot Output icon again to return the output window to 
an active status for updating.

Who is the patient population?

You can click on the second icon “Who?” to display a message box 
showing the current patient population for that output. The “Who?” 
message works with the ‘live’ output and the ‘snapshot’ output.
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Pivot panels

Transposing normalized clinical data

With pivot panels, you can transpose clinical data stored in a normalized 
manner into a more easily reportable horizontal data structure. Click on 
the pseudo-panel ”_Define Pivot Panel_”, and the Define Pivot Panel 
dialog box opens: 
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Creating pivot panels

The creation of the pivot panel is a point and click operation. You 
construct the new data structure by selecting the appropriate items 
sequentially according to the number of the list box. Each list box is 
numbered and includes a brief description and instruction:

1. Choose a base panel:

2. Choose a pivot variable. 
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3. Select pivot variable Values. Hold down Ctrl and click to select 
multiple values.

4. Select header items to group by, generating a new row in the new data 
structure for each change in the header items. By default, Patient ID is 
included as one of the header items. For example, if you include 
Patient ID and Visit Number, a new row will be created not only for a 
change in Patient ID, but also for each Patient Visit Number. You must 
hold down the Ctrl and click to select multiple Values.
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5. Select items that are dependent on the pivot variable. This is the data 
which will be stored for each pivot variable value. Multiple dependent 
variables can be selected.

6. Enter a description of the pivot panel.

7. Select UserGroup or Public to make the new data structure accessible 
to others. (See Common Topics: Sharing Objects. 

8. Click Create Panel. When the pivot panel is created, it is included in 
the panel listing with a dependent variables listing in the items list 
box.

9. To remove a pivot panel, click on the Edit menu and select remove 
pivot panel.

Note: Saved specifications using a pivot panel will only work with the pivot 
panel it was created with. If the same pivot panel is recreated with the same 
name, the objects using the original panel will not work because the system 
naming convention iterates with each created panel. 
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A comparison between the Laboratory Examination Panel and the 
defined Pivot Panel is best demonstrated by opening the panels with the 
Data Browser.
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The Laboratory Examinations Panel previously stored in a normalized manner is 
pivoted into a horizontal data structure.

The resulting Pivot Panel is defined as Hematology:Piv01.
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Defining logical joins

User-defined logical joins

If the default join logic used by Review is not appropriate for a pair of 
tables, you can specify the join logic Review will use between specified 
tables. A common usage of this utility is to define join logic between the 
Dosage panel’s Start Date item as “>=” the Adverse Event panel’s Onset 
Date item. This, and any logical join can be defined by the end-user at 
any time. Thus, the end-user can define joins 'on the fly'.

Logical joins with Clintrial Type 0

This is a necessary utility in the join logic and utilization of a Clintrial 
Type 0 panel. The Type 0 panels don't have typical context items, and are 
typically non-patient data.
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Creating logical joins

1. Click on the pseudo-panel ‘_Define Join Logic_’ from any listing of 
available panels, and the following window opens:

2. Point and click on the panels that you would like to join.
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3. Point and click on items and join operators, defining relational joins.

4. Then click Add Expression to Join Logic to build the logic for the join 
between the selected panels.

Global object storage of join logic

5. Define the Object Store as Public or UserGroup to share the defined 
Join Logic. The default is private and will allow access only its author.
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6. Click Save for a new join definition, or Update to edit (update) an 
existing join definition.
504 Chapter 12:  Common Topics



Level 1 bleed
Once the Define Join Logic has been saved, the defined JOIN pairs are 
highlighted in the description with ‘***JOIN***’. Click on the ‘A’ panel 
with ‘***JOIN***’ description to list corresponding ‘B’ panel(s).

Removing logical join

1. Click on the pseudo-panel ‘_Define Logical Join_’.

2. Select the joined panels. 

3. Click Remove to delete a defined logical join.
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Import SQL

Access Import SQL

The Import SQL function is another way to create and access foreign 
panels for data review. (See ReviewAdmin: Register Foreign Panels)

After selecting a project and protocol, the ‘pseudo panel’ _Import SQL_ 
displays in the Panels list box:
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Enter Import SQL SELECT statement

1. Click on _Import SQL_ to open the Import SQL dialog.

2. Either type in the desired SELECT Statement (don’t end it with a semi-
colon) or copy a SELECT statement to the clipboard and paste it into 
the ‘Imported SELECT statement’ edit control. 

3. For an example of a select statement accessing our Object Catalog 
table in the ReviewAdmin oracle account:

select 
project,studyid,objecttype,objectindex,objectname,descr
iption,objectlevel from reviewadmin.objectcatalog
You can select and copy this select statement to the clipboard, then 
paste it into the ‘Import SELECT statement’ edit control.
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4. Next provide a Description, ‘Brief Name, i.e. PanelName’, SASName 
(< 8 char).

5.  Select the correct ‘Expected Frequency’ from the dropdown listbox. 
These are the same as Clintrial panel types. Non-patient data would 
be type 0, the default.

6. Select the appropriate ‘Object Store’ and ‘Object Level’ similar to 
Saved Objects terminology. The Private ObjectStore, however, is stored 
in the database.  All of these definitions are stored in the new 
‘ImportSQL’ table in the ReviewAdmin account.

7. Lastly, click on the ‘Check SQL/Get Column Info’ button which goes 
out to the database and checks the SQL syntax returning an Oracle 
error if there is one.

If the SQL syntax is correct, you’ll notice that the ‘Column Information 
in Imported SELECT statement’ spreadsheet is now filled with the 
column info from the select statement (col name, type, length, 
description, SASName).

8. Only the Description and SASName are able to be modified. Also, you 
can delete any of the rows in the spreadsheet if the user didn’t want all 
the columns to be available for reporting in IReview after registering 
this SQL statement.

9. Click SAVE. The information is saved and added to the list of Panels 
and will function much like a registered Foreign Panel. You can do 
reports, graphs, use it in Output Filters, etc.

Note: If it’s not patient related, it’s important that it not be subsetted using 
the Patient Selection Criteria. 

10.To edit or remove after it’s been defined use the same convention as 
Edit New Item. Just click on the description of the Imported SQL in 
the list of panels, then click the Edit menu for Edit ‘Imported SQL’ – 
where you can make changes, including changing the ObjectStore and 
ObjectLevel, or Remove.
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Using Clintrial tags 

Tags for selection and reporting

‘Clintrial TAGS’ are listed and accessible through the entry ‘Clintrial 
TAGS’. 

Access Clintrial tags items listing

Click on the pseudo-panel “Clintrial TAGS” and a listing of all tags will 
be presented in the items list box.

You can use the listing of tags and tag descriptions as selection criteria 
and reporting elements.
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Exploring clinical data with derived item values 

Derived data item values

You may find it desirable to select and report a derivation of the original 
clinical data. For example, you may want to derive a total score by 
summing up several raw data items in the database from within the same 
panel or across panels and panels types. You select the panels and the 
underlying items, using any mathematics operator to join Item 
expressions and save the derived items. 

1. Select panel items.

2. Join item expression with mathematical operators.

3. Enter New Item Description.

4. Save New Item.

Derived items across panels

Deriving items across panels requires no programming. You just point 
and click to select the data items you want to include, and Review does 
all the rest. 

Perhaps age was not collected, but you have collected Date of Birth. You 
could define a calculated age by doing date arithmetic on Date of Birth 
against the Date of the Visit. Such derived data items are supported 
throughout Review.
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The newly defined item will be displayed and accessible from the active 
panel when you clicked on _Defined New Item_:
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“_Define New Item_”

The first entry in the item list for every panel is the pseudo-item ‘_Define 
New Item_’.

1. Click on this item. Review displays a dialog box where you can define 
the expression for the derived item. 

2. Select the items. Click ADD expression to criteria to paste the item 
and function into the expression spreadsheet.

As each item is added, it’s description and codelist reference is defaulted 
into the New Item Description text. This is handy if you want to copy an 
existing item(s) from one panel to another for convenience in display. 
The item(s) is than available for use throughout all the browsers.
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When you enter a SAS name into the SAS Name field, there is an internal 
check to prevent duplication of SAS names within the same panel. 

Note: If any items used in a mathematical calculation contain NULL data, the 
resulting derived item will be NULL per standard Oracle functionality.
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You can edit the SQL within the Expression Item editbox to adjust your 
derived item calculation, as shown in the next example. 

Note: The overall length of the expression is currently limited to 256 characters. 
Review prevents you from exceeding this limit.
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Adding operators
By default, the rows are joined by ’+’ operators; however, you can change 
the operator. By clicking on the operator field, you can change it to any 
mathematical operator of choice.

You can also edit more complex mathematical expressions within the 
Expression Items editbox. Be sure to hit the Return key on the last 
expression line so all expression items and operators are processed into 
the calculation.
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Note: You must use parentheses between rows to control operator precedence if it 
is a complex expression. 

3. Enter a description.

The “Description” field allows you to enter a description of your 
expression. This description will be in the item list when you select the 
panel to which you are adding the new data item.

If you need to change your item type from the default value: 

4. Click the New Item Type button to select from the droplist.
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 Saving the new item

Click Save. Review saves the definition and the description and posts the 
New Item at the end of the list of items from the panel in which it was 
activated.
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In the next example, you can define a new item to reference an existing 
decode in one panel and display the new item in a different panel:
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The Define New Item is added to the Demography panel, while decode 
information is taken from item Reason for discontinuation in the Final 
panel. 
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Saving a Global new item

If you are granted “SuperUser” capability through the ReviewAdmin’s 
Review Privileges, the “Global NewItem?” checkboxes are enabled when 
you select Object Store for the new item as either UserGroup or Public. 
This feature defines the new item further to automatically be saved in 
“All Panels” and/or “All Studies”.
520 Chapter 12:  Common Topics



Level 1 bleed
Editing defined new items

When you return to the define New Item dialog box, notice that the 
description of your newly defined item has been added to the end of the 
list of items.

To change the expression for the new Item that you have defined and 
saved:

1. Select the panel that it belongs to. 

2. Select the New Item’s description from the item list.
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3. From the Edit menu, select Edit Defined Item. 

Review displays the Edit New Item dialog box:

You can click on, and change any portion of the New Item Expression 
with Add/edit items, functions and operators. 

4. Click Update and Review saves the changes.

Removing saved new item definitions

To remove the new item that you have previously defined. 

1. Select the panel it belongs to.

2. Select the new item description you would like to remove.

3. From the Edit menu, select Edit Defined Item. Review brings up the 
dialog box displaying the new item expression and its description. 

4. You can remove the item by clicking Remove. Review removes the 
new item.
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Exploring clinical data with range variables

User-defined range variables

Reporting continuous numerical data as groups of values or categories 
based upon range variables is often a desirable task. Review supports 
user definition of range variables upon numeric data items throughout 
the Report, SAS Proc, and Graph Browsers. 

“_Define New Range_”

The second entry in the item list is the pseudo-item ”_Define New 
Range_”:

1. Click on this item. Review displays a dialog box where you can define 
the specifications of your new range variable. 

2. Select the numeric item upon which to base your new range variable. 

Note: Review automatically displays the current range of the numeric 
variable in the database.
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3. Enter a description for your range variable in the “Description field”. 
Your description will be listed in the item list whenever you select the 
panel in which you added the new range variable.

Defining range cut points

You enter the ‘cut points’ of your ranges in the Range Max column. 

4. Enter a Label for Range to describe the relation of the previous row to 
the current row and to Range columns. 

Note: The definition of ranges are entered as the Maximum value of each 
range as opposed to entry of the minimum and maximum values for every 
range. In essence, you are entering the only the Maximum value of each 
range because Review uses the previous row’s Maximum value as the 
Minimum value of the following row’s range.

The first row’s Minimum value is automatically generated by Review 
to include all points less than, but not including, the range maximum 
of the following row. Missing item values for a patient or group are 
automatically assigned to a range noted as a ‘missing’ entry.
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Saving the new range variable

5. Click Save. Review saves the descriptive information about the range 
in it’s internal tables. The actual set of ranges values will be stored on 
the database under your User ID, in a new table of the form:

       ICRG_<nodeID>_<RangeNo>

where <nodeID> is the NodeName of your PC on the network, and 
<RangeNo> is a system generated unique sequence number assigned 
to the range.   Do not delete or modify this table in any way.   
Note: The description of your newly defined range has been added to the end 
of the list of items of the pertinent panel.

Editing a defined range variable

To change the range values or description for the range variable that you 
have defined and saved:

1. Select the panel.

2. Select the range variable description in the items list.

3. From the Edit menu, select Edit Range Variable. Review displays the 
Edit Range Variable dialog box with the range variable definition and 
it’s description.

4. You can click on and change the range description, or any of the range 
value definitions.
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5. When your modifications are complete, click Update and Review 
saves the changes.

Removing saved range variables

To remove the range:

1. Select the panel.

2. Select the range variable description you want to remove. 

3. From the Edit menu, select Edit Range Variable. Review displays the 
dialog box.

4. To remove the range variable, click Remove. 

Review removes the range variable from the panel’s list of items, and 
removes the definition from your local PC and the remote database.
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New event function

User-defined time related milestones

You can define time-related milestones, such as baseline, endpoint, or 
any description of your choice, for use throughout Review. From the 
pseudo-function “_New Event Function_” you can view a current listing 
of event derived-values and add new event criteria.

1. Click the pseudo-function '_New Event Function_’ from the Functions 
list.

“_Define New Event_”

2. Select an existing event function, or start a new definition by clicking 
on a reference panel.
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3. Select a header.

4. Select an operator.

5. Select a value from the Display Values listing, or enter a value in the 
“value” field.

6. Click ADD Expression to build the new event function value. The 
values will be entered in the build spreadsheet.

7. When you are finished building the event function value enter the 
event function description.

8. Click SAVE and the new event function will be listed with the 
function values.

Editing or deleting a new event function

If you select an existing function, the current values are added to the 
table, and you can click Update to edit the new event function or 
Remove to delete.
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Exploring clinical data in multi-protocol mode by StudyID

Multi-protocol mode: protocol comparisons

When working in multi-protocol mode it is often desirable to identify the 
protocols, patient groups, or individual patients to which data points 
belong. Review supports the use of the StudyID pseudo-item throughout 
the report and graph browsers.

Using the <StudyID>

After opening a report or graph browser, the third entry in the item list 
for every panel is the pseudo-item entry .

You can add the <StudyID> to the report, to one of the axes on a graph, 
or as an item or BY variable in a SAS Proc request.

Review processes your report or graph request and reports the StudyID 
description as it appears in the sources list in the Patient Selection 
Criteria window.
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Reviewing preferences

Open preferences

When in the Patient Selection Criteria window, from the Edit menu, 
select Preferences. The following window opens:

When you enable or disable a preference and click OK, the change is 
immediately implemented.
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Automatic Outer joins 

By default, Review enables automatic Outer joins. With Outer joins 
enabled, all patients’ data will be included in a browser's results, even if 
some panels of data are missing for that patient. The joins are based on 
the context items Patient ID, Visit ID, and Observation ID. Depending on 
the expect frequency of panel per patient, appropriate combinations of 
context items are used to execute joins between any and all included 
panels.

Optional Outer joins in Results

If enabled, a patient's data is included in a browsers results even if some 
panels of data are missing for that patient. With Outer joins disabled, 
patients will only be included in browser results if they have all panels of 
data.

Use full joins in Selection Criteria

By default, full joins are disabled. The disabled full joins allows the 
automatic outer joins to test selection criteria by row restricting criteria to 
visit and/or observation (depending on the type of panel).

An optional join preference is to enable the full automatic joins 
facilitating the selection criteria to be applied throughout all patient data 
rows.   The criteria applied would test by Patient ID and not consider 
visit and/or observation, thus broadening the scope of the patients 
meeting the criteria.

Displaying panel names

If enabled, panel lists will display the panel name rather than the panel 
description. 

Displaying item names

If enabled, item lists display the item rather than the item description. 
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Sort panels alphabetically

If enabled, panel lists will be sorted alphabetically; otherwise, panels are 
listed in order of creation. 

Sort items alphabetically

If enabled, item lists are sorted alphabetically; otherwise, items are listed 
in order of creation.

Patient subset footer as text

If enabled, patient selection criteria definition when printed in footers 
will display as text; otherwise, definition displays in SQL.

Clintrial Data Source

Clintrial sites may select a storage preference in Clintrial Data Source 
which includes DATA, UPDATE or ALL. This allows the user to switch to 
the desired data source within Review. (Clintrial 4.x releases)

Single patient mode

Identify Patients with interactive browsing design

Review is designed to work with clinical data at the patient-level 
displays and summary displays. Throughout Review’s data reviewing 
browsers, patient-level displays of data interact simultaneously to 
highlight and identify patient data. 

Patient-level results interact 

Review’s patient-level displays of data interact simultaneously to 
highlight and identify patients underlying selected data points and 
values from any display of patient-level data. When you select a patient, 
or a data point in a patient level display, instantly all browsers receive a 
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broadcast message to highlight and identify the patients’ data. Because 
review is built on patient-level data, all browsers communicate with each 
other at the patient-level.

Multiple patient mode

Patient-level and summary displays interact

Review’s multi-patient mode refers to the reviewing of multiple patients 
throughout the various browsers by Subset or Highlight a selected group 
of patients. 

Browsers interact
A subset of a selected group of patients may be viewed across multiple 
browsers by the way the browsers interact.

• Data Browser: 

– Patient Listing Subset to a selected group of patients from any 
Browser.

• Report Browser: 

– Detail Data Listing Subset to selected groups of patients from any 
Browser.

• Graph Browser: 

– Scatter Plot Graph Highlight all patients selected from any other 
Browser Specification. 

– Scatter Plot Graph: Mouse click and drag to lasso groups of patients 
within graphical regions, to broadcast and identify patients within 
such population regional subsets.

– Bar Chart Graphs: Click on Bars within Bar Chart Graphs to 
broadcast and subset the patients underlying each Bar Value in all 
open patient level displays of data.

• CrossTab Browser: 

– CrossTab Table: Mouse click on a grid value (patient count), and all 
underlying patients will be highlighted and identified in all open 
patient level displays of data.

– Shift Table: Mouse click on a grid value (patient count), and all 
underlying patients will be highlighted and identified in all open 
patient level displays of data.
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Summary results and patient level results

All CrossTab and Shift tables, Bar Chart graphs and their summary 
values instantaneously highlight and subset the currently selected 
patient population when their summary values are clicked. For example, 
a value in a Shift table from the CrossTab browser, and all patient level 
displays of data will highlight, identify, and subset the underlying 
patients making up the count.

Displaying spreadsheets

Exporting browser spreadsheets

Review displays data by a spreadsheet control in many places 
throughout the product. You can export the results displayed in the 
spreadsheet controls to a Microsoft Excel or HTML formatted file.

First, display the data and then from the File menu, select Export. 
Review requires you to enter a filename for the Excel or HTML formatted 
file before you can save and store the data in the file you specified. The 
spreadsheets in review are supported by the spreadsheet control, by 
browser.

Non-formatted reports may be exported as Excel tab delimited files, 
HTML format or Tabbed Text. Formatted reports export as PDF files. 
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Browsers export spreadsheets

The areas of Review that support this functionality are:

• Selection Criteria: Display Values

• Data Browser: List of Patients

• DataView - any panel’s display of data for a patient. 

• Report Browser:Report Sheet - Detail Data or Summary Report.

• CrossTab Browser: Result Tables - CrossTab or Shift Table.

Copy to Clipboard

View SQL details dialog

You can view the SQL details dialog from the View menu, click SQL 
details. The various browsers will display the SQL details as you explore 
the data. Review allows you to copy the SQL to Clipboard. 
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Copying and pasting browser results

Review allows you to copy any portion or all of the resulting data 
displays in a spreadsheet control (for example, in a graph or SAS output 
window) to a clipboard for pasting functionality into other Microsoft 
Windows-based applications. 

1. You select the portion of the results you want to copy by clicking and 
dragging until the area you are interested in is highlighted. 

2. From the Edit menu, select Copy. 

 Review copies your selection to the clipboard. 

3. From the Windows-based application you want to paste the selection 
into, from the Edit menu, select Paste.

Browsers copy and paste

The areas of Review that support this functionality include:

• Selection Criteria: Display Values and Display Stats

• Data Browser: List of Patients

• DataView - any panel’s display of data for a patient

• Report Browser: Report Sheet - either Detail Data or Summary Report.

• CrossTab Browser: Result Tables- either CrossTab or Shift Tables

• Graph Browser: Graph View

• SAS Proc Browser: SAS Output window

• SAS Program Browser: SAS Output window 
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